
MacBook	Pro	Essentials



Introducing	the	new	14-inch	and	16-inch	MacBook	Pro

See	it	all	on	your	bold	and	bright	display
The	Liquid	Retina	XDR	display	delivers	extreme	dynamic	range,	high	contrast	ratio,	adaptive	refresh
rates,	and	advanced	color	accuracy.	Everyone	will	enjoy	the	vivid	quality,	whether	theyʼre	grading	8K
video	on-set,	or	watching	a	movie	in	HDR	to	get	a	truly	cinematic	experience.

Use	all	the	functionality	on	your	keyboard
The	Magic	Keyboard	includes	a	row	of	full-height	function	keys	with	new	keyboard	shortcuts	for
Spotlight	search	 ,	Siri/Dictation	 ,	and	Do	Not	Disturb	 ,	which	allow	you	to	quickly	focus	on	the
task	at	hand.



Connect	all	your	devices
The	new	MacBook	Pro	models	have	versatile	connectivity—including	three	Thunderbolt	4	(USB-C)
ports,	an	HDMI	port,	an	SDXC	card	slot,	a	MagSafe	3	port	for	the	power	adapter,	and	a	3.5	mm
headphone	jack	that	supports	high-impedance	headphones—so	you	can	connect	and	use	all	your
devices	easily.

Charge	quickly	and	safely
Connect	the	USB-C	to	MagSafe	3	Cable	to	the	power	adapter	and	the	MagSafe	3	port.	As	the
connector	gets	close	to	the	port,	youʼll	feel	a	magnetic	pull	drawing	it	in.	With	the	96W	USB-C	Power
Adapter	for	the	14-inch	model	and	the	140W	USB-C	Power	Adapter	for	the	16-inch	model,	MacBook
Pro	can	be	charged	up	to	50	percent	in	about	30	minutes.



Want	to	learn	more?	See	Take	a	tour:	New	14-inch	and	16-inch	MacBook	Pro.



MacBook	Pro	at	a	glance

Take	a	tour:	New	14-inch	and	16-inch	MacBook	Pro
Note:	This	guide	is	for	the	currently	shipping	MacBook	Pro	models.	If	youʼre	not	sure	which	model	you
have	or	want	to	find	information	and	documentation	for	other	models,	see	the	Apple	Support	article
Identify	your	MacBook	Pro	model.

The	14-inch	and	16-inch	MacBook	Pro	models	have	the	following	features.	Not	all	features	are
available	on	all	MacBook	Pro	models.

MagSafe	3	port:	Plug	in	the	included	USB-C	Power	Adapter	to	recharge	the	MacBook	Pro	battery.
The	indicator	light	glows	amber	when	the	battery	needs	to	be	charged,	and	green	when	itʼs	fully
charged.	Charge	your	battery	quickly—up	to	50	percent	in	30	minutes—on	the	14-inch	model	with
the	96W	USB-C	Power	Adapter,	and	on	the	16-inch	model	with	the	140W	USB-C	Power	Adapter.

Thunderbolt	4	(USB-C)	ports:	Transfer	data	at	Thunderbolt	speeds	(up	to	40	Gbps),	connect	to	a
display	or	projector,	connect	to	USB	4	peripherals,	and	more.	See	Use	an	external	display	with
your	MacBook	Pro.

3.5	mm	headphone	jack:	Plug	in	stereo	headphones	or	external	speakers	to	listen	to	your	favorite
music	or	movies.	Use	high-impedance	headphones	without	a	digital-to-analog	converter	or	an
amplifier.

SDXC	card	slot:	Transfer	photos,	videos,	and	data	to	and	from	your	MacBook	Pro,	with	support	for
high-capacity	SD	4.0	cards.

HDMI	port:	Connect	your	MacBook	Pro	to	a	TV	or	external	display.	See	Use	an	external	display
with	your	MacBook	Pro.

https://support.apple.com/HT201300


1080p	FaceTime	HD	camera:	Make	FaceTime	video	calls	or	take	pictures	and	video.	The	camera
system	provides	high-quality	video	and	better	low-light	performance.	If	the	green	indicator	light
next	to	the	camera	is	glowing,	the	camera	is	on.	See	FaceTime	and	Use	the	built-in	camera	on
Mac	in	the	macOS	User	Guide.

Studio-Quality	Microphones:	Three	microphones	with	high	signal-to-noise	ratio	and	directional
beamforming	deliver	super-clear	audio	for	videoconferencing	and	phone	calls,	as	well	as	high-
quality	voice	recordings	for	audio	tracks,	podcasts,	and	voice	memos.

Speakers:	The	high-fidelity	six-speaker	sound	system	consists	of	two	pairs	of	dual	force-
canceling	woofers	and	two	tweeters.	Enjoy	a	robust	and	high-quality	audio	experience,	including
spatial	audio	support	for	videos	and	songs	with	Dolby	Atmos.

Touch	ID	(the	power	button):	Press	to	turn	on	your	MacBook	Pro	(or	just	lift	the	lid	or	press	any
key).	A	metallic	trim	ring	guides	your	finger	to	the	Touch	ID	sensor	that	analyzes	your	fingerprint.
When	you	first	start	up	or	restart,	you	need	to	log	in	by	typing	your	password.	To	learn	more	about
how	to	use	Touch	ID,	see	Magic	Keyboard	for	14-inch	and	16-inch	MacBook	Pro.

Force	Touch	trackpad:	Control	your	MacBook	Pro	with	gestures.	The	entire	trackpad	surface	acts
as	a	button	so	you	can	easily	click	anywhere.	For	more	about	using	gestures,	see	MacBook	Pro
trackpad.

Take	a	tour:	13-inch	MacBook	Pro

https://support.apple.com/guide/mac-help/use-the-built-in-camera-mchlp2980/11.0/mac/11.0


Note:	This	guide	is	for	the	currently	shipping	MacBook	Pro	models.	If	youʼre	not	sure	which	model	you
have	or	want	to	find	information	and	documentation	for	other	models,	see	the	Apple	Support	article
Identify	your	MacBook	Pro	model.

The	13-inch	MacBook	Pro	with	M1	chip	has	the	following	features.	Not	all	features	are	available	on	all
MacBook	Pro	models.

Thunderbolt	/	USB	4	port:	Charge	your	computer,	transfer	data	at	Thunderbolt	speeds	(up	to	40
Gbps),	connect	to	a	display	or	projector,	USB	4	peripherals,	and	more.

3.5	mm	headphone	jack:	Plug	in	stereo	headphones	or	external	speakers	to	listen	to	your	favorite
music	or	movies.

Microphones:	Record	live	music,	make	conference	calls,	and	mix	audio	on	the	go.	The	three-
microphone	array	on	the	MacBook	Pro	delivers	studio-quality	recordings	with	high	signal-to-noise
ratio	and	directional	beamforming.

https://support.apple.com/HT201300


Touch	Bar:	The	Touch	Bar	at	the	top	of	the	keyboard	dynamically	adapts	to	the	app	youʼre	using.
The	Touch	Bar	is	an	extension	of	the	keyboard—it	presents	intuitive	shortcuts	and	application
controls,	when	and	where	you	need	them.	You	can	use	familiar	gestures	like	swipe	and	tap	in	the
Touch	Bar.	See	Magic	Keyboard	for	13-inch	MacBook	Pro.

FaceTime	HD	camera:	Make	FaceTime	video	calls	or	take	pictures	and	video.	If	the	light	is
glowing,	the	camera	is	on.	See	FaceTime	and	Use	the	built-in	camera	on	Mac	in	the	macOS	User
Guide.

Touch	ID	(the	power	button):	Press	to	turn	on	your	MacBook	Pro	(or	just	lift	the	lid	or	press	any
key).	When	you	first	start	up	or	restart,	you	need	to	log	in	by	typing	your	password.	To	learn	more
about	how	to	use	Touch	ID,	see	Magic	Keyboard	for	13-inch	MacBook	Pro.

Force	Touch	trackpad:	Control	your	MacBook	Pro	with	gestures.	The	entire	trackpad	surface	acts
as	a	button	so	you	can	easily	click	anywhere.	For	more	about	using	gestures,	see	MacBook	Pro
trackpad.

Whatʼs	included:	14-inch	and	16-inch	MacBook	Pro
To	use	your	MacBook	Pro,	you	need	a	power	adapter	and	a	cable,	included	in	the	box:

Accessory Description

USB-C	to	MagSafe	3	Cable:	To	charge	your	MacBook	Pro,	connect	one
end	of	the	USB-C	to	MagSafe	3	Cable	to	the	MagSafe	3	port	on	your
MacBook	Pro,	and	the	other	end	to	the	power	adapter	(67W	USB-C
Power	Adapter,	96W	USB-C	Power	Adapter,	or	140W	USB-C	Power
Adapter).	When	you	first	connect	the	cable	to	MacBook	Pro,	an	indicator
on	the	connector	starts	to	glow,	indicating	battery	status:	green	for	fully
charged	or	amber	for	charging.

67W	USB-C	Power	Adapter	or	96W	USB-C	Power	Adapter:	After	the
power	adapter	is	connected,	fully	extend	the	electrical	prongs	on	the	AC
plug,	and	plug	the	adapter	into	an	AC	power	outlet.	The	96W	USB-C
Power	Adapter	for	the	14-inch	MacBook	Pro	fast	charges	MacBook	Pro	to
approximately	50	percent	in	about	30	minutes.

https://support.apple.com/guide/mac-help/use-the-built-in-camera-mchlp2980/11.0/mac/11.0


140W	USB-C	Power	Adapter:	After	the	power	adapter	is	connected,	fully
extend	the	electrical	prongs	on	the	AC	plug,	and	plug	the	adapter	into	an
AC	power	outlet.	The	140W	USB-C	Power	Adapter	for	the	16-inch
MacBook	Pro	fast	charges	MacBook	Pro	to	approximately	50	percent	in
about	30	minutes.

Accessory Description

Automatically	start	up	your	MacBook	Pro.	Use	the	USB-C	to	MagSafe	3	Cable	to	connect	your
MacBook	Pro	to	the	power	adapter	(67W	USB-C	Power	Adapter,	96W	USB-C	Power	Adapter,	or
140W	USB-C	Power	Adapter),	then	plug	in	the	power	adapter.	Lift	the	lid	and	touch	any	key	to	turn	on
and	start	up	your	MacBook	Pro.	Log	in	and	get	right	to	work.

Other	adapters	and	accessories	are	sold	separately.	Visit	apple.com,	your	local	Apple	Store,	or	other
resellers	for	more	information	and	availability.	Review	the	documentation	or	check	with	the
manufacturer	to	make	sure	you	choose	the	right	product.

Whatʼs	included:	13-inch	MacBook	Pro
To	use	your	MacBook	Pro,	you	need	these	two	accessories,	included	in	the	box:

Accessory Description

USB-C	Charge	Cable:	To	charge	your	MacBook	Pro,	connect	one	end	of
the	USB-C	Charge	Cable	to	any	Thunderbolt	port	on	your	MacBook	Pro,
and	the	other	end	to	the	61W	USB-C	Power	Adapter.

61W	USB-C	Power	Adapter:	After	the	power	adapter	is	connected,	fully
extend	the	electrical	prongs	on	the	AC	plug,	and	plug	the	adapter	into	an
AC	power	outlet.

https://store.apple.com


Automatically	start	up	your	MacBook	Pro.	Connect	your	61W	USB-C	Power	Adapter	and	USB-C
Charge	Cable	and	lift	the	lid	and	touch	any	key	to	turn	on	and	start	up	your	MacBook	Pro.	Log	in	and
get	right	to	work.

Other	adapters	and	accessories	are	sold	separately.	Visit	apple.com,	your	local	Apple	Store,	or	other
resellers	for	more	information	and	availability.	Review	the	documentation	or	check	with	the
manufacturer	to	make	sure	you	choose	the	right	product.

Magic	Keyboard	for	14-inch	and	16-inch	MacBook	Pro
The	function	keys	on	the	top	row	of	the	Magic	Keyboard	on	your	14-inch	and	16-inch	MacBook	Pro
provide	shortcuts	for	common	functions,	such	as	increasing	the	volume	or	screen	brightness.	Touch
ID	(the	power	button)	is	located	on	the	right	side	of	the	function	keys.	After	you	set	up	Touch	ID,	you
can	use	your	fingerprint	to	unlock	MacBook	Pro,	quickly	lock	your	screen,	or	make	purchases	from
the	App	Store,	Apple	TV	app,	and	Apple	Books,	and	on	websites	using	Apple	Pay.

You	can	set	up	Touch	ID	during	setup,	or	later	in	the	Touch	ID	pane	of	System	Preferences.	To	set
keyboard	preferences,	open	System	Preferences,	click	Keyboard,	then	click	the	buttons	at	the	top	to
see	the	available	options.

Use	Touch	ID	(the	power	button).	Press	to	turn	on	your	MacBook	Pro	(or	just	lift	the	lid	and	press
any	key).	When	you	first	start	up	or	restart	the	computer,	you	need	to	log	in	by	typing	your	password.
After	setup	and	initial	login,	whenever	youʼre	asked	for	your	password	in	the	same	session,	you	can
just	place	your	finger	lightly	on	the	Touch	ID	sensor	to	authenticate.

Press	the	Touch	ID	key	to	quickly	lock	your	screen.

You	can	also	use	Touch	ID	to	make	online	purchases	securely	with	Apple	Pay.	For	more	information
about	Touch	ID,	see	Set	up	your	MacBook	Pro.	For	more	information	about	Apple	Pay,	see	Use	Apple
Pay	on	your	Mac.

https://store.apple.com


Note:	To	turn	off	your	MacBook	Pro,	choose	Apple	menu	 	>	Shut	Down.	To	put	your	MacBook	Pro	to
sleep,	choose	Apple	menu	 	>	Sleep.

Many	system	functions	can	be	accessed	through	the	function	keys.

Brightness	keys	(F1,	F2):	Press	 	or	 	to	decrease	or	increase	the	brightness	of	the	screen.

Mission	Control	key	(F3):	Press	 	to	view	whatʼs	running	on	your	MacBook	Pro,	including	all	your
spaces	and	open	windows.

Spotlight	Search	(F4):	Press	 	to	open	Spotlight	and	easily	search	for	something	on	your
MacBook	Pro.

Dictation/Siri	(F5):	Press	 	to	activate	dictation—you	can	dictate	text	wherever	you	can	type	(for
example,	in	Messages,	Mail,	Pages,	and	other	apps).	To	activate	Siri,	press	and	hold	 ,	then
immediately	speak	your	request.

Do	Not	Disturb	key	(F6):	Press	 	to	turn	Do	Not	Disturb	on	or	off.	When	Do	Not	Disturb	is	on,	you
wonʼt	see	or	hear	notifications	on	MacBook	Pro,	but	you	can	view	them	later	in	Notification	Center.

Media	keys	(F7,	F8,	F9):	Press	 	to	rewind,	 	to	play	or	pause,	or	 	to	fast-forward	a	song,
movie,	or	slideshow.

Mute	key	(F10):	Press	 	to	mute	the	sound	from	the	built-in	speakers	or	3.5	mm	headphone	jack.

Volume	keys	(F11,	F12):	Press	 	or	 	to	decrease	or	increase	the	volume	of	sound	from	the	built-
in	speakers	or	3.5	mm	headphone	jack.

Function	(Fn)/Globe	key:	Press	 	to	switch	to	a	different	keyboard	(press	 	repeatedly	to	cycle
through	other	language	or	emoji	options	you	specify	in	preferences),	or	press	twice	to	start
dictation	(if	you	set	that	preference).	Press	and	hold	the	Fn	key	while	you	press	a	function	key	to
trigger	the	action	associated	with	the	key.	Each	function	key	on	the	top	row	can	also	perform
other	functions—for	example,	the	F11	key	can	hide	all	open	windows	and	show	the	desktop.

To	specify	options	for	the	Function	(Fn)/Globe	key,	open	System	Preferences,	click	Keyboard,	and
choose	options	to	change	your	keyboard	or	input	source,	show	emoji	and	symbols,	start	dictation,
or	define	functions.

Learn	about	keyboard	shortcuts.	You	can	press	key	combinations	to	do	things	on	your	MacBook	Pro
that	youʼd	normally	do	with	a	trackpad,	mouse,	or	other	device.	For	example,	press	Command-C	to
copy	selected	text,	then	click	where	you	want	to	paste	the	text	and	press	Command-V.	For	a	list	of
commonly	used	shortcuts,	see	Keyboard	shortcuts	on	your	Mac.	If	youʼre	new	to	the	Mac,	you	might
also	be	interested	in	Are	you	new	to	Mac?.

Magic	Keyboard	for	13-inch	MacBook	Pro



The	Touch	Bar	at	the	top	of	the	Magic	Keyboard	on	the	13-inch	MacBook	Pro	displays	a	set	of	tools
that	changes	based	on	what	youʼre	doing.	Touch	ID	(the	power	button)	is	located	on	the	right	side	of
the	Touch	Bar.	After	you	set	up	Touch	ID,	you	can	use	your	fingerprint	to	unlock	MacBook	Pro,
quickly	lock	your	screen,	or	make	purchases	from	the	App	Store,	Apple	TV	app,	and	Apple	Books,	and
on	websites	using	Apple	Pay.

You	can	set	up	Touch	ID	during	setup,	or	later	in	the	Touch	ID	pane	of	System	Preferences.	To	set
keyboard	and	Touch	Bar	preferences,	open	System	Preferences,	click	Keyboard,	then	click	the
buttons	at	the	top	to	see	the	available	options.

Use	Touch	ID	(the	power	button).	Press	to	turn	on	your	MacBook	Pro	(or	just	lift	the	lid	and	press
any	key).	When	you	first	start	up	or	restart	the	computer,	you	need	to	log	in	by	typing	your	password.
After	setup	and	initial	login,	whenever	youʼre	asked	for	your	password	in	the	same	session,	you	can
just	place	your	finger	lightly	on	the	Touch	ID	sensor	to	authenticate.

Press	the	Touch	ID	sensor	to	quickly	lock	your	MacBook	Pro	screen.

You	can	also	use	Touch	ID	to	make	secure	online	purchases	with	Apple	Pay.	For	more	information
about	Touch	ID,	see	Set	up	your	MacBook	Pro.	For	more	information	about	Apple	Pay,	see	Use	Apple
Pay	on	your	Mac.

Note:	To	turn	off	your	MacBook	Pro,	choose	Apple	menu	 	>	Shut	Down.	To	put	your	MacBook	Pro	to
sleep,	choose	Apple	menu	 	>	Sleep.

All	system	functions	are	located	on	the	Touch	Bar.

Brightness	buttons:	Press	 	or	 	to	decrease	or	increase	the	brightness	of	the	screen.

Mission	Control	button:	Press	 	to	view	whatʼs	running	on	your	MacBook	Pro,	including	all	your
spaces	and	open	windows.

Launchpad	button:	Press	 	to	open	Launchpad	and	instantly	see	all	the	apps	on	your	MacBook
Pro.	Click	an	app	to	open	it.

Keyboard	illumination	buttons:	Press	 	or	 	to	decrease	or	increase	the	brightness	of	the
keyboard.



Media	buttons:	Press	 	to	rewind,	 	to	play	or	pause,	or	 	to	fast-forward	a	song,	movie,	or
slideshow.

Mute	button:	Press	 	to	mute	the	sound	from	the	built-in	speakers	or	3.5	mm	headphone	jack.

Volume	buttons:	Press	 	or	 	to	decrease	or	increase	the	volume	of	sound	from	the	built-in
speakers	or	3.5	mm	headphone	jack.

Function	(Fn)	key:	Each	function	button	on	the	top	row	can	also	perform	other	functions—for
example,	the	F11	button	can	hide	all	open	windows	and	show	the	desktop.	Press	and	hold	the	Fn
key	while	you	press	a	function	button	to	trigger	the	action	associated	with	the	button.

Function	(Fn)/Globe	key:	Press	 	to	switch	to	another	keyboard	(press	 	repeatedly	to	cycle
through	other	language	or	emoji	options	you	specify	in	preferences).

To	specify	options	for	the	Function	(Fn)/Globe	key,	open	System	Preferences,	click	Keyboard,	and
choose	options	to	change	your	keyboard	or	input	source,	show	emoji	and	symbols,	start	dictation,
or	define	functions.	See	Change	Keyboard	preferences	on	Mac	in	the	macOS	User	Guide.

Learn	about	keyboard	shortcuts.	You	can	press	key	combinations	to	do	things	on	your	MacBook	Pro
that	youʼd	normally	do	with	a	trackpad,	mouse,	or	other	device.	For	example,	press	Command-C	to
copy	selected	text,	then	click	where	you	want	to	paste	the	text	and	press	Command-V.	For	a	list	of
commonly	used	shortcuts,	see	Keyboard	shortcuts	on	your	Mac.	If	youʼre	new	to	the	Mac,	you	might
also	be	interested	in	Are	you	new	to	Mac?.

Use	the	Touch	Bar	on	MacBook	Pro

https://support.apple.com/guide/mac-help/mchlf9bb4dee


The	Touch	Bar	on	the	13-inch	MacBook	Pro	is	integrated	into	many	macOS	apps	to	give	you	handy
shortcuts	for	the	tasks	you	do	most,	based	on	your	current	app	and	activity.	Use	familiar	gestures—
like	tap	and	swipe—in	the	Touch	Bar	while	you	work.

The	buttons	at	the	right	end	of	the	Touch	Bar	are	the	Control	Strip—you	use	them	to	expand	or
collapse	the	Control	Strip,	change	the	brightness	and	volume,	or	activate	Siri.	The	other	buttons	in
the	Touch	Bar	depend	on	the	app	youʼre	using.

Expand	or	collapse	the	Control	Strip.	Frequently	used	system	controls,	like	volume	and	brightness,
are	located	in	the	Control	Strip	on	the	right	side	of	the	Touch	Bar.	Tap	 	to	expand	the	strip,	then	tap
buttons	or	sliders	for	the	settings	you	want	to	change.	Tap	 	when	you	finish,	or	leave	the	Control
Strip	open	to	keep	the	buttons	available.

Customize	the	Control	Strip.	Click	Keyboard	in	System	Preferences,	then	click	Customize	Control
Strip.	Drag	controls	to	the	bottom	of	your	screen	and	into	the	Touch	Bar	to	add	them.	In	Keyboard
Preferences,	you	can	also	select	options	for	what	the	Control	Strip	displays—for	example,	function
keys	or	desktop	spaces.

Display	the	function	keys.	Press	and	hold	the	Function	(Fn)	key	to	display	the	function	keys	F1
through	F12	in	the	Touch	Bar,	then	tap	a	function	button	to	use	it.

Use	the	Esc	button.	The	Esc	button	usually	appears	on	the	left	side	of	the	Touch	Bar,	in	the	same
place	the	Esc	key	appears	on	traditional	keyboards.	Esc	appears	on	the	left	even	when	the	other	tools
on	the	Touch	Bar	change.



Tap	instead	of	type.	In	apps	where	you	compose	text,	like	Notes,	Messages,	TextEdit,	and	Mail,	the
Touch	Bar	can	display	typing	suggestions	to	help	you	save	time	by	presenting	words	and	emoji	you
can	tap	instead	of	type.	Tap	 	in	the	Touch	Bar	to	see	typing	suggestions,	if	theyʼre	not	already
showing.

Note:	Typing	suggestions	may	not	be	available	in	all	languages	or	in	all	areas.

Express	yourself	with	emoji.	In	some	apps,	you	can	choose	an	emoji	instead	of	words	for	a	fun	way
to	make	your	point.	Tap	 	to	display	the	emoji.	Swipe	to	scroll	through	options,	organized	by
category,	such	as	“Frequently	Used,”	“Smileys	&	People,”	“Travel	&	Places,”	and	more.	Tap	to	select
the	emoji	you	want.

Explore	and	experiment.	Tap	around	to	see	what	you	can	accomplish	quickly	and	efficiently.	Itʼs
often	easier	to	tap	the	Touch	Bar	than	to	click	or	select	items	onscreen	in	order	to	accomplish	a	task
or	apply	a	setting.	For	example,	open	Calculator	and	do	quick	calculations	with	the	number	keys	and
the	functions	on	the	Touch	Bar—no	more	moving	your	pointer,	clicking,	and	typing	onscreen.

Keep	using	the	Touch	Bar	to	find	the	best	ways	to	achieve	the	results	you	want.	Move	seamlessly
between	the	Touch	Bar,	your	keyboard,	and	the	trackpad	to	get	the	job	done.	See	Apps	on	your
MacBook	Pro	and	the	sections	for	each	app	for	information	about	their	Touch	Bar	features.

Learn	more.	See	Use	the	Touch	Bar	on	Mac	in	the	macOS	User	Guide.

Customize	the	Touch	Bar	on	the	13-inch	MacBook	Pro
In	the	Finder	and	in	apps	such	as	Mail	and	Safari,	you	can	customize	the	buttons	in	the	Touch	Bar.
You	can	also	customize	the	Control	Strip.	Choose	View	>	Customize	Touch	Bar	to	add,	delete,	or
rearrange	items	in	the	Touch	Bar.

When	youʼre	customizing	the	Touch	Bar,	the	buttons	jiggle.	For	example,	hereʼs	the	Calculator	Touch
Bar,	ready	to	be	edited:

Add	buttons	to	the	Touch	Bar.	Drag	controls	to	the	bottom	of	your	screen	and	into	the	Touch	Bar	to
add	them.

https://support.apple.com/guide/mac-help/touch-bar-mchlbfd5b039/mac


When	you	finish,	click	Done	on	the	screen.

Rearrange	buttons	in	the	Touch	Bar.	While	customizing	the	Touch	Bar,	drag	buttons	to	a	new
location.	When	you	finish,	click	Done	on	the	screen.

Remove	buttons	from	the	Touch	Bar.	While	customizing	the	Touch	Bar,	drag	a	button	from	the
Touch	Bar	to	the	screen	to	remove	it.	When	you	finish,	click	Done	on	the	screen.

MacBook	Pro	trackpad
You	can	do	a	lot	on	your	MacBook	Pro	using	simple	trackpad	gestures—scroll	through	webpages,
zoom	in	on	documents,	rotate	photos,	and	more.	With	the	Force	Touch	trackpad,	pressure-sensing
capabilities	add	another	level	of	interactivity.	The	trackpad	provides	feedback—when	you	drag	or
rotate	objects,	you	feel	a	subtle	vibration	when	theyʼre	aligned,	allowing	you	to	work	with	greater
precision.

Here	are	some	common	gestures:

Gesture Action

Click:	Press	anywhere	on	the	trackpad.	Or	enable	“Tap	to	click”	in
Trackpad	preferences,	and	simply	tap.

Force	click:	Click	and	then	press	deeper.	You	can	use	force	click	to	look
up	more	information—click	a	word	to	see	its	definition,	or	an	address	to
see	a	preview	that	you	can	open	in	Maps.



Secondary	click	(that	is,	right-click):	Click	with	two	fingers	to	open
shortcut	menus.	If	“Tap	to	click”	is	enabled,	tap	with	two	fingers.	On	the
keyboard,	press	the	Control	key	and	click	the	trackpad.

Two-finger	scroll:	Slide	two	fingers	up	or	down	to	scroll.

Pinch	to	zoom:	Pinch	your	thumb	and	finger	open	or	closed	to	zoom	in	or
out	of	photos	and	webpages.

Swipe	to	navigate:	Swipe	left	or	right	with	two	fingers	to	flip	through
webpages,	documents,	and	more—like	turning	a	page	in	a	book.

Open	Launchpad:	Quickly	open	apps	in	Launchpad.	Pinch	closed	with
four	or	five	fingers,	then	click	an	app	to	open	it.

Swipe	between	apps:	To	switch	from	one	full-screen	app	to	another,
swipe	left	or	right	with	three	or	four	fingers.

Gesture Action

Customize	your	gestures.	In	System	Preferences,	click	Trackpad.	You	can	do	the	following:

Learn	more	about	each	gesture

Set	the	click	pressure	you	prefer	to	use

Decide	whether	to	use	pressure-sensing	features

Customize	other	trackpad	features

Tip:	If	you	find	youʼre	force	clicking	when	you	donʼt	intend	to,	try	adjusting	the	click	pressure	to	a
firmer	setting	in	Trackpad	preferences.	Or	change	the	“Look	up	&	data	detectors”	option	from	the
“Force	Click	with	one	finger”	default	setting	to	“Tap	with	three	fingers.”

For	examples	of	force	click	options,	see	the	Apple	Support	article	How	to	use	the	Force	Touch
trackpad.

Charge	the	MacBook	Pro	battery
The	battery	in	your	MacBook	Pro	recharges	whenever	the	MacBook	Pro	is	connected	to	power,	unless
you	have	options	set.

https://support.apple.com/HT204352


Charge	the	battery.	Connect	your	13-inch	MacBook	Pro	to	a	power	outlet	using	the	included	USB-C
Charge	Cable	and	61W	USB-C	Power	Adapter.

Connect	your	14-inch	or	16-inch	MacBook	Pro	to	a	power	outlet	using	the	included	67W	USB-C
Power	Adapter,	96W	USB-C	Power	Adapter,	or	140W	USB-C	Power	Adapter	and	USB-C	to	MagSafe	3
Cable.

You	can	set	options	in	the	Battery	pane	of	System	Preferences:

Slightly	dim	the	display	while	on	battery	power:	Keeps	your	display	dimmed	to	save	energy	while
youʼre	using	battery	power.

Automatic	graphics	switching:	Your	MacBook	Pro	will	automatically	choose	the	best	graphics
mode	based	on	your	usage	to	increase	battery	life.

Optimize	video	streaming	while	on	battery:	This	is	not	on	by	default,	but	you	might	want	to	turn	it
on	while	doing	a	presentation.

Show	battery	status	in	menu	bar:	Adds	an	icon	to	the	status	bar	so	you	can	quickly	see
information	about	your	battery	and	open	Battery	Preferences.

Optimized	Battery	Charging:	This	feature	helps	to	reduce	the	wear	on	your	battery	and	improve	its
lifespan	by	learning	your	daily	charging	routine.	It	delays	charging	the	battery	past	80%	when	it
predicts	that	youʼll	be	plugged	in	for	an	extended	period	of	time,	and	aims	to	charge	the	battery
before	you	unplug.	You	can	change	this	option	in	Battery	preferences.

Low	Power	Mode:	This	option	reduces	energy	usage	and	increases	battery	life.	This	is	a	good
option	for	travel	or	when	youʼre	away	from	a	power	source	for	an	extended	period	of	time.

High	Power	Mode:	Available	on	the	16-inch	MacBook	Pro	with	Apple	M1	Max.	When	selected,	your
Mac	maximizes	performance	and	increases	energy	consumption	for	increased	speed	in	sustained
workloads.

To	charge	the	battery,	use	the	MagSafe	3	port	or	any	of	the	Thunderbolt	4	(USB-C)	ports	on	your	14-
inch	or	16-inch	MacBook	Pro,	or	any	of	the	Thunderbolt	/	USB	4	ports	on	your	13-inch	MacBook	Pro.

Note:	The	battery	charges	more	quickly	when	the	computer	is	off	or	in	sleep.



Check	the	batteryʼs	charge.	Look	at	the	battery	status	icon	at	the	right	of	the	menu	bar	to	see	the
battery	level	or	charging	status.

Battery	usage	history.	Click	Battery	in	System	Preferences,	then	click	Usage	History	to	see	your
batteryʼs	usage	over	the	past	24	hours	or	the	last	10	days.

Conserve	battery	power.	To	extend	battery	life	on	a	given	charge,	you	can	reduce	the	display
brightness,	close	apps,	and	disconnect	peripheral	devices	youʼre	not	using.	Click	Battery	in	System
Preferences	to	change	your	power	settings.	If	your	MacBook	Pro	is	in	sleep	when	a	device	is
connected	to	it,	the	deviceʼs	battery	may	drain.

Learn	more.	For	more	information	about:

The	battery	in	your	Mac,	including	troubleshooting	information,	see	the	Apple	Support	article	Get
help	with	your	Mac	notebook	battery.

How	to	monitor	the	battery	in	your	Mac,	see	Monitor	your	portable	Mac	computerʼs	battery	in	the
macOS	User	Guide.

Charging	issues	with	your	power	adapter,	see	the	Apple	Support	articles	If	your	USB-C	power
adapter	isnʼt	charging	your	Mac	notebook	and	If	your	Mac	battery	status	is	"Not	Charging".

The	internal,	rechargeable	battery	in	your	MacBook	Pro,	and	for	conservation	and	performance
tips,	see	Apple	Lithium-ion	Batteries.

https://support.apple.com/HT204054
https://support.apple.com/en-md/guide/mac-help/mchlp1115/10.15/mac/10.15
https://support.apple.com/HT204652
https://support.apple.com/guide/mac-help/if-your-battery-status-is-not-charging-mh20876/10.15/mac/10.15
https://www.apple.com/batteries


MacBook	Pro	accessories
The	following	Apple	accessories	are	available	to	connect	your	MacBook	Pro	to	power,	external
devices	and	displays,	and	more.

Cable	or	Adapter Description

USB-C	to	USB	Adapter:	Connect	your	MacBook	Pro	to	standard	USB
accessories.

USB-C	to	Lightning	Cable:	Connect	your	iPhone	or	other	iOS	or	iPadOS
device	to	your	MacBook	Pro	for	syncing	and	charging.

USB-C	Digital	AV	Multiport	Adapter:	Connect	your	MacBook	Pro	to	an
HDMI	display,	while	also	connecting	a	standard	USB	device	and	a	USB-C
charge	cable	to	charge	your	MacBook	Pro.

Connect	directly	to	the	HDMI	port	on	the	14-inch	and	16-inch	MacBook
Pro.

USB-C	VGA	Multiport	Adapter:	Connect	your	MacBook	Pro	to	a	VGA
projector	or	display,	while	also	connecting	a	standard	USB	device	and	a
USB-C	charge	cable	to	charge	your	MacBook	Pro.

Thunderbolt	3	(USB-C)	to	Thunderbolt	2	Adapter:	Connect	your
MacBook	Pro	to	Thunderbolt	2	devices.

Learn	more.	see	the	Apple	Support	article	Adapters	for	the	Thunderbolt	3	or	USB-C	port	on	your	Mac
or	iPad	Pro.

Adapters	and	other	accessories	are	sold	separately.	Visit	apple.com,	your	local	Apple	Store,	or	other
resellers	for	more	information	and	availability.	Review	the	documentation	or	check	with	the
manufacturer	to	make	sure	you	choose	the	right	product.

Work	with	wireless	accessories
Using	Bluetooth®	technology,	your	MacBook	Pro	can	wirelessly	connect	(that	is,	pair)	with	devices
such	as	a	Bluetooth	keyboard,	mouse,	trackpad,	headset,	wearable	sport	accessory,	and	more.

Connect	a	Bluetooth	device.	Turn	on	the	device	so	that	itʼs	discoverable,	then	open
System	Preferences	and	click	Bluetooth.	Select	the	device	in	the	list,	then	click	Connect.	The	device
remains	connected	until	you	remove	it.	Control-click	a	device	name	to	remove	it.

https://support.apple.com/HT207443
https://store.apple.com


Turn	Bluetooth	on	or	off.	Click	the	Control	Center	icon	 	in	the	menu	bar,	click	the	Bluetooth	icon	
,	then	click	the	control	to	turn	Bluetooth	on	or	off.	If	you	have	the	Bluetooth	 	icon	in	your	menu	bar,

you	can	click	that	and	then	turn	the	control	on	or	off.	Your	MacBook	Pro	comes	with	Bluetooth	turned
on.

Tip:	If	you	donʼt	see	the	Bluetooth	icon	 	in	the	menu	bar,	you	can	add	it.	Click	the	Bluetooth	icon	
	in	Control	Center,	click	Bluetooth	Preferences,	then	select	“Show	Bluetooth	in	menu	bar.”

Learn	more.	See	Use	Bluetooth	devices	with	Mac	in	the	macOS	User	Guide.

Use	an	external	display	with	your	MacBook	Pro
You	can	use	an	external	display,	a	projector,	or	an	HDTV	with	your	14-inch	or	16-inch	MacBook	Pro.
The	HDMI	and	Thunderbolt	ports	on	your	MacBook	Pro	support	video	output.	You	can	connect	up	to
two	external	displays	with	up	to	6K	resolution	at	60Hz	(Apple	M1	Pro)	or	up	to	three	external	displays
with	up	to	6K	resolution	and	one	external	display	with	up	to	4K	resolution	at	60Hz	(Apple	M1	Max).

You	can	use	an	external	display,	a	projector,	or	an	HDTV	with	your	13-inch	MacBook	Pro.	The
Thunderbolt	ports	on	your	MacBook	Pro	support	video	output.

Connect	a	VGA	display	or	projector:	Use	a	USB-C	VGA	Multiport	Adapter	to	connect	the	display	or
projector	to	a	Thunderbolt	port	on	your	MacBook	Pro.

Connect	an	HDMI	display	or	HDTV:	Plug	a	cable	from	your	HDMI	display	or	HDTV	directly	into	the
HDMI	port	on	your	14-inch	or	16-inch	MacBook	Pro.	Use	a	USB-C	Digital	AV	Multiport	Adapter	to
connect	the	HDMI	display	or	HDTV	to	a	Thunderbolt	/	USB	4	port	on	your	13-inch	MacBook	Pro.

Connect	a	USB-C	display:	Connect	the	display	to	a	Thunderbolt	port	on	your	MacBook	Pro.

https://support.apple.com/guide/mac-help/blth8111/mac


Note:	The	MacBook	Pro	can	support	full	6K	resolution	on	the	Apple	Pro	Display	XDR.	See	the	“System
requirements	and	compatible	Mac	models”	section	of	the	Apple	Support	article	Set	up	and	use	Apple
Pro	Display	XDR.

If	your	display	has	a	connector	that	doesnʼt	match	the	port	you	want	to	use,	you	may	be	able	to	use	it
with	an	adapter	(sold	separately).	Visit	apple.com,	your	local	Apple	Store,	or	other	resellers	for	more
information	and	availability.	Review	the	displayʼs	documentation	or	check	with	the	displayʼs
manufacturer	to	make	sure	you	choose	the	right	product.	See	Adapters	for	the	ports	on	your	Mac	or
iPad	Pro.

Tip:	If	you	have	an	HDTV	connected	to	an	Apple	TV,	you	can	use	AirPlay	to	mirror	your	MacBook
Pro	screen	on	your	TV	screen	in	up	to	1080p	HD.	See	Use	AirPlay	on	your	Mac	for	details.

Adjust	and	arrange	displays.	After	you	connect	an	external	display	or	projector,	use	Displays
preferences	in	System	Preferences	to	set	how	the	displays	are	arranged,	turn	screen	mirroring	on	or
off,	and	make	other	adjustments	to	color,	resolution,	and	more.

Troubleshooting.	If	youʼre	not	sure	how	many	external	displays	your	MacBook	Pro	supports,	check
the	Resources	tab	in	About	This	Mac.	Choose	Apple	menu	 	>	About	This	Mac	>	Resources,	click
Specifications,	then	locate	Video	Support	(you	may	need	to	scroll).	To	troubleshoot	an	issue	with	an
external	display,	see	If	your	external	display	isn't	detected	or	appears	blurry	on	your	Mac.

https://support.apple.com/HT210437
https://apple.com
https://support.apple.com/HT207443
https://support.apple.com/HT201177


Get	started

Set	up	your	MacBook	Pro
The	first	time	your	MacBook	Pro	starts	up,	Setup	Assistant	walks	you	through	the	simple	steps
needed	to	start	using	your	new	Mac.	You	can	respond	to	all	the	prompts,	or	skip	some	steps	and
choose	to	complete	them	later.	For	example,	it	might	make	sense	to	set	up	Screen	Time—which	you
can	set	for	different	users—after	initial	setup.

Setup	Assistant	guides	you	through	the	following:

Set	your	country	or	region:	This	sets	the	language	and	time	zone	for	your	Mac.

Accessibility	options:	View	accessibility	options	for	Vision,	Motor,	Hearing,	Cognitive	abilities,	or
click	Not	Now.	To	learn	more,	see	Accessibility	on	your	Mac.

Connect	to	a	Wi-Fi	network:	Choose	the	network	and	enter	a	password,	if	necessary.	(If	youʼre
using	Ethernet,	you	can	also	choose	Other	Network	Options.)	To	change	the	network	later,	click
the	Wi-Fi	status	icon	 	in	the	menu	bar	or	in	Control	Center,	click	Other	Networks,	then	choose	a
Wi-Fi	network	and	enter	the	password.	You	can	also	choose	to	turn	Wi-Fi	on	or	off	here.

Tip:	After	setup,	if	you	donʼt	see	the	Wi-Fi	status	icon	 	in	the	menu	bar,	you	can	add	it.
Open	System	Preferences,	then	click	Network.	Click	Wi-Fi	in	the	list	on	the	left,	then	select	“Show
Wi-Fi	status	in	menu	bar.”

Transfer	information:	If	youʼre	setting	up	a	new	computer	and	you	havenʼt	previously	set	up	a
Mac,	click	Not	Now	in	the	Migration	Assistant	window.	If	you	want	to	transfer	your	data	from
another	computer	now	or	later,	see	Transfer	your	data	to	your	new	MacBook	Pro.



Sign	in	with	your	Apple	ID:	Your	Apple	ID	consists	of	an	email	address	and	a	password.	Itʼs	the
account	you	use	for	everything	you	do	with	Apple—including	using	the	App	Store,	Apple	TV	app,
Apple	Books,	iCloud,	Messages,	and	more.	Itʼs	best	to	have	your	own	Apple	ID	and	not	share	it.	If
you	donʼt	already	have	an	Apple	ID,	you	can	create	one	during	setup	(itʼs	free).
Sign	in	with	the	same	Apple	ID	to	use	any	Apple	service,	on	any	device—whether	itʼs	your
computer,	iOS	device,	iPadOS	device,	or	Apple	Watch.	See	Apple	Account	on	Mac.

Tip:	If	youʼve	already	set	up	another	device	with	the	latest	software	versions	(macOS	12	or
later,	iOS	15	or	later,	iPadOS	15	or	later),	youʼll	see	a	panel	for	express	setup,	“Make	This	Your
new	Mac,”	that	skips	a	lot	of	the	steps	and	uses	the	settings	stored	in	your	iCloud	account.

Store	files	in	iCloud:	With	iCloud,	you	can	store	your	content—documents,	photos,	and	more—in
the	cloud,	and	access	it	anywhere	you	go.	Be	sure	to	sign	in	with	the	same	Apple	ID	on	all	your
devices.	To	set	this	option	later,	open	System	Preferences	and	sign	in	with	your	Apple	ID	if	you
havenʼt	already.	Click	Apple	ID,	click	iCloud	in	the	sidebar,	then	select	the	features	you	want	to
use.	You	can	also	choose	to	use	iCloud	Keychain	to	save	your	passwords	during	setup.	To	find	out
more,	see	Access	your	iCloud	content	on	your	Mac.

Screen	Time:	Monitor	and	get	reports	on	the	use	of	your	computer.	For	options	and	details,	see
Screen	Time	on	Mac.

Enable	Siri	and	“Hey	Siri”:	You	can	turn	on	Siri	and	“Hey	Siri”	(so	you	can	speak	your	Siri
requests)	during	setup.	To	enable	“Hey	Siri,”	speak	several	Siri	commands	when	prompted.	To
learn	how	to	turn	on	Siri	and	“Hey	Siri”	later	and	for	information	about	using	Siri	on	your	Mac,	see
Siri	on	your	Mac.

Set	up	Touch	ID:	You	can	add	a	fingerprint	to	Touch	ID	during	setup.	To	set	up	Touch	ID	later,	or
to	add	additional	fingerprints,	open	System	Preferences,	then	click	Touch	ID.	To	add	a	fingerprint,
click	 	and	follow	the	onscreen	instructions.

You	can	also	set	options	for	how	you	want	to	use	Touch	ID	on	your	MacBook	Pro:	to	unlock	your
Mac,	use	Apple	Pay	(see	Use	Apple	Pay	on	your	Mac),	purchase	items	on	the	App	Store,	Apple	TV
app,	Apple	Books,	and	websites,	and	auto-fill	your	password.

Tip:	If	two	or	more	users	use	the	same	MacBook	Pro,	each	user	can	add	a	fingerprint	to	Touch
ID	to	quickly	unlock,	authenticate,	and	log	in	to	the	MacBook	Pro.	You	can	add	up	to	three
fingerprints	per	user	account,	and	a	total	of	five	fingerprints	for	all	your	MacBook	Pro	user
accounts.

To	learn	more,	see	Use	Touch	ID	on	Mac	in	the	macOS	User	Guide.

https://support.apple.com/guide/mac-help/touch-id-mchl16fbf90a/mac


Set	up	Apple	Pay:	You	can	set	up	Apple	Pay	for	one	user	account	on	your	MacBook	Pro	during
setup.	Other	users	can	still	pay	with	Apple	Pay,	but	they	must	complete	the	purchase	using	their
iPhone	or	Apple	Watch	thatʼs	been	set	up	for	Apple	Pay	(see	Use	Apple	Pay	on	your	Mac).	Follow
the	onscreen	prompts	to	add	and	verify	your	card.	If	you	already	use	a	card	for	media	purchases,
you	might	be	prompted	to	verify	this	card	first.

To	set	up	Apple	Pay	or	add	additional	cards	later,	open	System	Preferences,	then	click	Wallet	&
Apple	Pay.	Follow	the	onscreen	prompts	to	set	up	Apple	Pay.

Note:	The	card	issuer	determines	whether	your	card	is	eligible	to	use	with	Apple	Pay,	and	may	ask
you	to	provide	additional	information	to	complete	the	verification	process.	Many	credit	and	debit
cards	can	be	used	with	Apple	Pay.	For	information	about	Apple	Pay	availability	and	current	credit
card	issuers,	see	the	Apple	Support	article	Apple	Pay	participating	banks.

Choose	your	look:	Select	Light,	Dark,	or	Auto	for	your	desktop	appearance.	If	you	want	to	change
the	choice	you	make	during	setup,	open	System	Preferences,	click	General,	then	select	an
appearance	option.	You	can	also	set	other	preferences	here.

Tip:	If	youʼre	new	to	Mac,	see	Are	you	new	to	Mac?	and	the	Apple	Support	articles	Whatʼs	it	called
on	my	Mac?	and	Mac	tips	for	Windows	switchers.

Apple	Account	on	Mac
Your	Apple	ID	is	an	account	that	lets	you	access	all	Apple	services.	Use	your	Apple	ID	to	download
apps	from	the	App	Store;	access	media	in	Apple	Music,	Apple	Podcasts,	Apple	TV,	and	Apple	Books;
keep	your	content	up	to	date	across	devices	using	iCloud;	set	up	a	Family	Sharing	group;	and	more.

You	can	also	use	your	Apple	ID	to	access	other	apps	and	websites	(see	Use	Sign	in	with	Apple	on
Mac	in	the	macOS	User	Guide).

Important:	If	you	forget	your	Apple	ID	password,	you	donʼt	need	to	create	a	new	Apple	ID.	Just	click
the	“Forgot	Apple	ID	or	password?”	link	in	the	sign-in	window	to	retrieve	your	password.

If	other	family	members	use	Apple	devices,	make	sure	that	each	family	member	has	their	own	Apple
ID.	You	can	create	Apple	ID	accounts	for	your	kids	and	share	purchases	and	subscriptions	with	Family
Sharing,	described	later	in	this	section.

To	view	the	services	you	can	use	with	your	Apple	ID,	see	the	Apple	Support	article	Where	can	I	use
my	Apple	ID?.

All	in	one	place.	Manage	everything	related	to	your	Apple	ID	in	the	same	place.	Open
System	Preferences	on	your	MacBook	Pro—your	Apple	ID	and	Family	Sharing	settings	are	at	the	top.

https://support.apple.com/HT204916
https://support.apple.com/guide/mac-help/whats-it-called-on-my-mac-cpmh0038/mac
https://support.apple.com/HT204216
https://support.apple.com/guide/mac-help/mchl12f76694
https://support.apple.com/HT202659


Update	account,	security,	and	payment	information.	In	System	Preferences,	click	Apple	ID,	then
select	an	item	in	the	sidebar	to	review	and	update	the	information	associated	with	your	account.

Overview:	The	Overview	pane	lets	you	know	if	your	account	is	set	up	and	working	properly—if	not,
you	see	tips	and	notifications	here.

Name,	Phone,	Email:	Update	the	name	and	contact	information	associated	with	your	Apple	ID.	You
can	also	manage	Apple	email	newsletter	subscriptions.

Password	&	Security:	Change	your	Apple	ID	password,	turn	on	two-factor	authentication,	add	or
remove	trusted	phone	numbers,	and	generate	verification	codes	to	sign	in	to	another	device	or
iCloud.com.	You	can	also	manage	which	apps	and	websites	use	Sign	in	with	Apple.	See	Use	Sign
in	with	Apple	in	the	macOS	User	Guide.

Payment	&	Shipping:	Manage	the	payment	methods	affiliated	with	your	Apple	ID,	and	your
shipping	address	for	purchases	from	the	Apple	Store.

iCloud:	Select	the	checkbox	next	to	an	iCloud	feature	to	turn	the	feature	on.	When	you	turn	on	an
iCloud	feature,	your	content	is	stored	in	iCloud	and	not	locally	on	your	Mac,	so	you	can	access	any
content	on	any	device	with	iCloud	turned	on	and	signed	in	with	the	same	Apple	ID.

Media	&	Purchases:	Manage	the	accounts	linked	to	Apple	Music,	Apple	Podcasts,	Apple	TV,	and
Apple	Books;	select	purchasing	settings;	and	manage	your	subscriptions.

https://www.icloud.com
https://support.apple.com/guide/mac-help/use-sign-in-with-apple-for-apps-and-websites-mchl12f76694/10.15/mac/10.15


See	all	your	devices.	At	the	bottom	of	the	Apple	ID	sidebar,	see	all	the	devices	linked	to	your	Apple
ID.	You	can	verify	that	Find	My	[device]	is	turned	on	for	each	one	(see	Find	My),	see	the	status	of
iCloud	Backup	for	an	iOS	or	iPadOS	device,	or	remove	a	device	from	your	account	if	you	no	longer
own	it.

Family	Sharing.	With	Family	Sharing,	you	can	set	up	a	family	group	and	create	Apple	ID	accounts	for
your	kids.	To	manage	your	family	sharing	settings,	click	Family	Sharing	in	System	Preferences	and
select	an	icon	in	the	sidebar	to	review	and	update	your	information.	You	can	add	or	remove	family
members;	share	media	purchases,	payment	methods,	iCloud	storage,	and	your	locations;	and	set
Screen	Time	limits	for	your	children	(see	Screen	Time	on	Mac).	To	learn	more,	see	the	Apple	Support
article	Set	up	Family	Sharing.

Share	purchases	and	storage	with	Family	Sharing.	Up	to	six	members	of	your	family	can	share	their
purchases	from	the	App	Store,	Apple	TV	app,	Apple	Books,	and	iTunes	Store	and	share	the	same
storage	plan—even	if	they	each	use	their	own	iCloud	account.	Pay	for	family	purchases	with	one
credit	card,	and	approve	your	kidsʼ	spending	right	from	your	MacBook	Pro,	iOS	device,	or	iPadOS
device.	Share	locations,	so	you	can	help	family	members	find	lost	devices.

Account	Recovery.	Add	one	or	more	people	you	trust	as	a	recovery	contact	or	set	up	a	recovery	key
to	help	you	reset	your	password	and	regain	access	to	your	account.

https://support.apple.com/HT201088


Learn	more.	To	learn	more	about	iCloud	and	Family	Sharing,	see	Access	your	iCloud	content	on	your
Mac	and	Manage	a	Family	Sharing	group	on	Mac	in	the	macOS	User	Guide.

Find	your	way	around

The	desktop,	menu	bar,	and	Help	on	your	Mac
The	first	thing	you	see	on	your	MacBook	Pro	is	the	desktop,	where	you	can	quickly	open	apps,	search
for	anything	on	your	MacBook	Pro	and	the	web,	organize	your	files,	and	more.

https://support.apple.com/guide/mac-help/manage-a-family-sharing-group-on-mac-mh5a9bb78c90/mac


Tip:	Canʼt	find	the	pointer	on	the	screen?	To	magnify	it	temporarily,	move	your	finger	rapidly	back
and	forth	on	the	trackpad.	Or	if	youʼre	using	a	mouse,	slide	it	back	and	forth	quickly.

Menu	bar.	The	menu	bar	runs	along	the	top	of	the	screen.	Use	the	menus	on	the	left	side	to	choose
commands	and	perform	tasks	in	apps.	The	menu	items	change,	depending	on	which	app	youʼre	using.
Use	the	icons	on	the	right	side	to	connect	to	a	Wi-Fi	network,	check	your	Wi-Fi	status	 ,	open
Control	Center	 ,	check	your	battery	charge	 ,	search	using	Spotlight	 ,	and	more.

Tip:	You	can	change	the	icons	that	appear	in	the	menu	bar.	See	Control	Center	on	your	Mac.

Apple	menu	 .	The	Apple	menu	contains	frequently	used	items	and	always	appears	in	the	upper-left
corner	of	the	screen.	To	open	it,	click	the	Apple	icon	 .

App	menu.	You	can	have	multiple	apps	and	windows	open	at	the	same	time.	The	name	of	the	app
thatʼs	active	appears	in	bold	to	the	right	of	the	Apple	menu	 ,	followed	by	that	appʼs	unique	menus.	If
you	open	a	different	app	or	click	an	open	window	in	a	different	app,	the	name	of	the	app	menu
changes	to	that	app	and	the	menus	in	the	menu	bar	change	along	with	it.	If	youʼre	looking	for	a
command	in	a	menu	and	canʼt	find	it,	check	the	app	menu	to	see	if	the	app	you	want	is	active.

Help	menu.	Help	for	your	MacBook	Pro	is	always	available	in	the	menu	bar.	To	get	help,	open	the
Finder	in	the	Dock,	click	the	Help	menu,	and	choose	macOS	Help	to	open	the	macOS	User	Guide.	Or
type	in	the	search	field	and	choose	a	suggestion.	To	get	help	for	a	specific	app,	open	the	app	and
click	Help	in	the	menu	bar.	See	Use	the	macOS	User	Guide.



Stay	organized	with	stacks.	You	can	gather	files	on	the	desktop	into	stacks	to	keep	them	organized
in	groups	(by	kind,	date,	or	tag),	and	to	keep	your	desktop	orderly.	To	view	whatʼs	inside	a	stack,
click	the	stack	to	expand	its	contents,	or	place	your	pointer	over	a	stack	to	view	thumbnail	images	of
the	files.	To	create	stacks	on	your	desktop,	click	the	desktop,	then	choose	View	>	Use	Stacks.	To	see
grouping	options	for	your	stacks,	go	to	View	>	Group	Stacks	By	and	choose	an	option.	Then	any	new
files	you	add	to	the	desktop	are	automatically	sorted	into	the	appropriate	stack.	To	learn	more,	see
Organize	files	in	stacks	on	Mac	in	the	macOS	User	Guide.

Learn	more.	See	The	Finder	on	your	Mac.

The	Finder	on	your	Mac
Represented	by	the	blue	icon	with	the	smiling	face,	the	Finder	is	the	home	base	for	your	Mac.	You
use	it	to	organize	and	access	almost	everything	on	your	Mac,	including	documents,	images,	movies,
and	any	other	files	you	have.	To	open	a	Finder	window,	click	the	Finder	icon	 	in	the	Dock	at	the
bottom	of	the	screen.	Force	click	a	file	icon	to	quickly	view	its	contents,	or	force	click	a	filename	to
edit	it.	See	MacBook	Pro	trackpad	to	learn	about	force	clicking	and	other	gestures.

For	information	about	using	the	Touch	Bar	for	Finder	tasks,	see	Use	the	Finder	with	the	Touch	Bar	on
your	13-inch	MacBook	Pro.

https://support.apple.com/guide/mac-help/stacks-mh35846/mac


The	Finder	window.	Click	the	pop-up	menu	button	at	the	top	of	the	Finder	window	to	change	how
you	view	documents	and	folders.	View	them	as	icons,	in	a	list,	in	hierarchical	columns,	or	in	a	gallery.
The	sidebar	on	the	left	shows	icons	for	the	items	you	use	often	or	want	to	open	quickly.	To	see	all
your	documents	stored	on	iCloud	Drive,	click	the	iCloud	Drive	folder	in	the	sidebar,	and	to	see	only
the	documents	youʼre	sharing	and	that	are	shared	with	you,	click	the	Shared	folder.	To	change	whatʼs
shown	in	the	sidebar,	choose	Finder	>	Preferences.

Get	organized.	Your	Mac	has	folders	already	created	for	common	types	of	content—Documents,
Pictures,	Applications,	Music,	and	more.	As	you	create	documents,	install	apps,	and	do	other	work,
you	can	create	new	folders	to	stay	organized.	To	create	a	new	folder,	choose	File	>	New	Folder.	See
Organize	files	in	folders.

Sync	devices.	When	you	connect	a	device	like	an	iPhone	or	iPad,	it	appears	in	the	Finder	sidebar.
Double-click	the	deviceʼs	icon	to	see	options	to	back	up,	update,	sync,	and	restore	your	device.

Gallery	View.	With	Gallery	View,	you	can	see	a	large	preview	of	your	selected	file,	so	you	can	visually
identify	your	images,	video	clips,	and	other	documents.	The	Preview	pane	on	the	right	shows
information	to	help	you	identify	the	file	you	want.	Use	the	scrubber	bar	at	the	bottom	to	quickly	locate
what	youʼre	looking	for.	To	close	or	open	the	Preview	pane,	press	Shift-Command-P.	To	show	the
Preview	pane	options	in	the	Finder,	choose	View	>	Show	Preview.	To	customize	whatʼs	shown,
choose	View	>	Show	Preview	Options,	then	select	the	options	for	your	file	type.

Tip:	To	show	filenames	in	Gallery	View,	press	Command-J	and	select	“Show	filename.”

https://support.apple.com/guide/mac-help/mh26885/


Quick	Actions.	In	Gallery	View,	click	the	More	button	 	at	the	bottom	right	of	the	Finder	window	for
shortcuts	to	manage	and	edit	files	directly	in	the	Finder.	You	can	rotate	an	image,	annotate	or	crop	an
image	in	Markup,	combine	images	and	PDFs	into	a	single	file,	trim	audio	and	video	files,	run	shortcuts



created	with	the	Shortcuts	app,	and	create	custom	actions	through	Automator	workflows	(for
example,	watermarking	a	file).	See	Perform	quick	actions	in	the	Finder	on	Mac	in	the	macOS	User
Guide.

Quick	Look.	Select	a	file	and	press	the	Space	bar	to	open	Quick	Look.	Use	the	buttons	at	the	top	of
the	Quick	Look	window	to	sign	PDFs;	trim	audio	and	video	files;	and	mark	up,	rotate,	and	crop	images
without	opening	a	separate	app.	To	learn	more	about	Quick	Look	and	markup	features,	see	View	and
edit	files	with	Quick	Look	on	Mac	and	Mark	up	files	on	Mac	in	the	macOS	User	Guide.

Tip:	You	can	add	alternative	image	descriptions	that	can	be	read	by	VoiceOver	using	Markup	in
Preview	or	Quick	Look.

Get	there	faster.	The	Go	menu	in	the	menu	bar	is	a	quick	way	to	get	to	folders	and	locations.	Instead
of	using	several	clicks	to	navigate	to	the	Utilities	folder,	choose	Go	>	Utilities.	You	can	also	choose
Go	>	Enclosing	Folder	to	return	to	the	top	level	of	nested	folders.	If	you	know	the	path	to	a	specific
folder,	choose	Go	>	Go	to	Folder,	then	type	the	path.	See	Go	directly	to	a	specific	folder	in	the
macOS	User	Guide.

Use	the	Finder	with	the	Touch	Bar	on	your	13-inch	MacBook	Pro
Use	the	Touch	Bar,	at	the	top	of	your	keyboard,	to	perform	Finder	tasks	and	more.

Use	the	Touch	Bar.	Tap	buttons	to	move	back	and	forth	through	items	youʼve	viewed,	set	view
options,	and	quickly	look	at,	share,	or	tag	an	item.

Tap	 	to	see	buttons	for	viewing	and	sorting	options:

Tap	 	to	see	sharing	options:

Tap	 	to	see	tags	you	can	apply:

To	learn	more,	see	Use	the	Touch	Bar	on	MacBook	Pro.

The	Dock	on	your	Mac
The	Dock,	at	the	bottom	of	the	screen,	is	a	convenient	place	to	keep	the	apps	and	documents	you
use	frequently.

https://support.apple.com/guide/mac-help/mchl97ff9142/
https://support.apple.com/guide/mac-help/mh14119/
https://support.apple.com/guide/mac-help/mchl1fd88863/
https://support.apple.com/guide/mac-help/mchlp1236


Open	an	app	or	file.	Click	an	app	icon	in	the	Dock,	or	click	the	Launchpad	icon	 	in	the	Dock	to	see
all	the	apps	on	your	Mac,	then	click	the	app	you	want.	You	can	also	search	for	an	app	using	Spotlight	

	(in	the	top-right	corner	of	the	menu	bar),	then	open	the	app	directly	from	your	Spotlight	search
results.	Recently	opened	apps	appear	in	the	center	section	of	the	Dock.

Close	an	app.	When	you	click	the	red	dot	in	the	top-left	corner	of	an	open	window,	the	window
closes	but	the	app	stays	open.	Open	apps	have	a	black	dot	beneath	them	in	the	Dock.	To	close	an
app,	choose	“Quit	appname”	from	the	app	menu	(for	example,	in	the	Mail	app,	choose	Quit	Mail	from
the	Mail	menu).	Or	Control-click	the	app	icon	in	the	Dock	and	click	Quit.

Add	an	item	to	the	Dock.	Drag	the	item	and	drop	it	where	you	want	it.	Place	apps	in	the	left	section
of	the	Dock,	and	files	or	folders	in	the	right	section.

Remove	an	item	from	the	Dock.	Drag	it	out	of	the	Dock.	The	item	isnʼt	removed	from	your	MacBook
Pro—just	from	the	Dock.

See	everything	thatʼs	open	on	your	Mac.	Press	the	Mission	Control	key	 	on	your	keyboard	or
swipe	with	three	fingers	on	your	trackpad	to	open	Mission	Control.	View	your	open	windows,	desktop
spaces,	full-screen	apps,	and	more,	and	switch	easily	between	them.	You	can	also	add	the	Mission
Control	icon	 	to	the	Dock.	See	the	Apple	Support	article	Use	Mission	Control	on	your	Mac.

See	all	open	windows	in	an	app.	Force	click	an	app	in	the	Dock	to	view	all	the	appʼs	open	windows.

Tip:	Click	Dock	&	Menu	Bar	in	System	Preferences	to	change	the	appearance	and	behavior	of	the
Dock.	Make	the	Dock	larger	or	smaller,	move	it	to	the	left	or	right	side	of	the	screen,	set	it	to	hide
when	youʼre	not	using	it,	and	more.

Learn	more.	See	Use	the	Dock	on	Mac	in	the	macOS	User	Guide.

Notification	Center	on	your	Mac

https://support.apple.com/HT204100
https://support.apple.com/guide/mac-help/dock-mh35859/mac


Notification	Center	keeps	all	of	your	important	information,	reminders,	and	widgets	in	one	convenient
place.	Get	details	about	calendar	events,	stocks,	weather,	and	more—and	catch	up	on	notifications
you	might	have	missed	(emails,	messages,	reminders,	and	more).

Open	Notification	Center.	Click	the	date	or	time	at	the	top	right	of	the	screen,	or	swipe	left	from	the
right	edge	of	the	trackpad	with	two	fingers.	Scroll	down	to	see	more.

Focus	on	what	youʼre	doing.	When	youʼre	working,	having	dinner,	or	just	donʼt	want	to	be	disturbed,
Focus	can	automatically	filter	your	notifications	so	you	see	only	the	ones	you	specify.	Focus	can
pause	all	notifications	or	allow	only	certain	ones	to	appear,	and	sends	an	auto-reply—called	a	Focus
Status—to	people	trying	to	reach	you,	so	they	know	your	notifications	are	silenced.	You	can	set	or
customize	a	Focus	to	fit	what	youʼre	currently	doing,	and	allow	notifications	from	certain	people	or
apps,	for	phone	calls	or	upcoming	events,	and	more.	To	set	up	Focus,	open	System	Preferences	

,	click	Notifications	&	Focus,	then	click	Focus.	To	turn	Focus	on	or	off,	click	 	in	the	menu	bar,	then
click	the	Focus	section	and	choose	a	Focus.

Interact	with	your	notifications.	Reply	to	an	email,	listen	to	the	latest	podcast,	or	view	details	about
calendar	events.	Click	the	arrow	in	the	top-right	corner	of	a	notification	to	view	options,	take	action,
or	get	more	information.

Customize	your	widgets.	Click	Edit	Widgets	(at	the	bottom	of	your	notifications)	to	add,	remove,	or
rearrange	widgets.	You	can	also	add	third-party	widgets	from	the	Mac	App	Store.



Set	your	notification	preferences.	Open	System	Preferences,	click	Notifications	&	Focus,	then	click
Notifications	to	select	which	notifications	you	see.	Notifications	are	sorted	by	most	recent,	and
redesigned	Today	widgets	deliver	information	at	a	glance.

Learn	more.	See	the	Apple	Support	article	Use	Notifications	on	your	Mac.

Control	Center	on	your	Mac
Control	Center	groups	all	your	menu	bar	extras	into	a	single	place,	giving	you	instant	access	to	the
controls	you	use	the	most—like	Bluetooth,	AirDrop,	Mic	Mode,	Screen	Mirroring,	Focus,	and
brightness	and	volume	controls—right	from	the	menu	bar.	Click	 	in	the	upper-right	corner	of	the
screen	to	open	Control	Center.

Monitor	your	mic.	The	recording	indicator	shows	when	your	computerʼs	microphone	is	in	use	or	if	it
was	used	recently.	This	light	increases	security	and	privacy	on	your	Mac	by	letting	you	know	if	an	app
has	access	to	the	microphone.

Click	for	more	options.	Click	a	button	to	see	more	options.	For	example,	click	the	Wi-Fi	button	 	to
see	your	preferred	networks,	other	networks,	or	to	open	Network	Preferences.	To	return	to	the	main
Control	Center	view,	click	 	again.

Pin	your	Control	Center	favorites.	Drag	a	favorite	item	from	Control	Center	to	the	menu	bar	to	pin	it
there,	so	you	can	easily	access	it	with	a	single	click.	To	change	what	appears	in	Control	Center	and	in
the	menu	bar,	open	Dock	&	Menu	Bar	preferences,	select	a	control	on	the	left,	then	click	“Show	in
Menu	Bar”	or	“Show	in	Control	Center.”	You	see	a	preview	of	where	the	control	will	appear	in	the
menu	bar.	Some	items	canʼt	be	added	to	or	removed	from	Control	Center	or	the	menu	bar.

https://support.apple.com/HT204079


Tip:	To	quickly	remove	an	item	from	the	menu	bar,	press	and	hold	the	Command	key	and	drag	the
item	out	of	the	menu	bar.

Learn	more.	See	Use	Control	Center	on	Mac	in	the	macOS	User	Guide.	Also	see	Use	AirDrop	on	your
Mac	and	Use	AirPlay	on	your	Mac.

System	Preferences	on	your	Mac
System	Preferences	is	the	place	where	you	personalize	your	MacBook	Pro	settings.	For	example,	use
Battery	preferences	to	change	sleep	settings.	Or	use	Desktop	&	Screen	Saver	preferences	to	add	a
desktop	picture	or	choose	a	screen	saver.

Customize	your	MacBook	Pro.	Click	the	System	Preferences	icon	 	in	the	Dock,	or	choose	Apple
menu	 	>	System	Preferences.	Then	click	the	type	of	preference	you	want	to	set.	To	learn	more,	see
Customize	your	Mac	with	System	Preferences	in	the	macOS	User	Guide.

https://support.apple.com/guide/mac-help/control-center-mchl50f94f8f
https://support.apple.com/guide/mac-help/mh15217/mac


Update	macOS.	In	System	Preferences,	click	Software	Update	to	see	if	your	Mac	is	running	the	latest
version	of	macOS	software.	You	can	specify	options	for	automatic	software	updates.

Spotlight	on	your	Mac
Spotlight	 	is	an	easy	way	to	find	anything	on	your	MacBook	Pro,	such	as	documents,	contacts,
calendar	events,	and	email	messages.	Spotlight	Suggestions	offer	info	from	Wikipedia	articles,	web
search	results,	news,	sports,	weather,	stocks,	movies,	and	other	sources.

Search	for	anything.	Click	 	at	the	top	right	of	the	screen,	then	start	typing.

Tip:	Type	Command–Space	bar	to	show	or	hide	the	Spotlight	search	field.



Convert	currencies	and	measurements.	Enter	a	currency—like	$,	€,	or	¥—and	an	amount,	then
press	Return	to	get	a	list	of	converted	values.	Or	specify	a	unit	of	measure	for	measurement
conversions.

Open	an	app.	Enter	the	app	name	in	Spotlight,	then	press	Return.

Turn	off	Spotlight	Suggestions.	If	you	want	Spotlight	to	search	only	for	items	on	your	MacBook	Pro,
open	System	Preferences,	click	Spotlight,	then	click	to	deselect	Siri	Suggestions.	You	can	also	make
other	changes	to	the	list	of	categories	Spotlight	searches.

Learn	more.	See	Search	with	Spotlight	on	Mac	in	the	macOS	User	Guide.

https://support.apple.com/guide/mac-help/spotlight-mchlp1008/


Siri	on	your	Mac
You	can	activate	Siri	with	your	voice	on	your	MacBook	Pro	and	use	Siri	for	many	tasks.	For	example,
you	can	schedule	meetings,	change	preferences,	get	answers,	send	messages,	place	calls,	and	add
items	to	your	calendar.	Use	Siri	to	give	you	directions	(“How	do	I	get	home	from	here?”),	provide
information	(“How	high	is	Mount	Whitney?”),	perform	basic	tasks	(“Create	a	new	grocery	list”),	and
much	more.

If	you	enable	the	“Listen	for	‘Hey	Siriʼ”	option	in	Siri	preferences,	Siri	is	available	whenever	you	say
“Hey	Siri”	and	immediately	speak	your	request.

Note:	To	use	Siri,	your	Mac	must	be	connected	to	the	internet.	Siri	may	not	be	available	in	all
languages	or	in	all	areas,	and	features	may	vary	by	area.

Enable	and	activate	Siri.	Open	System	Preferences,	click	Siri,	and	set	options.	If	you	enabled	Siri
during	setup,	on	the	13-inch	MacBook	Pro,	tap	the	Siri	button	 	in	the	Control	Strip	on	the	Touch	Bar
or	press	and	hold	Command-Space	bar	to	open	Siri.	On	the	14-inch	or	16-inch	MacBook	Pro,	press
and	hold	the	Dictation/Siri	(F5)	key	 	to	open	Siri.	Or	click	Siri	in	System	Preferences,	then	select
Enable	Ask	Siri.	You	can	set	other	preferences	in	the	Siri	pane,	such	as	the	language	and	voice	to	use
and	whether	to	show	Siri	in	the	menu	bar.

Tip:	You	can	add	the	Siri	icon	to	the	menu	bar	by	selecting	that	option	in	the	Siri	pane	of	System
Preferences.	Then	click	the	Siri	icon	 	to	use	Siri.

Hey	Siri.	On	your	MacBook	Pro,	you	can	simply	say	“Hey	Siri”	to	get	responses	to	your	requests.	To
enable	this	feature	in	the	Siri	pane	of	System	Preferences,	click	“Listen	for	‘Hey	Siriʼ,”	then	speak
several	Siri	commands	when	prompted.

For	convenience,	“Hey	Siri”	doesnʼt	respond	when	the	lid	to	your	MacBook	Pro	is	closed.	If	the	lid	is
closed	and	connected	to	an	external	display,	you	can	still	activate	Siri	from	the	icon	in	the	menu	bar.

Tip:	To	learn	about	more	ways	you	can	use	Siri,	ask	“What	can	you	do?”	at	any	time,	or	see	the
Apple	Support	article	What	can	I	ask	Siri?.

https://support.apple.com/siri


Play	some	music.	Just	say	“Play	some	music,”	and	Siri	does	the	rest.	You	can	even	tell	Siri,	“Play	the
top	song	from	March	1991.”

Drag	and	drop.	Drag	and	drop	images	and	locations	from	the	Siri	window	into	an	email,	text	message,
or	document.	You	can	also	copy	and	paste	text.

Change	the	voice.	Click	Siri	in	System	Preferences,	then	choose	an	option	from	the	Siri	Voice	menu.

Throughout	this	guide,	youʼll	find	suggestions	for	things	you	can	use	Siri	for—they	look	like	this:

Ask	Siri.	Say	something	like:

“Open	the	Keynote	presentation	I	was	working	on	last	night”

“What	time	is	it	in	Paris?”

Learn	more.	See	the	Apple	Support	article	How	to	use	Siri	on	your	Mac.

Window	management	on	your	Mac
Itʼs	easy	to	find	yourself	with	a	dozen	open	apps	and	one	or	more	windows	for	each	app	open	on	your
desktop.	Luckily,	there	are	some	efficient	ways	to	see	and	navigate	the	windows	you	have	open.
When	you	want	to	focus,	you	can	expand	one	app	to	fill	the	whole	screen	or	choose	two	apps	to
share	the	screen.	When	you	need	to	find	a	window	thatʼs	buried,	use	Mission	Control	to	show	all	your
open	windows	in	a	single	layer.	You	can	even	create	multiple	desktops	(called	spaces)	to	view	only
specific	windows,	and	then	move	between	the	spaces.

https://support.apple.com/HT206993


Use	the	whole	screen.	Use	full-screen	view	when	you	want	your	app	to	fill	the	whole	screen.	Many
apps	on	your	Mac,	such	as	Keynote,	Numbers,	and	Pages,	support	full-screen	view.	In	full	screen,	the
menu	bar	is	hidden	until	you	move	the	pointer	over	the	top	of	the	screen,	or	you	can	choose	to	always
show	the	menu	bar.	To	enter	or	leave	full-screen	view,	move	the	pointer	over	the	green	button	in	the
top-left	corner	of	the	window,	then	choose	Enter	Full	Screen	from	the	menu	that	appears.	See	Use
apps	in	full	screen	in	the	macOS	User	Guide.

Split	the	screen.	Use	Split	View	to	work	in	two	app	windows	side	by	side.	Like	full	screen,	the	two
windows	fill	the	screen.	Move	the	pointer	to	the	green	button	in	the	top-left	corner	of	a	window	you
want	to	use,	then	choose	Tile	Window	to	Left	of	Screen	or	Tile	Window	to	Right	of	Screen	from	the
menu	that	appears.	Click	another	window	and	it	automatically	fills	the	other	half	of	the	screen.	When
the	pointer	is	over	the	green	button,	the	menu	that	appears	has	options	to	switch	apps,	take	the	two
windows	to	full	screen,	and	more.	See	Use	apps	in	Split	View	in	the	macOS	User	Guide.

Mission	Control.	Quickly	move	your	open	windows	into	a	single	layer,	then	click	a	window	to	return	to
regular	view	with	that	window	in	front	and	active.	If	you	have	additional	desktops	(spaces)	or	have
apps	in	Split	View,	they	appear	in	a	row	along	the	top	of	the	screen.	To	enter	or	leave	Mission	Control,
press	 	on	the	top	row	of	your	keyboard,	or	press	Control-Up	Arrow.	You	can	also	add	the	Mission
Control	icon	 	to	the	Dock.	See	See	open	windows	and	spaces	in	Mission	Control	in	the	macOS	User
Guide.

When	one	desktop	isnʼt	enough.	Organize	your	app	windows	into	multiple	desktop	spaces,	then
switch	between	them	as	you	work.	To	create	a	space,	enter	Mission	Control	and	click	the	Add
Desktop	button	 .	Use	keyboard	shortcuts	and	Mission	Control	to	move	between	your	spaces.	You
can	drag	windows	from	one	space	to	another	and	add	or	delete	spaces	as	you	work.	See	Work	in
multiple	spaces	in	the	macOS	User	Guide.

That	horizontal	traffic	light.	The	red,	yellow,	and	green	buttons	in	the	top-left	corner	of	every
window	arenʼt	just	for	show.	Click	the	red	button	to	close	an	app	window.	For	some	apps,	this	quits
the	app	and	closes	all	open	windows	for	the	app.	For	others,	it	closes	the	current	window	but	leaves
the	app	open.	The	yellow	button	closes	the	window	temporarily	and	puts	it	in	the	right	side	of	the
Dock.	When	you	want	to	reopen	it,	click	it	in	the	Dock	to	expand	it.	And	the	green	button	is	a	quick
way	to	change	your	windows	to	full	screen	and	Split	View,	and	more.

Display	settings	for	your	Mac
Match	the	light	in	your	surroundings.	Your	MacBook	Pro	has	a	Retina	display	with	True	Tone®
technology.	True	Tone	automatically	adapts	the	color	of	the	display	to	match	the	light	in	your
environment	for	a	more	natural	viewing	experience.	Turn	True	Tone	on	or	off	in	the	Displays	pane	of
System	Preferences.

Use	a	dynamic	desktop.	When	you	use	a	dynamic	desktop	picture,	the	desktop	picture	automatically
changes	to	match	the	time	of	day	in	your	location.	Click	Desktop	&	Screen	Saver	in	System
Preferences,	click	Desktop,	then	choose	a	picture	for	Dynamic	Desktop.	To	have	your	screen	change
based	on	your	time	zone,	enable	Location	Services.	If	Location	Services	is	turned	off,	the	picture
changes	based	on	the	time	zone	specified	in	Date	&	Time	preferences.

https://support.apple.com/guide/mac-help/use-apps-in-full-screen-mchl9c21d2be
https://support.apple.com/guide/mac-help/use-apps-in-split-view-mchl4fbe2921
https://support.apple.com/guide/mac-help/open-windows-spaces-mission-control-mh35798
https://support.apple.com/guide/mac-help/work-in-multiple-spaces-mh14112


Stay	focused	with	Dark	Mode.	You	can	use	a	dark	color	scheme	for	the	desktop,	menu	bar,	Dock,
and	all	the	built-in	macOS	apps.	Your	content	stands	out	front	and	center	while	darkened	controls
and	windows	recede	into	the	background.	See	white	text	on	a	black	background	in	apps	such	as	Mail,
Contacts,	Calendar,	and	Messages,	so	itʼs	easier	on	your	eyes	when	youʼre	working	in	dark
environments.

Dark	Mode	is	finely	tuned	for	professionals	who	edit	photos	and	images—colors	and	fine	details	pop
against	the	dark	app	backgrounds.	But	itʼs	also	great	for	anyone	who	just	wants	to	focus	on	their
content.

Night	Shift.	Switch	your	Mac	to	warmer	colors	at	night	or	in	low-light	conditions	to	reduce	your
exposure	to	bright	blue	light.	Blue	light	can	make	it	harder	to	fall	asleep,	so	warmer	screen	colors	may
help	you	get	a	better	nightʼs	rest.	You	can	schedule	Night	Shift	to	turn	on	and	off	automatically	at
specific	times,	or	set	it	to	come	on	from	sunset	to	sunrise.	In	System	Preferences,	click	Displays,	click
the	Night	Shift	button	at	the	bottom,	then	set	your	options.	Drag	the	slider	to	adjust	the	color
temperature.

Connect	a	display.	You	can	connect	an	external	display,	a	projector,	or	an	HDTV	to	your	Mac.	See
Use	an	external	display	with	your	MacBook	Pro.

Learn	more.	See	the	Apple	Support	article	Using	a	Retina	display.

Transfer	your	data	to	your	new	MacBook	Pro
Itʼs	easy	to	copy	your	files	and	settings	wirelessly	from	another	Mac	or	PC	to	your	MacBook	Pro.	You
can	transfer	information	to	your	MacBook	Pro	from	an	existing	computer	or	from	a	Time	Machine
backup	on	a	USB	storage	device.

https://support.apple.com/HT202471


You	might	need	to	upgrade	the	macOS	version	on	your	older	computer	before	you	can	transfer	the
information	on	it—Migration	Assistant	requires	macOS	10.7	or	later,	but	itʼs	best	to	update	your	older
computer	to	the	latest	version	possible.	If	youʼre	not	sure	which	MacBook	Pro	you	have	or	want	to
find	information	about	other	models,	see	the	Apple	Support	article	Identify	your	MacBook	Pro	model.

Tip:	For	best	results,	make	sure	your	new	MacBook	Pro	is	running	the	latest	version	of	macOS.
Open	System	Preferences,	then	click	Software	Update	to	check	for	updates.

Move	from	a	PC	to	a	Mac.	If	youʼre	new	to	Mac	and	want	to	transfer	from	a	Windows	computer,	see
Transfer	info	from	a	PC	to	Mac	in	the	macOS	User	Guide	and	the	Apple	Support	article	Move	your
data	from	a	Windows	PC	to	your	Mac.

Transfer	wirelessly.	If	you	didnʼt	transfer	your	data	when	you	first	set	up	your	MacBook	Pro,	you	can
use	Migration	Assistant	at	any	time.	Open	a	Finder	window,	go	to	Applications,	open	the	Utilities
folder,	then	double-click	Migration	Assistant	and	follow	the	onscreen	instructions.	Make	sure	both
computers	are	connected	to	the	same	network,	and	keep	the	computers	near	each	other	throughout
the	migration	process.

Tip:	To	transfer	the	information	wirelessly	from	your	existing	computer	to	your	MacBook	Pro,
make	sure	both	computers	are	connected	to	the	same	network.	Keep	both	computers	near	each	other
throughout	the	migration	process.

If	you	used	Time	Machine	to	back	up	your	files	from	another	Mac	to	a	storage	device	(such	as	an
external	disk),	you	can	copy	the	files	from	the	device	to	your	MacBook	Pro.	See	Back	up	and	restore
your	Mac.

Copy	files	from	a	storage	device.	Connect	the	storage	device	to	your	MacBook	Pro	using	an
appropriate	adapter	if	necessary	(see	MacBook	Pro	accessories).	Then	drag	files	from	the	storage
device	to	your	MacBook	Pro.

Restore	your	content.	To	learn	how	to	restore	your	Mac	from	a	Time	Machine	or	other	backup,	see
the	Apple	Support	article	Restore	your	Mac	from	a	backup.

Learn	more.	See	Transfer	your	information	to	Mac	from	another	computer	or	device	in	the	macOS
User	Guide	and	the	Apple	Support	article	Move	your	content	to	a	new	Mac.

https://support.apple.com/HT201300
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https://support.apple.com/HT204350


Back	up	and	restore	your	Mac
To	keep	your	files	safe,	itʼs	important	to	back	up	your	MacBook	Pro	regularly.	The	easiest	way	to	back
up	is	to	use	Time	Machine—which	is	built	into	your	Mac—to	back	up	your	apps,	accounts,
preferences,	music,	photos,	movies,	and	documents	(it	doesnʼt	back	up	the	macOS	operating
system).	Use	Time	Machine	to	back	up	to	an	external	storage	device	connected	to	your	MacBook	Pro,
or	to	a	supported	network	volume.	For	a	list	of	devices	supported	by	Time	Machine,	see	the	Apple
Support	article	Backup	disks	you	can	use	with	Time	Machine.

Tip:	You	can	use	a	shared	Mac	thatʼs	on	the	same	network	as	your	MacBook	Pro	as	a	backup
destination.	On	the	other	Mac,	go	to	the	Sharing	pane	of	System	Preferences,	then	turn	on	File
Sharing.	Add	a	shared	folder,	Control-click	the	folder,	choose	Advanced	Options,	then	click	“Share	as
Time	Machine	backup	destination.”

Set	up	Time	Machine.	Make	sure	your	MacBook	Pro	is	on	the	same	Wi-Fi	network	as	your	external
storage	device,	or	connect	the	external	storage	device	to	your	MacBook	Pro.	Open	System
Preferences,	click	Time	Machine,	then	select	Back	Up	Automatically.	Select	the	drive	you	want	to	use
for	backup,	and	youʼre	all	set.

Back	up	with	iCloud.	Files	in	iCloud	Drive	and	photos	in	iCloud	Photos	are	automatically	stored	in
iCloud	and	donʼt	need	to	be	part	of	your	Time	Machine	backup.	However,	if	youʼd	like	to	back	them
up,	do	the	following:

iCloud	Drive:	Open	System	Preferences,	click	Apple	ID,	then	click	iCloud	and	deselect	Optimize
Mac	Storage.	The	contents	of	your	iCloud	Drive	will	be	stored	on	your	Mac	and	included	in	your
backup.

iCloud	Photos:	Open	Photos,	then	choose	Photos	>	Preferences.	In	the	iCloud	pane,	select
“Download	Originals	to	this	Mac.”	Full-resolution	versions	of	your	entire	photo	library	will	be
stored	on	your	Mac	and	included	in	your	backup.

https://support.apple.com/HT202784


Restore	your	files.	You	can	use	Time	Machine	to	restore	all	your	files	at	once.	Click	the	Time	Machine
icon	in	the	menu	bar,	then	choose	Enter	Time	Machine.	(If	the	Time	Machine	icon	isnʼt	in	the	menu
bar,	choose	Apple	Menu	>	System	Preferences,	click	Time	Machine,	then	select	“Show	Time	Machine
in	menu	bar.”)	Select	one	or	more	items	that	you	want	to	restore	(individual	folders	or	your	entire
disk),	then	click	Restore.

If	you	use	Time	Machine	to	back	up	your	Mac,	you	can	recover	your	files	if	the	operating	system	or
startup	disk	is	damaged.	To	do	this,	you	must	first	reinstall	macOS	on	your	Mac	before	you	can
restore	your	files	using	your	Time	Machine	backup.	Read	on	for	more	information.

Reinstall	macOS.	Your	operating	system	files	are	kept	separate	from	your	personal	files	in	a	sealed
system	disk.	However,	some	actions,	like	erasing	or	inadvertently	damaging	a	disk,	require	that	you
restore	your	MacBook	Pro.	You	can	reinstall	macOS	and	then	use	Time	Machine	to	restore	your
personal	files	from	your	backup.	With	macOS	Big	Sur	and	later,	there	are	several	ways	to	restore	your
Mac.	You	may	be	required	to	install	a	newer	version	of	macOS	than	what	your	computer	originally
came	with,	or	what	you	were	using	before	the	disk	was	damaged.	To	learn	more	about	these	options,
see	Recover	all	your	files	from	a	Time	Machine	backup	in	the	macOS	User	Guide	and	the	Apple
Support	article	How	to	reinstall	macOS.

Important:	Advanced	users	may	want	to	create	a	bootable	installer	to	reinstall	macOS	in	the	future.
This	can	be	useful	if	you	want	to	use	a	specific	version	of	macOS.	See	the	Apple	Support	article	How
to	create	a	bootable	installer	for	macOS.

Restore	factory	settings.	You	can	restore	your	Mac	to	its	original	state	by	erasing	your	Mac,	then
using	macOS	Recovery	to	reinstall	macOS.	See	Erase	your	Mac	in	the	macOS	User	Guide.

Learn	more.	See	Back	up	your	files	with	Time	Machine	and	Time	Machine	troubleshooting	on	Mac	in
the	macOS	User	Guide.	Also	see	the	Apple	Support	article	What	to	do	before	you	sell,	give	away,	or
trade	in	your	Mac.

Accessibility	on	your	Mac
Your	Mac,	iOS	devices,	and	iPadOS	devices	include	powerful	tools	to	make	Apple	product	features
available	and	easy	to	use	by	all.	There	are	four	main	accessibility	focus	areas	for	your	Mac.	Click	a
link	to	learn	more	about	the	features	for	each	area:

Vision

Hearing

Mobility

Cognitive

For	comprehensive	details	about	Accessibility	support	in	Apple	products,	go	to	Accessibility.

Accessibility	preferences.	In	System	Preferences,	Accessibility	preferences	are	organized	around
topics	of	vision,	hearing,	and	motor,	making	it	simpler	to	find	what	youʼre	looking	for.
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Do	it	all	with	Voice	Control.	You	can	control	your	Mac	with	just	your	voice.	All	audio	processing	for
Voice	Control	happens	on	your	Mac,	so	your	personal	data	is	kept	private.	See	Control	your	Mac	and
apps	using	Voice	Control.

Accurate	dictation.	If	you	canʼt	type	by	hand,	accurate	dictation	is	essential	for	communication.
Voice	Control	brings	the	latest	advances	in	machine	learning	for	speech-to-text	transcription.

You	can	add	custom	words	to	help	Voice	Control	recognize	the	words	you	commonly	use.	Choose
System	Preferences	>	Accessibility,	select	Voice	Control,	then	click	Vocabulary	and	add	the	words
you	want.	To	customize	commands	in	the	Voice	Control	preferences	page,	click	Commands,	then
select	to	keep	default	commands,	or	add	new	ones.

Note:	The	dictation	accuracy	improvements	are	for	these	languages:	English	(US,	UK,	India,
Australia),	Mandarin	Chinese	(China	mainland),	Cantonese	(Hong	Kong),	Japanese	(Japan),	Spanish
(Mexico,	Latin	America,	Spain),	French	(France),	and	German	(Germany).

Rich	text	editing.	Rich	text	editing	commands	in	Voice	Control	let	you	quickly	make	corrections	and
move	on	to	expressing	your	next	idea.	You	can	replace	one	phrase	with	another,	quickly	position	the
pointer	to	make	edits,	and	select	text	with	precision.	Try	saying	“Replace	‘John	will	be	there	soonʼ
with	‘John	just	arrivedʼ.”	When	you	correct	words,	word	and	emoji	suggestions	help	you	quickly
select	what	you	want.

Comprehensive	navigation.	Use	voice	commands	to	open	and	interact	with	apps.	To	click	an	item,
just	say	its	accessibility	label	name.	You	can	also	say	“show	numbers”	to	see	number	labels	appear
next	to	all	clickable	items,	and	then	say	a	number	to	click.	If	you	need	to	touch	a	part	of	the	screen
without	a	control,	you	can	say	“show	grid”	to	superimpose	a	grid	on	your	screen	and	do	things	like
click,	zoom,	drag,	and	more.

Hover	and	zoom.	Use	Hover	Text	to	display	high-resolution	text	for	screen	items	under	your	pointer.
Press	Command	while	hovering	over	text	with	the	pointer,	and	a	window	with	zoomed	text	appears	on
your	screen.

https://support.apple.com/guide/mac-help/mh40719/11.0/mac/11.0


Zoom	Display	lets	you	keep	one	monitor	zoomed	in	tightly	and	another	at	its	standard	resolution.
View	the	same	screen	up	close	and	at	a	distance	simultaneously.

Make	an	easy-to-see	custom	pointer.	Customize	the	outline	and	fill	color	of	the	mouse	pointer	so
itʼs	easier	to	recognize	when	it	moves	or	changes	to	an	insertion	point,	crosshair,	hand,	or	other
shape.

Improved	keyboard	access.	An	expanded	set	of	keyboard	shortcuts	allows	you	to	control	everything
on	your	Mac	with	a	keyboard—no	mouse	or	trackpad	required.

Use	VoiceOver,	the	built-in	screen	reader.	VoiceOver	describes	aloud	what	appears	on	the	screen
and	speaks	the	text	in	documents,	webpages,	and	windows.	Using	VoiceOver,	you	control	your	Mac
with	the	keyboard	or	trackpad	gestures,	or	connect	a	refreshable	braille	display	to	use	with
VoiceOver.	To	customize	VoiceOver,	use	VoiceOver	Utility.	See	VoiceOver	User	Guide.

https://support.apple.com/guide/voiceover/welcome/mac


Ask	Siri.	Say	something	like:

“Turn	VoiceOver	on.”

“Turn	VoiceOver	off.”

Use	Siri	for	VoiceOver.	If	you	prefer	the	natural	voice	of	Siri,	you	can	choose	to	use	Siri	for
VoiceOver	or	Speech.	Simplified	keyboard	navigation	requires	less	drilling	into	unique	focus	groups—
making	it	even	easier	to	navigate	with	VoiceOver.	You	can	also	store	custom	punctuation	marks	in
iCloud,	and	choose	from	International	Braille	tables.	And	if	youʼre	a	developer,	VoiceOver	now	reads
aloud	line	numbers,	break	points,	warnings,	and	errors	in	the	Xcode	text	editor.

VoiceOver	image	descriptions.	Using	Markup	in	Preview	or	Quick	Look,	you	can	add	alternative
image	descriptions	that	can	be	read	by	VoiceOver.	Image	descriptions	persist	even	when	shared	and
can	be	read	by	a	range	of	supported	apps	on	iPhone,	iPad,	and	Mac.

VoiceOver	PDF	signature	descriptions.	Add	custom	descriptions	to	your	PDF	signatures	so	you	can
identify	them	quickly	and	choose	the	right	one.

Color	enhancements.	If	you	have	a	color	vision	deficiency,	you	can	adjust	your	Mac	display	colors
using	color	filter	options.	Itʼs	easy	to	turn	this	preference	on	or	off	to	quickly	differentiate	a	color
using	the	Accessibility	Options	panel,	which	you	can	access	by	triple-pressing	Touch	ID.

Customize	your	Memoji.	macOS	Monterey	introduces	new	customizations	for	Memoji,	including
cochlear	implants,	oxygen	tubes,	and	a	soft	helmet	for	headwear.	See	Messages	to	learn	about
creating	your	Memoji.

Learn	more.	See	Use	accessibility	features	on	Mac	in	the	macOS	User	Guide.

https://support.apple.com/guide/mac-help/mh35884/mac


New	features	on	your	MacBook	Pro

macOS	Monterey	introduces	tools	to	bring	you	closer	with	family,	colleagues,	and	friends,	and	work
more	fluidly	across	all	your	devices.

The	new	communication	and	connection	features	of	macOS	Monterey	include:

FaceTime:	Create	a	link	to	set	up	a	FaceTime	call	for	later,	share	with	a	group,	or	add	to	a
Calendar	event.	A	new	Grid	View	makes	it	easy	to	see	whoʼs	speaking.	You	can	even	use	a	link	to
invite	people	on	non-Apple	devices	to	join	a	call	using	FaceTime	on	the	web.	With	new	Voice
Isolation	and	Wide	Spectrum	modes,	your	mic	captures	only	the	sounds	you	want.	Keep	the	focus
on	you	and	blur	your	background	with	Portrait	mode	(available	on	your	Mac	with	Apple	silicon).
See	FaceTime.

Messages:	View	multiple	photos	in	collages	or	stacks	that	you	can	flip	through.	Pin	important
content	so	it	gets	priority	in	searches,	Shared	with	You,	and	conversation	details.	See	Messages.

Shared	with	You:	Content	you	receive	in	Messages	automatically	appears	in	a	new	Shared	with
You	section	in	the	corresponding	app,	so	you	can	enjoy	it	whenever	itʼs	convenient.	Content	only
appears	in	Shared	with	You	if	the	friend	who	sent	it	is	in	your	Contacts.	Shared	with	You	is
featured	in	the	Photos,	Safari,	News,	Podcasts,	and	TV	apps.

AirPlay	to	Mac:	Now	you	can	watch	videos,	listen	to	music,	and	more	on	your	Mac	as	theyʼre	being
played	on	your	other	devices.	See	Use	AirPlay	on	your	Mac.

Here	are	improvements	to	increase	your	productivity:



Safari:	Safari	reimagines	the	browser,	providing	a	more	immersive	and	personal	experience	across
your	devices.	Get	more	space	to	browse	websites,	with	the	new	unified	tab	bar.	Easily	switch
between	investigating	your	next	big	trip,	exploring	gift	options,	and	doing	essential	research	with
Tab	Groups.	The	new	tab	bar,	extensions,	and	start	page	are	now	available	across	Mac,	iPhone,
and	iPad,	so	you	get	the	same	Safari	everywhere	you	browse.	Other	features	include	improved
Intelligent	Tracking	Prevention	and	Hide	My	Email.	See	Safari.

Focus	and	Notification	Center:	When	youʼre	working,	having	dinner,	or	just	donʼt	want	to	be
disturbed,	Focus	can	automatically	filter	your	notifications	so	you	see	only	the	ones	you	want.	See
Notification	Center	on	your	Mac.

Quick	Note	and	Notes:	Notes	now	supports	tags	(for	example,	#research)—to	help	you	organize
and	search	your	notes—and	mentions	(@username),	so	that	you	can	alert	collaborators	to
changes	in	a	shared	note.	A	new	Activity	view	displays	a	summary	of	updates	since	you	last
viewed	a	shared	note.	With	Quick	Note,	you	can	create	a	note	anywhere	on	your	Mac—in	an	app
or	webpage,	or	even	on	the	desktop.	See	Notes.

Check	out	these	intelligence	and	automation	features:

Photos,	Visual	Look	Up,	and	Live	Text:	Thereʼs	newly	improved	people	identification	and	naming,
new	features	for	editing	and	playing	back	Memories,	and	the	ability	to	import	photos	from	a
second	Photos	library.	Quickly	see	photos	shared	with	you	in	Messages,	and	respond	in	Photos.
Learn	about	objects	in	the	photo	in	Visual	Look	Up	and	interact	with	text	using	Live	Text.	See
Photos.

Shortcuts:	Quickly	perform	tasks	using	one	or	more	apps	or	actions.	Create	your	own	shortcuts,	or
choose	from	a	curated	list	of	shortcuts	available	in	the	Gallery	and	keep	your	shortcuts	synced
across	all	your	devices.	Run	shortcuts	with	your	voice,	from	the	Dock,	Menu	Bar,	Finder,	and
more.	See	Shortcuts.

macOS	Monterey	also	provides	these	new	features	and	enhancements	to	existing	features	to	improve
your	productivity	and	creativity:

Maps:	A	new	design	helps	you	find	what	youʼre	looking	for	and	get	there	sooner.	Explore	natural
features	with	an	interactive	3D	globe	and	discover	new	city	experiences	with	landmarks,
elevation,	and	more,	available	on	your	Mac	with	Apple	silicon.	You	can	filter	to	see	whatʼs	open
now	and	save	your	favorite	places	and	transit	lines	for	later.	Nearby	transit	information	and	new
driving	maps	will	help	you	plan	where	youʼre	going	and	get	there	quicker.	See	Maps.

Apple	ID:	Add	your	Memoji	to	your	Apple	account.	Set	up	a	contact	and	PIN	to	help	you	recover
your	account	if	you	get	locked	out.	See	Apple	Account	on	Mac.

iCloud+:	This	premium	subscription	service	gives	you	more	iCloud	storage	for	your	photos	and
files,	plus	additional	features	such	as	Private	Relay	(beta),	Hide	My	Email,	and	HomeKit	Secure
Video	support.	iCloud+	availability	varies	by	country	or	region.	See	Access	your	iCloud	content	on
your	Mac.



Accessibility:	Updates	to	VoiceOver	include	the	ability	to	add	image	descriptions	with	Markup,
PDF	signature	descriptions,	improved	keyboard	access,	custom	mouse	pointers,	and	new
accessibility	Memoji	to	better	reflect	your	appearance.	See	Accessibility	on	your	Mac.

App	Store	and	Games:	The	new	multiplayer	friend	selector	makes	it	easy	to	invite	your	recent
Messages	friends	and	groups	to	play	Game	Center-enabled	games.	Games	you	download	from
the	App	Store	now	appear	automatically	in	the	new	Games	folder	in	Launchpad,	so	theyʼre	always
easy	to	access,	even	with	a	game	controller	See	App	Store.

Books:	Explore	new	features	like	Reading	Goals,	Want	to	Read,	and	Reading	Now,	previously
available	only	on	iOS.	Find	books	quicker	with	search	results	that	come	up	as	soon	as	you	start
typing.	Enjoy	personalized	recommendations	for	books,	audiobooks,	and	genre	collections	in	your
search	results	and	buy	directly	from	the	Search	tab.	See	Books.

Finder	improvements:	An	enhanced	“go	to	folder”	window	features	a	new	look	and	improved
autocompletion	engine	to	help	you	get	to	the	files	or	folder	youʼre	looking	for	more	quickly.	Run
shortcuts	from	the	Touch	Bar,	the	menu	bar,	and	the	Quick	Actions	menu.	A	new	collaboration
folder	in	the	sidebar	contains	all	shared	documents,	and	displays	sharing-related	metadata.	As
you	move	windows	from	your	Mac	to	a	secondary	display,	the	windows	resize	to	fit	the	new
display.	See	The	Finder	on	your	Mac.

Find	My:	Share	your	location	with	family	and	friends.	With	Separation	Alerts,	get	notified	on	your
iPhone,	iPad,	or	iPod	touch	if	you	leave	your	Mac	with	Apple	silicon	behind.	See	Find	My.

Hello	screen	saver	and	desktop	picture:	The	Hello	screen	saver	writes	“hello”	on	the	screen	in	34
languages	using	fresh	animation	and	a	font	inspired	by	the	original	Mac.	You	can	also	use	a	Hello
desktop	picture	available	in	several	colors	with	light,	dark,	or	dynamic	options.	Set	these	in	the
Desktop	&	Screen	Saver	pane	of	System	Preferences	 .

Passwords:	Look	up	and	manage	your	saved	passwords	for	apps	and	websites	in	the	new
Passwords	pane	in	System	Preferences.	Import	passwords	from	other	password	managers,	then
use	AutoFill	when	signing	in	to	apps	and	websites.

Reminders:	Use	tags	and	Custom	Smart	Lists	to	organize	and	filter	reminders.	Other
improvements	include	reminder	deletion,	enhanced	natural	language,	and	expanded	suggestions.
See	Reminders.

Split	View/Window	Management:	Manage	multiple	open	windows	efficiently	with	new	options	for
Split	View	and	full-screen	view.	In	Split	View,	click	the	green	button	in	the	top-left	corner	of	a
window	to	swap	apps	or	go	to	full	screen	(both	apps	in	Split	View	go	to	full	screen).	And	in	full-
screen	view,	you	can	keep	the	menu	bar	visible	if	you	prefer.	See	Window	management	on	your
Mac.

Translation:	Translate	text	in	Safari,	Mail,	Pages,	Preview,	and	other	apps.	You	can	replace
selected	text	with	the	translation,	switch	between	languages,	and	more.	With	Live	Text,	you	can
even	translate	selected	text	in	photos.	Translation	is	available	system-wide	and	in	some	third-
party	apps.	Not	all	languages	are	available.	See	Translate	on	Mac	in	the	macOS	User	Guide.

https://support.apple.com/guide/mac-help/mchldd8b3c15


Use	MacBook	Pro	with	other	devices

Use	your	MacBook	Pro	with	iCloud	and	Continuity
With	iCloud,	you	can	keep	your	information	up	to	date	on	all	your	devices	and	collaborate	with	friends
and	family.	Your	MacBook	Pro	works	seamlessly	with	your	iPhone,	iPad,	iPod	touch,	or	Apple	Watch
when	you	use	iCloud	and	sign	in	to	each	of	them	with	the	same	Apple	ID.	You	can	transfer	files,	share
and	edit	documents,	unlock	your	MacBook	Pro	with	your	Apple	Watch,	turn	your	iPhone	or	iPad	into
an	internet	hotspot,	answer	calls	or	send	texts	from	your	MacBook	Pro,	and	more.

If	you	didnʼt	turn	on	iCloud	when	you	first	set	up	your	Mac,	open	System	Preferences,	click	Sign	In,
then	sign	in	with	your	Apple	ID,	or	create	a	new	Apple	ID	if	you	donʼt	have	one.	Click	iCloud,	then	turn
iCloud	features	on	or	off.	To	learn	more,	see	Set	up	iCloud	features	on	Mac	in	the	macOS	User	Guide.

Access	your	content	across	devices.	With	iCloud,	you	can	securely	store,	edit,	and	share	your
documents,	photos,	and	videos	across	devices	to	make	sure	youʼre	always	up	to	date.	To	get	started,
see	Access	your	iCloud	content	on	your	Mac.

Use	your	MacBook	Pro	with	other	devices.	Seamlessly	move	content	between	your	MacBook	Pro
and	other	devices	using	Continuity.	Just	sign	in	on	each	device	with	your	Apple	ID,	and	whenever
your	MacBook	Pro	and	devices	are	near	each	other,	they	work	together	in	convenient	ways.	You	can
start	a	task	on	one	device	and	finish	it	on	another	(see	Use	Handoff	on	your	Mac),	copy	and	paste
between	devices	(see	Use	Universal	Clipboard	on	your	Mac),	answer	calls	or	send	texts	from	your
MacBook	Pro	(see	Phone	calls	and	text	messages	on	your	Mac),	transfer	files	with	AirDrop	(see	Use
AirDrop	on	your	Mac),	and	more.

For	a	list	of	system	requirements	for	devices	that	support	Continuity,	see	the	Apple	Support	article
System	requirements	for	Continuity	on	Mac,	iPhone,	iPad,	iPod	touch,	and	Apple	Watch.	To	learn
more	about	using	Continuity	with	your	MacBook	Pro,	see	the	Apple	Support	article	Use	Continuity	to
connect	your	Mac,	iPhone,	iPad,	iPod	touch,	and	Apple	Watch	or	go	to	All	your	devices.

https://support.apple.com/guide/mac-help/mh36834
https://support.apple.com/HT204689
https://support.apple.com/HT204681
https://www.apple.com/macos/continuity/


Access	your	iCloud	content	on	your	Mac
iCloud	helps	you	keep	your	most	important	information—like	your	photos,	files,	and	more—safe,	up	to
date,	and	available	across	all	your	devices.	Itʼs	built	into	every	Apple	device,	and	everyone	gets	5	GB
of	storage	to	start.	Purchases	you	make	from	the	App	Store,	Apple	TV	app,	Apple	Books,	or	iTunes
Store	donʼt	count	toward	your	available	space.	So	if	you	have	an	iPhone,	iPad,	or	iPod	touch,	just	sign
in	on	each	device	with	your	Apple	ID,	turn	on	iCloud,	and	youʼll	have	everything	you	need.	You	can
upgrade	to	iCloud+	if	you	need	more	storage	and	premium	features	including	iCloud	Private	Relay
(beta),	Hide	My	Email,	Custom	email	domains,	and	HomeKit	Secure	Video	support.

For	system	requirements	about	devices	that	support	iCloud,	see	the	Apple	Support	article	System
requirements	for	iCloud.

https://support.apple.com/HT204230


Automatically	store	your	desktop	and	Documents	folder	in	iCloud	Drive.	You	can	save	files	in	your
Documents	folder	or	on	your	desktop,	and	theyʼre	automatically	available	on	iCloud	Drive	and
accessible	wherever	you	are.	When	working	with	iCloud	Drive,	you	have	access	to	files	on	your
MacBook	Pro,	on	your	iPhone	or	iPad	in	the	Files	app,	on	the	web	at	iCloud.com,	or	on	a	Windows	PC
in	the	iCloud	for	Windows	app.	When	you	make	changes	to	a	file	on	a	device	or	on	iCloud	Drive,	youʼll
see	your	edits	wherever	you	view	the	file.

To	get	started,	open	System	Preferences,	click	Apple	ID,	then	click	iCloud.	Select	iCloud	Drive,	then
click	Options	and	select	“Desktop	&	Documents	Folders.”	To	learn	more,	see	Set	up	and	use	iCloud
Drive	on	all	your	devices	in	the	iCloud	User	Guide.	Also	see	the	Apple	Support	article	Add	your
Desktop	and	Documents	files	to	iCloud	Drive.

Store	and	share	photos	with	iCloud	Photos	and	Shared	Albums.	Store	your	photo	library	in	iCloud
and	see	your	photos	and	videos,	as	well	as	the	edits	you	make	to	them,	on	all	your	devices.	Share
photos	and	videos	with	only	the	people	you	choose,	and	let	them	add	their	own	photos,	videos,	and
comments.	To	get	started,	open	System	Preferences,	click	Apple	ID,	click	iCloud,	then	select	Photos.
To	learn	more,	see	Use	iCloud	Photos	on	iCloud.com	in	the	iCloud	User	Guide.

Enjoy	your	purchases	anywhere.	When	youʼre	signed	in	to	your	devices	with	the	same	Apple	ID,
purchases	youʼve	made	on	the	App	Store,	Apple	TV	app,	Apple	Books,	and	iTunes	Store	are	available
at	any	time,	no	matter	which	computer	or	device	you	used	to	purchase	them.	So	all	your	music,
movies,	books,	and	more	are	available	wherever	you	go.

Locate	your	MacBook	Pro	with	Find	My	Mac.	If	your	MacBook	Pro	is	missing,	you	can	use	Find	My	to
locate	it	on	a	map,	lock	its	screen,	and	even	erase	its	data	remotely	if	you	have	Find	My	Mac	turned
on.	To	turn	on	Find	My	Mac,	open	System	Preferences,	click	Apple	ID,	click	iCloud,	then	select	Find
My	Mac.	See	the	Apple	Support	article	If	your	Mac	is	lost	or	stolen.

Note:	If	your	MacBook	Pro	has	multiple	user	accounts,	only	one	can	have	Find	My	Mac	turned	on.

Do	more	with	iCloud+.	iCloud+	is	a	subscription	service	that	gives	you	all	the	storage	tiers	and
sharing	features	of	iCloud	but	with	additional	features.	You	can	share	any	size	iCloud+	storage	plan
through	Family	Sharing.	iCloud+	also	includes	iCloud	Private	Relay	(beta),	HomeKit	Secure	Video,	and
custom	email	domains	for	your	Mail	address	on	iCloud.com.	Hereʼs	what	you	get	with	an	iCloud+
subscription:

Storage:	50	GB,	200	GB,	or	2	TB	of	iCloud	storage.

iCloud	Private	Relay	(beta):	Private	Relay	is	an	internet	privacy	service	that	hides	your	IP	address
in	Safari	and	protects	your	unencrypted	traffic.	When	itʼs	on,	you	can	browse	the	web	with	extra
security	and	privacy.

Hide	My	Email:	Create	unique,	random	email	addresses	that	forward	to	your	personal	inbox,	so
you	can	send	and	receive	email	without	having	to	share	your	personal	email	address.

HomeKit	Secure	Video:	Connect	your	home	security	cameras	in	the	Home	App	to	record	your
footage	and	view	it	from	anywhere.	Itʼs	all	end-to-end	encrypted,	and	none	of	the	video	counts
against	your	iCloud	storage.

https://www.icloud.com
https://support.apple.com/guide/icloud/set-up-icloud-drive-mm203b05aec8/icloud
https://support.apple.com/HT206985
https://support.apple.com/guide/icloud/photos-on-icloudcom-overview-mmbc402b84/1.0/icloud/1.0
https://support.apple.com/HT204756


Custom	email	domains:	Personalize	your	iCloud	Mail	address	with	a	custom	domain	name.	You	can
invite	your	family	members	to	use	the	same	domain	with	their	iCloud	Mail	accounts.

Family	Sharing:	All	iCloud+	plans	can	be	shared	with	up	to	five	family	members,	so	everyone	can
enjoy	all	these	features	and	included	storage	with	a	single	subscription.

Learn	more.	See	the	iCloud	User	Guide	and	What	is	iCloud?	in	the	macOS	User	Guide.

Screen	Time	on	Mac
Screen	Time	shows	you	how	you	spend	time	in	apps	and	on	websites.	It	also	lets	you	monitor	what
your	kids	are	doing	on	their	Apple	devices.

Set	your	limits.	Set	limits	to	control	how	much	time	you	spend	with	specific	apps,	categories	of	apps,
and	websites.	You	can	also	view	reports	to	see	how	much	time	youʼre	spending	with	apps	and
websites,	and	schedule	downtime	away	from	your	Mac.

Family	sharing.	Parents	can	configure	Screen	Time	on	their	Mac—or	iPhone	or	iPad—and	everything
is	set	up	for	their	kids	on	their	devices.

One-tap	media	ratings.	While	setting	up	Screen	Time	for	your	kids,	you	can	set	age-based	media
ratings	for	the	Music	and	Books	apps.

Learn	more.	See	Set	up	Screen	Time	for	a	child	on	Mac	in	the	macOS	User	Guide.

https://support.apple.com/guide/icloud
https://support.apple.com/guide/mac-help/mh36832
https://support.apple.com/guide/mac-help/mchlc5595037/mac


Use	Handoff	on	your	Mac
With	Handoff,	you	can	continue	on	one	device	where	you	left	off	on	another.	Work	on	a	presentation
on	your	MacBook	Pro,	then	continue	on	your	iPad.	Or	start	an	email	message	on	your	iPhone,	then
finish	it	on	your	MacBook	Pro.	View	a	message	on	your	Apple	Watch,	and	respond	to	it	on	your
MacBook	Pro.	You	donʼt	have	to	worry	about	transferring	files.	When	your	MacBook	Pro	and	devices
are	near	each	other,	an	icon	appears	in	the	Dock	whenever	an	activity	can	be	handed	off;	to	continue,
just	click	the	icon.

Note:	To	use	Handoff,	you	need	an	iPhone	or	iPod	touch	with	iOS	8	or	later,	or	an	iPad	with	iPadOS
installed.	Make	sure	your	MacBook	Pro,	iOS	device,	or	iPadOS	device	have	Wi-Fi	and	Bluetooth
turned	on	and	are	signed	in	with	the	same	Apple	ID.

Turn	on	Handoff	on	your	MacBook	Pro.	Open	System	Preferences,	click	General,	then	select	“Allow
Handoff	between	this	Mac	and	your	iCloud	devices.”

Turn	on	Handoff	on	your	iOS	or	iPadOS	device.	Go	to	Settings	>	General	>	Handoff,	then	tap	to	turn
on	Handoff.	If	you	donʼt	see	the	option,	your	device	doesnʼt	support	Handoff.

Turn	on	Handoff	on	your	Apple	Watch.	In	the	Apple	Watch	app	on	iPhone,	go	to	Settings	>	General,
then	tap	to	turn	on	Enable	Handoff.

Handoff	works	with	Safari,	Mail,	Calendar,	Contacts,	Maps,	Messages,	Notes,	Reminders,	Keynote,
Numbers,	and	Pages.

Learn	more.	See	Pick	up	where	you	left	off	with	Handoff	in	the	macOS	User	Guide.

Use	Universal	Clipboard	on	your	Mac
Copy	content	from	one	device,	and	paste	it	to	another	nearby	device	within	a	short	period	of	time.
The	contents	of	your	clipboard	are	sent	over	Wi-Fi	and	made	available	to	all	Mac,	iPhone,	iPad,	and
iPod	touch	devices	that	are	signed	in	with	the	same	Apple	ID	and	have	Handoff,	Wi-Fi,	and	Bluetooth
turned	on.	See	Use	Handoff	on	your	Mac.

Note:	To	use	Universal	Clipboard,	you	need	an	iPhone	or	iPod	touch	with	iOS	10	or	later,	or	an	iPad
with	iPadOS	installed.

https://support.apple.com/guide/mac-help/mchl732d3c0a


Use	across	apps.	You	can	copy	and	paste	images,	text,	photos,	and	video	between	any	apps	that
support	copy	and	paste	on	your	Mac,	iPhone,	iPad,	and	iPod	touch.

Copy	and	paste	files.	You	can	quickly	move	files	from	one	Mac	to	another	using	Universal	Clipboard.
Copy	a	file	on	your	MacBook	Pro	and	paste	it	to	a	Finder	window,	Mail	message,	or	any	app	on	a
nearby	app	that	supports	copy	and	paste.	You	must	be	signed	in	with	the	same	Apple	ID	on	both
computers.

Learn	more.	See	Copy	and	paste	between	devices	from	your	Mac	in	the	macOS	User	Guide.

Sidecar	on	your	Mac
With	Sidecar,	you	can	turn	your	iPad	into	a	second	display	for	your	Mac	and	use	your	iPad	as	a	tablet
input	device	for	your	Mac	apps.	Give	yourself	extra	space	to	work,	draw	with	Apple	Pencil,	mark	up
PDFs	and	screenshots,	and	more.

Note:	You	can	use	Sidecar	with	iPad	models	that	support	Apple	Pencil	and	run	iPadOS	13.1	(or	later).
For	more	information,	see	the	Apple	Support	article	Apple	Pencil	compatibility.

https://support.apple.com/guide/mac-help/mchl70368996
https://support.apple.com/HT211029


Set	up	and	connect.	You	can	use	your	iPad	wirelessly	within	32	feet	(ten	meters)	of	your	Mac,	or
connect	your	iPad	to	your	Mac	with	a	cable	to	keep	it	charged.	To	set	up	your	iPad	as	a	second
display,	go	to	Apple	menu	 	>	System	Preferences	and	click	Displays,	then	choose	your	iPad	from	the
Add	Display	pop-up	menu.	Later,	you	can	connect	to	your	iPad	in	the	Display	section	of	Control
Center	 .	To	disconnect	your	iPad	from	your	Mac,	click	the	Sidecar	button	 	in	Control	Center.	You
can	also	tap	 	in	the	sidebar	of	your	iPad.

Set	Sidecar	preferences.	To	set	Sidecar	preferences,	open	System	Preferences,	then	click	Displays.
Click	the	name	of	your	iPad,	then	specify	whether	you	want	to	use	your	iPad	as	the	main	display	or
mirror	your	Mac,	show	the	sidebar	and	Touch	Bar	on	your	iPad	and	set	their	locations,	and	enable
double-tap	with	Apple	Pencil	to	quickly	access	tools.

Note:	If	you	havenʼt	set	up	your	iPad,	you	donʼt	see	these	options	in	Display	preferences.

Extend	or	mirror	your	desktop.	When	you	connect	your	iPad,	it	automatically	becomes	an	extension
of	your	Mac	desktop,	so	you	can	drag	your	apps	and	documents	between	your	Mac	and	iPad.	To
show	your	Mac	screen	on	both	devices	(mirror	the	display),	move	your	mouse	over	the	Sidecar	button

	in	Control	Center,	click	the	right	arrow	that	appears	above	the	button,	then	select	Mirror	Built-in
Retina	Display.	To	extend	your	desktop	again,	open	the	menu	and	choose	Use	As	Separate	Display.

Tip:	For	quick	access	to	the	Sidecar	options,	you	can	set	Display	preferences	 	to	always	appear
in	the	menu	bar.	Go	to	System	Preferences	>	Dock	&	Menu	Bar,	click	Display	in	the	sidebar	on	the
left,	then	select	Show	in	Menu	Bar.	When	Sidecar	is	on	and	your	iPad	is	connected,	the	Display	icon	in
the	menu	bar	changes	to	 .

Use	Apple	Pencil.	Precisely	draw	and	create	in	your	favorite	pro	apps.	Just	drag	the	window	from
your	Mac	to	your	iPad	and	start	using	Apple	Pencil.	Or	use	Apple	Pencil	to	mark	up	PDFs,
screenshots,	and	images.	To	learn	more,	see	Continuity	Sketch	and	Continuity	Markup	on	your	Mac.

Note:	Pressure	and	tilt	for	Apple	Pencil	only	work	in	apps	with	advanced	stylus	support.

Take	advantage	of	sidebar	shortcuts.	Use	the	sidebar	on	your	iPad	to	quickly	reach	commonly	used
buttons	and	controls.	Tap	the	buttons	to	undo	actions,	use	keyboard	shortcuts,	and	display	or	hide
the	menu	bar,	Dock,	and	keyboard.

Use	Touch	Bar	controls—with	or	without	a	Touch	Bar.	For	apps	that	have	Touch	Bar	support,	the
controls	appear	at	the	bottom	of	the	iPad	display,	whether	or	not	your	Mac	has	a	Touch	Bar.



Learn	more.	See	Use	your	iPad	as	a	second	display	for	your	Mac	in	the	macOS	User	Guide.

Continuity	Camera	on	your	Mac
Use	your	iPhone,	iPad,	or	iPod	touch	to	scan	documents	or	take	a	picture	of	something	nearby,	and	it
appears	instantly	on	your	Mac.	Continuity	Camera	is	supported	in	many	apps,	including	Finder,	Mail,
Messages,	and	more.

Note:	To	use	Continuity	Camera,	you	need	an	iPhone	or	iPod	touch	with	iOS	12	(or	later)	or	an	iPad
with	iPadOS	13.1	(or	later)	installed.	Make	sure	your	MacBook	Pro	and	iOS	or	iPadOS	device	have	Wi-
Fi	and	Bluetooth	turned	on	and	are	signed	in	with	the	same	Apple	ID.

Insert	an	image	or	scan.	In	an	app	like	Mail,	Notes,	or	Messages,	click	where	you	want	the	image	to
go,	choose	File	(or	Insert)	>	Import	From	iPhone	or	iPad,	choose	“Take	Photo”	or	“Scan	Documents,”
then	take	the	photo	or	scan	the	image	on	your	iOS	or	iPadOS	device.	You	might	need	to	select	your
iOS	or	iPadOS	device	before	taking	the	photo.	Tap	Use	Photo	or	Keep	Scan.	You	can	also	tap	Retake
if	you	want	to	try	again.

In	an	app	such	as	Pages,	click	where	you	want	the	image	to	be	inserted,	then	Control-click,	choose
“Import	image,”	and	take	the	photo.	You	might	need	to	select	your	device	before	taking	the	photo.

Note:	To	take	a	scan	on	your	iOS	or	iPadOS	device,	drag	the	frame	until	what	you	want	to	show	is	in
the	frame,	tap	Keep	Scan,	then	tap	Save.	Tap	Retake	to	rescan	the	content.

The	photo	or	scan	appears	where	you	want	it	in	your	document.

https://support.apple.com/guide/mac-help/mchlf3c6f7ae


Learn	more.	See	Insert	photos	and	scans	with	Continuity	Camera	on	Mac	in	the	macOS	User	Guide.

Continuity	Sketch	and	Continuity	Markup	on	your	Mac
With	Continuity	Sketch,	you	can	use	your	nearby	iPhone	or	iPad	to	draw	a	sketch	and	instantly	insert
it	into	a	document	on	your	Mac—for	example,	in	an	email,	a	message,	a	document,	or	a	note.	Or	use
Continuity	Markup	to	edit	a	document	using	your	finger	on	an	iOS	device	or	with	Apple	Pencil	on	an
iPad,	and	see	those	markups	on	your	Mac.

Note:	To	use	Continuity	Sketch	and	Continuity	Markup,	you	need	an	iPhone	or	iPod	touch	with	iOS	13
(or	later)	or	an	iPad	with	iPadOS	13.1	(or	later).	Make	sure	youʼre	signed	in	with	the	same	Apple	ID	on
all	the	devices,	and	that	they	have	Wi-Fi	and	Bluetooth	turned	on.	Pressure	and	tilt	for	Apple	Pencil
work	only	in	apps	with	advanced	stylus	support.

Insert	a	sketch.	In	an	app	like	Mail,	Notes,	or	Messages,	position	the	pointer	where	you	want	to	insert
a	sketch.	Choose	File	(or	Insert)	>	Import	from	iPhone	or	iPad,	then	choose	Add	Sketch.	On	your	iOS
device	or	iPad,	draw	a	sketch	using	your	finger	or	Apple	Pencil	(on	an	iPad	that	supports	it),	then	tap
Done.	On	your	Mac,	the	sketch	appears	where	you	positioned	the	pointer.	Depending	on	where	the
sketch	is	inserted,	you	can	mark	it	up,	enlarge	it,	and	so	on.

Mark	up	a	document.	With	Continuity	Markup,	you	can	use	a	nearby	iPad	 	or	iPhone/iPod	touch	
to	mark	up	PDFs,	screenshots,	and	images,	and	see	the	results	on	your	Mac.	Press	and	hold	the
Space	bar	to	view	the	document	in	Quick	Look,	then	click	the	device	icon.	If	both	devices	are	nearby,
click	Annotate	 ,	then	choose	a	device.	The	tool	may	appear	highlighted	to	show	your	device	is
connected.

https://support.apple.com/guide/mac-help/mchl9aebdc99/


Start	writing,	drawing,	or	adding	shapes	with	your	finger	or	Apple	Pencil	(on	an	iPad	that	supports	it).
See	the	updates	live	on	your	Mac	as	you	make	them	on	your	iPad,	iPhone,	or	iPod	touch.

Learn	more.	See	Insert	sketches	with	Continuity	Sketch	in	the	macOS	User	Guide	and	the	Apple
Support	article	Use	Markup	on	your	iPhone,	iPad,	or	iPod	touch.

Use	AirDrop	on	your	Mac
AirDrop	makes	it	easy	to	share	files	with	nearby	Mac,	iPhone,	iPad,	and	iPod	touch	devices.	The
devices	donʼt	need	to	share	the	same	Apple	ID.

Note:	AirDrop	for	iOS	or	iPadOS	requires	devices	that	the	device	have	a	Lightning	or	USB-C
connector	and	iOS	7	(or	later)	or	iPadOS	13.1	(or	later).	Not	all	older	Macintosh	computers	support
AirDrop	(for	a	list	of	supported	computers,	see	the	Apple	Support	article	Use	AirDrop	on	your	Mac).

https://support.apple.com/guide/mac-help/mchl74e7c6df
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Send	a	file	from	the	Finder.	Control-click	the	item	you	want	to	send,	choose	Share	>	AirDrop,	then
select	the	device	you	want	to	send	the	item	to.	Or	click	the	Finder	icon	 	in	the	Dock,	then	click
AirDrop	in	the	sidebar	on	the	left	(or	choose	Go	>	AirDrop).	When	the	person	you	want	to	send	a	file
to	appears	in	the	window,	drag	the	file	to	them	from	the	desktop	or	another	Finder	window.	When	you
send	a	file	to	someone,	the	recipient	can	choose	whether	or	not	to	accept	the	file.

Send	a	file	from	an	app.	While	using	an	app	like	Pages	or	Preview,	click	the	Share	button	 	and
choose	AirDrop,	then	select	the	device	you	want	to	send	the	item	to.

Control	who	can	send	you	items	using	AirDrop.	Click	the	Control	Center	icon	 	in	the	menu	bar,
click	AirDrop	 ,	then	select	“Contacts	only”	or	“Everyone.”	You	can	also	turn	AirDrop	on	or	off	here.
iPad,	iPhone,	and	iPod	touch	have	similar	settings.	See	the	Apple	Support	article	How	to	adjust
AirDrop	settings.

Tip:	If	you	donʼt	see	the	recipient	in	the	AirDrop	window,	make	sure	both	devices	have	AirDrop
and	Bluetooth	turned	on	and	are	within	30	feet	(9	meters)	of	each	other.	If	the	recipient	is	using	an
older	Mac,	try	clicking	“Donʼt	see	who	youʼre	looking	for?”

Receive	items	using	AirDrop.	When	someone	uses	AirDrop	to	send	an	item	to	you	on	your	Mac,	you
can	choose	whether	to	accept	and	save	it.	When	you	see	the	AirDrop	notification	and	want	the	item,
click	Accept,	then	choose	to	save	it	to	your	Downloads	folder	or	an	app	like	Photos.	If	youʼre	signed	in
on	several	devices	with	the	same	iCloud	account,	you	can	easily	send	an	item	(for	example,	a	photo
from	iPhone)	from	one	device	to	another,	and	itʼs	saved	automatically.

Share	passwords	stored	in	iCloud	Keychain.	In	Safari,	you	can	use	AirDrop	to	share	an	account
password	with	one	of	your	contacts,	or	with	another	Mac,	iPhone,	iPad,	or	iPod	touch.	From	the	Safari
menu,	open	Preferences	>	Passwords,	select	the	website	whose	password	you	want	to	share,	then
Control-click.	Choose	“Share	with	AirDrop,”	then	select	the	person	or	device	in	the	AirDrop	window	to
share	the	password.

Learn	more.	See	Use	AirDrop	on	your	Mac	to	send	files	to	devices	near	you	in	the	macOS	User	Guide
and	the	Apple	Support	article	Use	AirDrop	on	your	Mac.

Phone	calls	and	text	messages	on	your	Mac
With	a	Wi-Fi	connection,	you	can	take	calls—and	make	them—right	from	your	MacBook	Pro.	You	can
also	receive	and	send	text	messages.

Set	up	FaceTime	for	phone	calls.	On	your	iPhone	(iOS	9	or	later),	go	to	Settings	>	Phone	and	enable
Wi-Fi	calling).	Then,	on	your	Mac,	go	to	FaceTime	>	Preferences,	choose	Settings,	then	click	“Calls
from	iPhone.”	See	Set	up	your	iPhone	and	Mac	for	phone	calls	in	the	FaceTime	User	Guide.

https://support.apple.com/HT204144#setoptions
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Make	a	call.	Open	FaceTime	on	your	Mac	and	enter	a	phone	number.	Or,	in	Contacts,	click	the	phone
icon	 	in	the	FaceTime	row	for	a	contact.	You	can	also	click	a	phone	number	in	a	Spotlight	search	or
in	an	app	such	as	Safari	or	Calendar	(your	iPhone	or	iPad	with	a	cellular	connection	must	be	nearby).
See	Make	and	receive	phone	calls	in	FaceTime	in	the	FaceTime	User	Guide.

Take	a	call.	When	someone	calls	your	iPhone,	click	the	notification	that	appears	on	your	MacBook	Pro
screen.	Your	MacBook	Pro	becomes	a	speakerphone	if	youʼre	not	wearing	headphones.

Tip:	To	temporarily	turn	off	notifications	about	phone	calls,	messages,	and	more	on	your	Mac,	turn
on	the	Do	Not	Disturb	feature.	Click	the	Control	Center	icon	 	in	the	menu	bar,	then	click	Do	Not
Disturb	and	choose	a	time	limit.

Send	and	receive	messages.	Use	Messages	to	send	text	messages	from	your	MacBook	Pro.	All
messages	appear	on	your	MacBook	Pro,	iPhone,	iPad,	iPod	touch,	and	Apple	Watch,	so	when
someone	texts	you,	you	can	respond	with	whichever	device	is	closest.	See	Messages.

Learn	more.	See	Set	up	iPhone	to	get	SMS	texts	on	Mac	in	the	Messages	User	Guide.

Instant	Hotspot	on	your	Mac
Lost	your	Wi-Fi	connection?	With	Instant	Hotspot,	you	can	use	the	Personal	Hotspot	on	your	iPhone
or	iPad	to	connect	your	MacBook	Pro	to	the	internet	instantly—no	password	required.

Note:	Personal	Hotspot	requires	an	iPhone	with	iOS	8	(or	later)	or	a	cellular-model	iPad	with	iPadOS
13.1	(or	later).	See	the	Apple	Support	article	How	to	set	up	a	Personal	Hotspot	on	your	iPhone	or	iPad.

https://support.apple.com/guide/facetime/make-and-receive-phone-calls-mchl390e9463/mac
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https://support.apple.com/HT204023


Connect	to	your	deviceʼs	Personal	Hotspot.	Click	the	Wi-Fi	status	icon	 	in	the	menu	bar,	then
click	 	next	to	your	iPhone	or	iPad	in	the	list	(if	you	donʼt	see	the	list,	click	Other	Networks).	The
Wi-Fi	icon	in	the	toolbar	changes	to	 .	You	donʼt	need	to	do	anything	on	your	device—MacBook	Pro
connects	automatically.	When	youʼre	not	using	the	hotspot,	your	MacBook	Pro	disconnects	to	save
battery	life.

Tip:	If	youʼre	asked	for	a	password,	make	sure	your	devices	are	set	up	correctly.	See	the	Apple
Support	article	Use	Instant	Hotspot	to	connect	to	your	Personal	Hotspot	without	entering	a	password.

Check	the	status	of	your	connection.	Look	in	the	Wi-Fi	status	menu	to	see	the	strength	of	the
cellular	signal.

Learn	more.	See	Use	an	iPhone	or	iPad	to	connect	to	the	Internet	in	the	macOS	User	Guide.

Unlock	your	Mac	and	approve	tasks	with	Apple	Watch
When	youʼre	wearing	your	Apple	Watch,	you	can	use	it	to	automatically	unlock	your	MacBook	Pro	and
approve	authentication	tasks—such	as	entering	passwords,	unlocking	notes	and	preferences,	and
authorizing	installations—without	having	to	type	a	password.	These	features	use	strong	encryption	to
provide	secure	communication	between	your	Apple	Watch	and	MacBook	Pro.

To	use	the	Auto	Unlock	and	Approve	with	Apple	Watch	features:

Sign	in	on	your	Mac	and	Apple	Watch	with	the	same	Apple	ID.

Make	sure	your	Apple	Watch	is	unlocked	and	running	watchOS	3	or	later	to	automatically	unlock
your	Mac;	approving	authentication	requests	requires	watchOS	6	or	later.

Turn	on	two-factor	authentication	(see	below).

Set	up	two-factor	authentication	for	your	Apple	ID.	To	turn	on	two-factor	authentication,	go	to
Apple	menu	 	>	System	Preferences	>	Apple	ID	>	Password	&	Security,	then	select	Set	Up	Two-
Factor	Authentication.	See	the	Apple	Support	article	Two-factor	authentication	for	Apple	ID.

https://support.apple.com/HT209459
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Make	sure	“Disable	automatic	login”	is	also	selected.	(You	wonʼt	see	this	option	if	youʼre	using
FileVault,	but	you	can	still	use	the	“Auto	Unlock”	and	“Approve	with	Apple	Watch”	features.	For
information	about	FileVault,	see	Encrypt	Mac	data	with	FileVault	in	the	macOS	User	Guide.)

Set	up	Auto	Unlock.	Sign	in	on	all	your	devices	with	the	same	Apple	ID,	then	open
System	Preferences	on	your	MacBook	Pro.	If	your	Apple	Watch	has	watchOS	6	installed,	click
Security	&	Privacy,	then	click	General	and	select	“Use	your	Apple	Watch	to	unlock	apps	and	your
Mac.”	If	your	Apple	Watch	has	watchOS	3	to	watchOS	5	installed,	select	“Allow	your	Apple	Watch	to
unlock	your	Mac.”	You	canʼt	approve	authentication	tasks	unless	you	have	watchOS	6	or	later.

Note:	These	features	work	only	when	your	Apple	Watch	is	authenticated	with	a	passcode.	You
authenticate	your	Apple	Watch	each	time	you	put	it	on,	so	no	extra	steps	are	necessary	after	you
enter	your	passcode.

Skip	the	sign-in.	Walk	up	to	your	sleeping	MacBook	Pro	wearing	your	authenticated	Apple	Watch	on
your	wrist,	and	lift	the	cover	or	press	a	key	to	wake	your	MacBook	Pro—Apple	Watch	unlocks	it	so
you	can	get	right	to	work.

Approve	with	Apple	Watch.	If	youʼre	prompted	for	a	password,	double-click	the	side	button	on	your
Apple	Watch	to	authenticate	your	password	on	your	Mac.	You	can	view	your	passwords	in	Safari,
approve	app	installations,	unlock	a	locked	note,	and	more	(requires	watchOS	6).

Learn	more.	See	Unlock	your	Mac	and	approve	requests	with	Apple	Watch	in	the	macOS	User	Guide.

Use	Apple	Pay	on	your	Mac
You	can	make	easy,	secure,	and	private	purchases	on	websites	using	Apple	Pay	on	your	MacBook
Pro.	With	Apple	Pay,	your	Apple	Card	and	other	credit	or	debit	card	information	is	never	stored	or
shared	by	Apple	with	the	merchant.	When	you	shop	online	using	Safari,	look	for	an	Apple	Pay
checkout	option.	Confirm	payment	using	your	Touch	ID,	your	iPhone	or	Apple	Watch.

Note:	Apple	Pay	and	Apple	Card	arenʼt	available	in	all	countries	or	regions.	For	information	about
Apple	Pay,	go	to	Apple	Pay.	For	information	about	current	card	issuers,	see	the	Apple	Support	article
Apple	Pay	participating	banks.	For	information	about	Apple	Card,	see	Apple	Card	Support.

https://support.apple.com/guide/mac-help/mh11785/mac
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Set	up	Apple	Pay.	Apple	Pay	uses	the	Apple	Card	or	other	credit	or	debit	cards	youʼve	already	set	up
on	your	iPhone	or	Apple	Watch,	so	no	extra	setup	is	required.	You	must	be	signed	in	to	an	iPhone	or
Apple	Watch	that	has	Apple	Pay	set	up	with	the	same	Apple	ID	youʼre	using	on	your	MacBook	Pro.
The	default	payment	card,	shipping,	and	contact	information	thatʼs	set	on	your	iPhone	or	Apple
Watch	will	be	used	for	purchases	on	your	Mac.

Make	a	purchase	using	Touch	ID.	On	your	MacBook	Pro,	youʼre	prompted	to	configure	Apple	Pay
during	setup.	When	you	choose	Apple	Pay	on	a	website,	place	your	finger	lightly	on	the	Touch	ID
sensor	to	authenticate	and	complete	your	purchase.

Make	a	purchase	using	the	Touch	Bar	on	13-inch	MacBook	Pro.	When	you	choose	Apple	Pay	on	a
website,	the	merchant	name	and	purchase	amount	appears	on	the	Touch	Bar.	Place	your	finger	lightly
on	the	Touch	ID	sensor	to	authenticate	and	complete	your	purchase.

Make	a	purchase	with	iPhone	or	Apple	Watch.	Click	the	Apple	Pay	button	on	the	website,	then	to
confirm	the	payment,	use	Face	ID,	Touch	ID,	or	the	passcode	on	your	iPhone,	or	double-click	the	side
button	on	your	unlocked	Apple	Watch.	You	must	be	signed	in	to	an	iPhone	or	Apple	Watch	that	has
Apple	Pay	set	up	with	the	same	Apple	ID	youʼre	using	on	your	MacBook	Pro.

Note:	You	can	add	or	delete	payment	cards	and	manage	your	Apple	Card	in	the	Wallet	&	Apple	Pay
pane	of	System	Preferences.

Learn	more.	See	the	Apple	Support	articles	Set	up	Apple	Pay,	Make	purchases	using	Apple	Pay,	and
Manage	the	cards	that	you	use	with	Apple	Pay.

https://support.apple.com/HT204506
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Use	AirPlay	on	your	Mac
Show	whateverʼs	on	your	MacBook	Pro	on	the	big	screen	using	AirPlay	screen	mirroring—or	use
AirPlay	to	send	content	to	your	Mac	from	an	iPhone,	iPad,	or	even	another	Mac.	To	mirror	the
MacBook	Pro	screen	on	your	TV	screen	or	to	use	the	HDTV	as	a	second	display,	connect	your	HDTV
to	Apple	TV	and	make	sure	the	Apple	TV	is	on	the	same	Wi-Fi	network	as	your	MacBook	Pro.	You	can
also	play	web	videos	directly	on	your	HDTV	without	showing	whatʼs	on	your	desktop—handy	when
you	want	to	play	a	movie	but	keep	your	work	private.

Mirror	your	desktop	using	Screen	Mirroring.	Click	the	Control	Center	icon	 	in	the	menu	bar,	click
Screen	Mirroring	 ,	then	choose	your	Apple	TV.	When	AirPlay	is	active,	the	icon	turns	blue.

Note:	If	your	Mac	supports	AirPlay	screen	mirroring,	you	see	an	AirPlay	status	icon	in	the	menu	bar	of
your	Mac	when	an	Apple	TV	is	on	the	same	network	as	your	Mac.	See	Use	AirPlay	to	stream	video	or
mirror	your	deviceʼs	screen.

In	some	cases,	you	can	use	an	AirPlay	display	even	if	your	MacBook	Pro	isnʼt	on	the	same	Wi-Fi
network	as	Apple	TV	(called	peer-to-peer	AirPlay).	To	use	peer-to-peer	AirPlay,	you	need	an	Apple
TV	(3rd	generation	rev	A,	model	A1469	or	later)	with	tvOS	7.0	or	later.

Send	content	to	your	Mac	from	other	devices.	Watch	videos,	listen	to	music,	and	more	on	your	Mac
as	theyʼre	being	played	on	your	other	devices.	Mirror	your	iPhone	or	iPad	on	your	Mac	or	extend	its
display	by	using	your	Mac	as	a	secondary	display	for	apps	that	support	it,	such	as	Keynote	and
Photos.	Use	your	Mac	as	an	AirPlay	2	speaker	to	stream	music	or	podcasts	to	your	Mac,	or	use	it	as	a
secondary	speaker	for	multiroom	audio.	Your	Mac	works	with	any	Apple	device,	and	itʼs	even	easier
to	connect	if	the	devices	share	the	same	Apple	ID.

Play	web	videos	without	showing	your	desktop.	When	you	find	a	web	video	with	an	AirPlay	icon	
,	click	the	icon,	then	select	your	Apple	TV.

https://support.apple.com/HT204289


Tip:	If	the	image	doesnʼt	fit	your	HDTV	screen	when	you	mirror	the	screen,	adjust	the	desktop	size
for	the	best	picture.	Click	the	AirPlay	icon	 	in	the	video,	then	choose	an	option	under	“Match
Desktop	Size	To.”

Apple	TV	is	sold	separately	at	apple.com	or	your	local	Apple	Store.

Learn	more.	To	learn	more	about	AirPlay,	see	Use	AirPlay	to	stream	whatʼs	on	your	Mac	to	an	HDTV
in	the	macOS	User	Guide.	To	learn	more	about	using	a	second	display	with	your	MacBook	Pro,	see
Use	an	external	display	with	your	MacBook	Pro.	To	troubleshoot,	see	the	Apple	Support	article	If
screen	mirroring	or	streaming	isnʼt	working	on	your	AirPlay-compatible	device.

Use	AirPrint	on	your	Mac
If	you	have	an	AirPrint-enabled	printer,	you	can	print	photos	and	documents	from	your	Mac	without
having	to	download	and	install	printer	drivers.

You	can	use	AirPrint	to	print	wirelessly	to:

An	AirPrint-enabled	printer	on	your	Wi-Fi	network

A	network	printer	or	printer	shared	by	another	Mac	on	your	Wi-Fi	network

A	printer	connected	to	the	USB	port	of	an	AirPort	base	station

Print	to	an	AirPrint	printer.	When	you	print	from	an	app,	click	the	Printer	pop-up	menu	in	the	Print
dialog,	then	choose	a	printer	in	the	Nearby	Printers	list.

Canʼt	find	the	printer	youʼre	looking	for?	Make	sure	itʼs	connected	to	the	same	Wi-Fi	network	as
your	MacBook	Pro.	If	itʼs	connected	and	you	still	donʼt	see	it,	try	adding	it:	open	System	Preferences,
click	Printers	&	Scanners,	then	click	 .	(You	may	have	to	temporarily	connect	the	printer	to	your
MacBook	Pro	using	a	USB	cable	and,	if	necessary,	an	adapter.)

Learn	more.	See	Print	wirelessly	from	your	Mac	to	an	AirPrint	printer	in	the	macOS	User	Guide.

For	a	list	of	AirPrint-enabled	printers	and	other	supported	printers,	see	the	Apple	Support	article
About	AirPrint.

https://apple.com
https://support.apple.com/guide/mac-help/mh40624
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https://support.apple.com/HT201311


Apps

Apps	on	your	MacBook	Pro
Your	MacBook	Pro	comes	with	a	collection	of	great	apps	for	things	you	do	every	day,	like	browse	the
web,	stay	connected	with	Messages	and	FaceTime,	and	manage	your	calendar.	It	also	comes	with
apps	like	Photos,	Apple	Music,	Apple	Podcasts,	the	Apple	TV	app,	Pages,	Numbers,	and	Keynote—so
you	can	be	creative	and	productive	right	from	the	start.

Note:	Some	macOS	apps	are	not	available	in	every	region	or	language.

Where	are	my	apps?	Youʼll	find	the	apps	in	the	Applications	folder	in	your	Finder	window.	You	can
open	apps	from	the	folder	or	drag	them	to	your	Dock.	This	folder	includes	a	subfolder,	Utilities,	where
you	can	locate	Disk	Utility	 ,	Keychain	Access	 ,	Migration	Assistant	 ,	VoiceOver	Utility	 ,	and
other	useful	utilities.

Here	are	some	of	the	apps	that	come	with	your	Mac.	Click	the	app	name	to	learn	more.

Icon/App	name Icon/App	name Icon/App	name

App	Store Books Calendar

FaceTime Find	My GarageBand

Home iMovie Keynote

Mail Maps Messages



Music News Notes

Numbers Pages Photos

Podcasts Preview Reminders

Safari Shortcuts Stocks

TV Voice	Memos

Icon/App	name Icon/App	name Icon/App	name

Youʼll	find	additional	apps	that	are	not	listed	in	the	table	above—like	Calculator	 ,	Chess	 ,	Contacts
,	TextEdit	 ,	and	more—in	the	Applications	folder.

Learn	more.	For	a	list	of	all	the	apps	and	utilities	installed	on	your	Mac,	see	Apps	included	on	your
Mac.

Find	even	more	apps.	Click	the	App	Store	icon	 	in	the	Dock	to	find	and	download	apps	for	almost
everything	you	want	to	do.	To	learn	more,	see	App	Store.

Get	help	for	any	app.	Click	the	Help	menu	(in	the	menu	bar	at	the	top	of	the	screen)	when	youʼre
using	an	app.	See	Use	the	macOS	User	Guide.

App	Store
Search	the	App	Store	to	find	and	download	apps,	and	get	the	latest	updates	for	your	apps.

https://support.apple.com/guide/mac-help/built-in-apps-mchl110b00b7/mac


Find	the	perfect	app.	Know	exactly	what	youʼre	looking	for?	Type	the	app	name	in	the	search	field,
then	press	Return.	Apps	you	download	from	the	App	Store	appear	automatically	in	Launchpad.	You
can	also	find	new	Safari	extensions,	which	add	value	to	your	personal	browsing	experience,	when	you
click	the	Categories	tab	in	the	sidebar.

Note:	Apple	Arcade	is	not	available	in	all	countries	or	regions.

Ask	Siri.	Say	something	like:	“Find	apps	for	kids.”

All	you	need	is	an	Apple	ID.	To	download	free	apps,	sign	in	with	your	Apple	ID—choose	Store	>	Sign
In,	or	click	Sign	In	at	the	bottom	of	the	sidebar.	If	you	donʼt	have	an	Apple	ID	yet,	click	Sign	In,	then
click	Create	Apple	ID.	If	you	have	an	Apple	ID	but	donʼt	remember	your	password,	click	“Forgot	Apple
ID	or	password?”	to	recover	it.	You	must	also	set	up	an	account	with	purchasing	information	to	buy
fee-based	apps.

Use	iPhone	and	iPad	apps	on	your	Mac.	Many	iPhone	and	iPad	apps	now	work	on	your	MacBook	Pro
with	Apple	silicon.	Any	available	apps	that	you	previously	purchased	for	your	iPhone	or	iPad	appear
on	your	Mac.	Search	for	apps	in	the	App	Store	to	see	if	theyʼre	available	for	Mac.

Game	on.	Click	the	Arcade	tab	to	learn	how	to	subscribe	to	Apple	Arcade,	discover	games	you	can
play,	find	ones	that	are	popular	with	your	Game	Center	friends,	see	your	achievement	progress,	and
more.	Games	you	download	from	the	App	Store	appear	automatically	in	the	Games	folder	in
Launchpad,	so	theyʼre	always	easy	to	access,	even	with	a	game	controller.	See	Subscribe	to	Apple
Arcade	in	the	App	Store	on	Mac	in	the	App	Store	User	Guide	and	Apple	Arcade.

https://support.apple.com/guide/app-store/subscribe-to-apple-arcade-fird5d0c1e30/mac
https://www.apple.com/apple-arcade/


Save	your	game	action.	You	can	save	up	to	a	15-second	video	clip	of	gameplay	by	pressing	the
share	button	on	supported	third-party	game	controllers,	so	you	can	review	your	game	strategy	or
keep	a	record	of	memorable	gaming	moments.

Invite	your	friends	to	play.	The	new	multiplayer	friend	selector	makes	it	easy	to	invite	your	recent
Messages	friends	and	groups	to	play	Game	Center-enabled	games.	See	incoming	requests	and
invitations	in	the	friend	request	inbox.	See	Play	games	on	your	Mac	in	the	macOS	User	Guide.

Get	the	latest	app	updates.	If	you	see	a	badge	on	the	App	Store	icon	in	the	Dock,	there	are	updates
available.	Click	the	icon	to	open	the	App	Store,	then	click	Updates	in	the	sidebar.

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Tap	a	button	to	quickly	move	to	the	tab	you	want
(Discover,	Arcade,	Create,	Work,	Play,	Develop,	Categories,	or	Updates).

Learn	more.	See	the	App	Store	User	Guide.

https://support.apple.com/guide/mac-help/play-games-mchlec6667e7/mac
https://support.apple.com/guide/app-store/welcome


Books
Use	Apple	Books	to	read	and	organize	your	library	of	books	and	audio	books,	and	to	purchase	new
books	on	your	Mac.	Set	reading	goals	and	keep	track	of	what	you	want	to	read	and	what	youʼre
reading	now.

Note:	Apple	Books	is	not	available	in	all	countries	or	regions.

A	bookshelf	on	your	Mac.	Books	youʼve	started	reading	appear	at	the	top	in	Reading	Now.	Browse	or
search	all	the	items	in	your	library—or	click	Book	Store	or	Audiobook	Store	in	the	sidebar	and	choose
a	category	to	find	new	books	and	other	publications.	To	buy	an	item,	just	sign	in	with	your	Apple	ID
(choose	Account	>	Sign	in).	You	can	also	buy	books	right	from	the	search	results.

Ask	Siri.	Say	something	like:	“Find	books	by	Jane	Austen.”

Set	reading	goals.	Set	daily	reading	goals	to	motivate	yourself	to	read	more.	The	default	is	five
minutes	a	day,	but	if	you	want	to	aim	higher,	click	 	in	the	Reading	Goals	section	of	Reading	Now
and	choose	a	new	goal.	You	can	turn	this	off	and	clear	reading	goal	data	in	Books	preferences.

Add	bookmarks,	notes,	and	highlights.	Move	your	pointer	to	the	top	of	the	book	youʼre	reading	to
show	the	controls,	then	click	 	to	bookmark	a	page	(click	the	bookmark	again	to	remove	the
bookmark).	To	go	to	a	bookmarked	page,	show	the	controls,	click	 ,	then	click	the	bookmark.	To
add	notes	or	highlights,	select	the	text,	then	choose	a	highlight	color	or	Add	Note	from	the	pop-up
menu.	To	read	your	notes	later,	show	the	controls	and	click	 .



Never	lose	your	place	or	your	markups.	Your	purchased	books,	collections,	bookmarks,	highlights
and	notes,	and	the	current	page	youʼre	reading	are	available	automatically	on	your	Mac,	iOS	devices,
and	iPadOS	devices,	as	long	as	youʼre	signed	in	on	them	with	the	same	Apple	ID.

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Tap	 	or	 	to	navigate	back	or	forth	in	the	book,
or	use	the	scrubber	to	move	quickly	through	the	pages.	Tap	 	to	search,	or	tap	 	to	add	a	bookmark
to	the	current	page.

Tip:	Change	to	Night	theme	to	read	more	easily	in	low-light	situations.	Choose	View	>	Theme,
then	choose	Night,	or	click	the	Appearance	button	 ,	then	click	the	black	circle.	Not	all	books
support	Night	theme.

Learn	more.	See	the	Apple	Books	User	Guide.

Calendar
Never	miss	an	appointment	with	Calendar.	Keep	track	of	your	busy	schedule	by	creating	multiple
calendars,	and	manage	them	all	in	one	place.

https://support.apple.com/guide/books/welcome


Create	events.	Click	 	to	add	a	new	event,	or	double-click	anywhere	in	a	day.	To	invite	someone,
double-click	the	event,	click	the	Add	Invitees	section,	then	type	an	email	address.	Calendar	lets	you
know	when	your	invitees	reply.

Ask	Siri.	Say	something	like:	“Set	up	a	meeting	with	Mark	at	nine	in	the	morning.”

Tip:	If	you	add	a	location	to	an	event,	Calendar	shows	you	a	map,	estimated	travel	time	and	time
to	leave,	and	even	the	weather	forecast.

A	calendar	for	every	part	of	your	life.	Create	separate	calendars—for	example,	for	home,	work,	and
school—each	with	its	own	color.	Choose	File	>	New	Calendar	to	create	a	calendar,	then	Control-click
each	calendar	to	choose	a	new	color.

See	all	your	calendars—or	just	a	few.	Click	the	Calendars	button	to	see	a	list	of	all	your	calendars;
click	the	ones	you	want	to	see	in	the	window.



Share	across	your	devices	and	with	others.	When	youʼre	signed	in	to	iCloud,	your	calendars	are
kept	up	to	date	on	all	your	Macintosh	computers,	iOS	devices,	iPadOS	devices,	and	Apple	Watch	that
are	signed	in	with	the	same	Apple	ID.	You	can	also	share	calendars	with	other	iCloud	users.

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Tap	the	Today	button	to	view	or	edit	todayʼs
events,	or	use	the	slider	to	select	the	month—past	or	future.

Select	an	event	in	your	calendar,	and	tap	buttons	to	specify	the	calendar	for	the	event,	get	event
details,	edit	the	time	or	place,	and	add	or	delete	invitees.

Learn	more.	See	the	Calendar	User	Guide.

FaceTime
Use	FaceTime	to	make	video	and	audio	calls	from	your	Mac	to	a	friend	or	a	group	of	friends.

Ask	Siri.	Say	something	like:	“Make	a	FaceTime	call	to	Sharon.”

Make	a	FaceTime	call.	Use	the	built-in	FaceTime	HD	camera	on	your	Mac	to	make	FaceTime	video
calls.	Click	New	FaceTime,	enter	a	name,	phone	number,	or	email	address	for	the	person	you	want	to
call,	then	click	FaceTime.	If	itʼs	not	convenient	to	make	a	video	call,	click	the	pop-up	menu	and	select
FaceTime	Audio	to	make	an	audio-only	call.	When	you	receive	a	FaceTime	invitation,	you	can	choose
to	join	with	video	or	just	audio.

Tip:	While	a	video	call	is	in	progress,	you	can	drag	the	small	picture-in-picture	window	to	any
corner	of	the	FaceTime	window.

https://support.apple.com/guide/calendar/welcome


Use	FaceTime	with	a	group.You	can	connect	with	up	to	32	people	in	a	group	call.	Make	a	unique	link
to	share	with	a	group.	Click	Create	Link.	Copy	the	link	to	your	Clipboard	or	share	directly	with	friends
in	Messages	or	Mail.	You	can	now	use	a	link	to	join	FaceTime	calls	on	non-Apple	devices.

Tip:	Add	a	FaceTime	link	to	a	Calendar	event	to	schedule	a	call	for	later.



Sign	language	recognition	and	Live	Captions.	FaceTime	detects	when	a	participant	is	using	sign
language	and	makes	the	person	prominent	in	a	Group	FaceTime	call.	FaceTime	Live	Captions	detect
whatʼs	said	and	present	real-time	captions	for	the	active	speaker.

Make	a	phone	call.	If	you	have	an	iPhone	with	iOS	8	or	later,	make	phone	calls	from	your	Mac	using
FaceTime.	Just	make	sure	your	Mac	and	iPhone	are	signed	in	with	the	same	Apple	ID	account	and
that	both	have	the	feature	turned	on.	(On	your	Mac,	open	FaceTime,	choose	FaceTime	>	Preferences,
then	select	“Calls	from	iPhone.”)

Note:	Your	MacBook	Pro	and	iPhone	must	be	connected	to	the	internet	and	the	same	Wi-Fi	network
to	make	or	receive	calls	on	your	Mac.

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Start	typing	a	contactʼs	name,	then	tap	your
selection.	On	the	Touch	Bar,	choose	Audio	or	Video	for	the	type	of	call	you	want	to	make.

Learn	more.	See	the	FaceTime	User	Guide.

Find	My
Use	Find	My	to	locate	your	friends,	family,	and	Apple	devices—all	in	the	same	app.

https://support.apple.com/guide/facetime/welcome


Note:	Find	My	features	are	not	available	in	all	regions	or	languages.

Share	locations	with	friends.	In	the	People	list,	click	Share	My	Location	to	tell	friends	and	family
where	you	are.	You	can	share	your	live	location	for	an	hour,	a	day,	or	indefinitely,	and	stop	sharing
whenever	you	like.	You	can	also	ask	to	follow	a	friend	so	you	can	see	where	they	are	on	a	map	and
get	step-by-step	directions	to	their	location.

Set	location	alerts.	Automatically	send	notifications	to	friends	when	you	arrive	at	or	leave	a	specific
location.	Set	notifications	when	your	friends	leave	and	arrive,	too.	If	your	friends	create	notifications
about	your	location,	you	can	view	them	all	in	one	place—click	Me	in	the	People	list,	then	scroll	to
Notifications	About	You.

Get	notified	when	you	leave	something	behind.	Set	up	separation	alerts	on	your	iPhone,	iPad,	or
iPod	touch	to	notify	you	when	you	leave	your	Mac	with	Apple	silicon	or	another	device	behind.

Secure	a	lost	device.	Use	Find	My	to	locate	and	protect	missing	devices,	like	your	Mac,	iPhone,	or
AirPods.	Click	a	device	in	the	Devices	list	to	locate	it	on	the	map.	Click	 	to	see	options	like	play	a
sound	on	the	device	to	help	you	find	it,	mark	the	device	as	lost	so	others	canʼt	access	your	personal
information,	and	even	erase	the	device	remotely.

Locate	devices,	even	if	theyʼre	offline.	Find	My	uses	Bluetooth	signals	from	other	nearby	Apple
devices	to	locate	your	device	when	itʼs	not	connected	to	a	Wi-Fi	or	cellular	network.	These	signals	are
anonymous	and	encrypted,	and	help	locate	your	missing	device	without	compromising	privacy.	You
can	even	find	a	device	thatʼs	been	erased	(for	Macintosh	computers	with	macOS	12	or	later,	iPhones
and	iPod	touch	devices	with	iOS	15	or	later,	and	iPads	with	iPadOS	15	or	later).

Find	a	family	memberʼs	device.	You	can	use	Find	My	to	help	locate	a	family	memberʼs	device,	if
youʼre	in	a	Family	Sharing	group	and	your	family	member	is	sharing	their	location	with	you.

Find	everyday	items.	Attach	an	AirTag	to	an	item	like	your	keychain	to	quickly	locate	it	when	you
canʼt	find	it.	Use	your	iOS	or	iPadOS	device	to	register	an	AirTag	and	compatible	third-party	items	to
your	Apple	ID.	To	locate	items	using	your	Mac,	click	the	Items	tab	in	Find	My,	then	click	an	item	in	the
list	to	view	its	location	on	the	map.	If	the	item	canʼt	be	located,	you	can	view	its	last	location	and
receive	a	notification	when	the	item	is	found.	You	can	even	turn	on	Lost	Mode	for	an	item	that
includes	a	message	and	phone	number.	See	Locate	an	item	in	Find	My	in	the	Find	My	User	Guide.

Learn	more.	See	the	Find	My	User	Guide.

GarageBand

https://support.apple.com/guide/findmy-mac/welcome
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GarageBand	is	an	app	for	creating,	recording,	and	sharing	your	music.	It	has	everything	you	need	to
learn	to	play	an	instrument,	write	music,	or	record	a	song—your	own	home	recording	studio.

Create	a	new	project.	You	can	start	with	a	song	template,	select	a	tempo,	key,	and	other	options,
then	click	Record	and	start	playing.	Build	your	song—for	example,	with	different	tracks	and	loops.
Click	Quick	Help	 	and	hold	the	pointer	over	items	to	learn	what	they	are	and	how	they	work.

Bring	in	the	beat.	You	can	quickly	add	drums	to	your	project	using	Drummer	Loops.	Click	the	Loop
Browser	 ,	then	drag	a	Drummer	Loop	 	into	an	empty	part	of	the	Tracks	area.	You	can	customize
Drummer	Loops	to	fit	your	song,	using	a	simple	set	of	controls.

Record	your	voice.	Choose	Track	>	New	Track,	then	select	the	microphone	under	Audio.	Click	the
triangle	next	to	Details	to	set	options	for	input,	output,	and	monitoring,	then	click	Create.	Click	the
Record	button	 	to	start	recording,	or	the	Play	button	 	to	stop	recording.



Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Easily	adjust	the	Smart	Controls	for	a	selected
track.	Tap	buttons	to	quickly	fine-tune	the	sound	of	your	instrument,	turn	effects	on	or	off,	or	adjust
the	volume	of	your	track.

Learn	more.	See	GarageBand	User	Guide	and	GarageBand	Support.

Home
With	the	Home	app,	you	can	easily	and	securely	control	all	of	your	HomeKit	accessories	from	your
Mac.

Accessory	control.	Accessories	appear	in	the	Home	app	as	tiles	with	icons.	Click	an	accessory	tile	to
control	it—turn	lights	on	or	off,	lock	or	unlock	the	door,	view	live	cameras,	and	more.	You	can	also
adjust	the	brightness	of	a	light,	or	the	target	temperature	of	a	thermostat.	A	new	visual	status	at	the
top	of	the	Home	app	shows	a	summary	of	accessories	that	need	your	attention	or	that	have	important
status	changes	to	share.

https://support.apple.com/guide/garageband/welcome/mac
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Shared	Access.	You	can	share	your	home	with	family	members	or	guests,	so	they	can	control
accessories	using	the	Home	app	on	their	own	Apple	devices.

Create	a	scene.	Create	a	scene	that	lets	your	accessories	work	together	with	a	single	command.	For
example,	make	a	Good	Night	scene	that	turns	off	all	the	lights,	closes	the	shades,	and	locks	the	door
when	you	turn	in	for	the	night.	To	create	a	scene,	click	 ,	then	click	Add	Scene.

HomeKit	Secure	Video.	Connect	your	home	security	cameras	in	the	Home	app	to	record	your
footage	and	view	it	from	anywhere.	Itʼs	all	end-to-end	encrypted,	and	none	of	the	video	counts
against	your	iCloud	storage.	HomeKit	Secure	Video	requires	a	supported	iCloud	plan,	compatible
HomeKit-enabled	security	camera,	and	HomePod,	Apple	TV,	or	iPad	running	as	a	home	hub.	See	the
iCloud	User	Guide.

Create	activity	zones.	Define	activity	zones	within	a	cameraʼs	view	to	capture	video	or	receive
notifications	only	when	motion	is	detected	in	those	areas.	In	addition	to	person,	animal,	package
delivery,	and	vehicle	detection,	Face	Recognition	lets	security	cameras	and	doorbells	identify	people
youʼve	tagged	in	the	Photos	app	or	in	the	Home	app	as	recent	visitors.	(HomeKit	Secure	Video
requires	a	home	hub	and	a	compatible	iCloud	plan.

Adaptive	lighting.	Set	your	smart	light	bulbs	to	automatically	adjust	the	color	temperature	throughout
the	day	to	maximize	comfort	and	productivity.	Wake	up	to	warm	colors,	stay	focused	and	alert	midday
with	cooler	ones,	and	wind	down	at	night	by	removing	blue	light.	(Adaptive	lighting	requires	a	home
hub.	For	more	information,	see	Configure	a	router	to	use	with	Home	on	Mac	in	the	Home	User	Guide.)

Learn	more.	See	the	Home	User	Guide.

https://support.apple.com/guide/icloud/welcome/icloud
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iMovie
iMovie	lets	you	turn	your	home	videos	into	beautiful	movies	and	Hollywood-style	trailers	that	you	can
share	with	a	few	quick	clicks.

Import	a	video.	Import	video	from	your	iPhone,	iPad,	or	iPod	touch,	from	a	camera,	or	from	media
files	already	on	your	Mac.	iMovie	creates	a	new	library	and	event	for	you.

Record	video	with	the	built-in	camera.	Use	the	FaceTime	HD	camera	on	your	Mac	to	record	video
and	add	it	to	your	project.	Select	an	event	in	the	sidebar,	click	Import	in	the	toolbar,	select	FaceTime
HD	Camera,	then	click	the	Record	button	to	start	and	stop	recording.

Create	Hollywood-style	trailers.	Make	clever	trailers,	complete	with	animated	graphics	and	soaring
soundtracks.	Just	add	photos	and	video	clips	and	customize	the	credits.	To	get	started,	click	the	New
button	 ,	click	Trailer,	choose	a	template	from	the	Trailer	window,	then	click	Create.	Add	the	cast
and	credits	in	the	Outline	tab,	and	add	your	own	photos	and	videos	in	the	Storyboard	tab.



Tip:	Shooting	video	with	a	handheld	device	can	produce	shaky	results,	but	you	can	stabilize	the
video	so	the	playback	is	smoother.	Select	the	clip	in	the	timeline,	click	the	Stabilization	button	 ,	then
click	Stabilize	Shaky	Video.

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Tap	to	Favorite	or	Reject	any	clip	in	the	browser,
making	it	easy	to	find	the	clip	later	or	hide	it	from	view.	You	can	also	tap	in	the	Touch	Bar	to	play	a
clip,	add	a	clip	to	the	current	movie,	or	add	a	clip	as	a	video	overlay,	such	as	split	screen	or	picture	in
picture.

When	the	timeline	is	selected,	use	the	Touch	Bar	buttons	to	rewind,	play,	fast-forward,	or	split	the
clip	into	two	parts	at	the	point	where	you	click.	Tap	the	volume	button	in	the	Control	Strip	to	adjust
the	volume	of	a	clip.

Use	the	slider	to	adjust	the	volume.	When	you	finish,	tap	 .

Learn	more.	See	iMovie	User	Guide	and	iMovie	Support.

Keynote
Create	professional,	cutting-edge	presentations	with	Keynote.	Start	with	one	of	the	more	than	30
predesigned	themes	and	make	it	your	own	by	adding	text,	new	objects,	and	changing	the	color
scheme.

https://support.apple.com/guide/imovie/welcome/mac
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Organize	visually.	Use	the	slide	navigator	on	the	left	to	quickly	add,	rearrange,	or	delete	slides.	Click
a	slide	to	see	it	in	the	main	window,	drag	a	slide	to	change	its	order,	or	select	a	slide	and	press	Delete
to	remove	it.

Practice	makes	perfect.	To	rehearse	your	presentation,	choose	Play	>	Rehearse	Slideshow.	Youʼll
see	each	slide	along	with	your	notes—and	a	clock	to	keep	you	on	track.



Present	in	any	situation.	Present	in	person	using	an	external	display	and	use	your	Mac	to	view
upcoming	slides,	presenter	notes,	a	clock,	and	a	timer.	Host	a	multi-presenter	slideshow	during	a
videoconference,	and	control	it	as	you	would	when	presenting	alone.	Create	an	interactive
presentation	that	the	viewer	controls,	control	your	presentation	remotely	using	your	iPhone,	iPad,	or
even	your	Apple	Watch,	and	more.

Share	your	presentation.	If	your	manager	wants	to	review	your	presentation	or	you	want	to	share	it
with	others	on	a	conference	call,	choose	Share	>	Send	a	Copy	to	send	a	copy	by	Mail,	Messages,
AirDrop,	or	even	social	media.

Draw	them	in.	Get	their	attention	by	animating	an	object	on	a	slide.	Select	the	object,	click	Animate	in
the	toolbar,	click	Action	in	the	sidebar,	then	click	Add	an	Effect.

Tip:	You	can	include	a	video	in	your	presentation.	Click	where	you	want	it	to	be,	then	click	the
Media	button	 	in	the	toolbar.	Click	Movies,	then	find	the	movie	you	want	and	drag	it	to	your	slide.

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Tap	the	arrow	buttons	to	move	up	or	down
through	your	slides.	Tap	to	zoom	or	skip	a	slide,	or	tap	to	group	or	ungroup	slides.	In	presentation
mode,	you	see	thumbnails	of	your	slides	in	the	Touch	Bar.

Learn	more.	See	the	Keynote	User	Guide.

Mail
Mail	lets	you	manage	all	your	email	accounts	from	a	single	app.	It	works	with	most	popular	email
services,	such	as	iCloud,	Gmail,	Yahoo	Mail,	and	AOL	Mail.

One-stop	email.	Tired	of	signing	in	to	multiple	websites	to	check	your	email	accounts?	Set	up	Mail
with	all	your	accounts	so	you	can	see	all	your	messages	in	one	place.	Choose	Mail	>	Add	Account.

Ask	Siri.	Say	something	like:	“Email	Laura	about	the	trip.”

Find	the	right	message.	Type	in	the	search	field	to	see	suggestions	for	messages	that	best	match
your	query.

https://support.apple.com/guide/keynote/welcome/mac


Focus	on	whatʼs	important.	See	only	the	messages	you	want	to	see	in	your	inbox.	You	can	block
messages	from	specific	senders	by	moving	their	messages	directly	to	the	Trash,	mute	overly	active
email	threads,	and	unsubscribe	from	mailing	lists	directly	in	Mail.

Add	events	and	contacts	right	from	Mail.	When	you	receive	a	message	that	includes	a	new	email
address	or	event,	just	click	Add	in	the	message	to	add	it	to	Contacts	or	Calendar.	Force	click	an
address	to	see	a	preview	of	the	location,	which	you	can	open	in	Maps.

Protect	your	privacy.	Privacy	Protection	prevents	email	senders	from	learning	information	about	your
Mail	activity.	If	you	turn	it	on,	it	hides	your	IP	address	so	senders	canʼt	link	it	to	your	other	online
activity	or	determine	your	location.	It	also	prevents	senders	from	seeing	if	youʼve	opened	their	email.
Turn	it	on	in	Mail	Preferences	>	Privacy,	then	check	Protect	Mail	Activity.

Translate	in	a	snap.	Select	the	text	you	want	to	translate,	Control-click	the	selected	text,	choose
Translate,	then	choose	a	language.	To	translate	text	youʼve	typed,	click	“Replace	with	Translation.”
You	can	also	download	languages	so	you	can	work	offline—go	to	the	Language	&	Region	pane	of
System	Preferences,	then	click	the	Translation	Languages	button	at	the	bottom.	Not	all	languages	are
available.	Not	all	languages	are	available.	See	Translate	on	Mac	in	the	macOS	User	Guide.

Personalize	any	message.	Add	emoji	or	photos	with	just	a	click.	Select	photos	from	your	photo
library	or	take	them	on	iPhone	or	iPad.	You	can	also	add	a	sketch	youʼve	drawn	on	your	iPhone	or
iPad.	To	learn	more	about	inserting	photos	and	sketches	from	other	devices,	see	Continuity	Camera
on	your	Mac	and	Continuity	Sketch	and	Continuity	Markup	on	your	Mac.

https://support.apple.com/guide/mac-help/mchldd8b3c15


View	in	full	screen.	When	youʼre	using	Mail	in	full	screen,	windows	for	new	messages	automatically
open	in	Split	View	on	the	right,	so	itʼs	easy	to	reference	another	message	in	your	inbox	as	you	write.
See	the	Apple	Support	article	Use	two	Mac	apps	side	by	side	in	Split	View.

Never	miss	an	email.	Check	the	Mail	icon	in	the	Dock	to	see	the	number	of	unread	messages.	When
you	get	a	new	email,	a	notification	also	appears	at	the	top-right	of	the	screen	so	you	can	quickly
preview	incoming	messages.	(Donʼt	want	notifications?	To	turn	them	off,	open	System	Preferences,
then	click	Notifications.)

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Use	the	Touch	Bar	for	many	common	tasks,	like
composing,	replying,	archiving,	marking	as	junk,	and	flagging	messages.

https://support.apple.com/HT204948


Customize	the	Touch	Bar	to	add	your	favorite	controls	(choose	View	>	Customize	Touch	Bar).	See
Customize	the	Touch	Bar	on	the	13-inch	MacBook	Pro.

Learn	more.	See	the	Mail	User	Guide.

Maps
Get	directions	and	view	locations	using	a	map	or	a	satellite	image.	Get	recommendations	for	the	best
places	to	visit	in	a	city,	with	guides	curated	by	Apple.	Force	click	a	location	to	drop	a	pin	there.

Explore	in	detail.	Maps	shows	you	more	details	to	help	you	discover	whatʼs	out	there,	including
landmarks,	elevation,	natural	features,	and	more.	On	your	Mac	with	Apple	silicon,	new	city
experiences	offer	details	like	landmarks,	buildings,	and	even	trees.

Plan	your	route.	Use	the	new	driving	map	to	plan	your	route,	check	for	traffic,	and	see	road	details,
like	turn	and	bus	lanes.	Quickly	share	directions	to	your	iPhone	or	to	a	friend	via	Messages.

Find	and	save	your	favorites.	Find	what	youʼre	looking	for	and	filter	the	results.	Click	on	a	place	to
learn	important	information,	like	opening	hours	for	a	business	or	whether	a	restaurant	offers	takeout.
You	can	save	the	places	you	go	most	often	to	your	favorites.

Ask	Siri.	Say	something	like:	“Find	coffee	near	me.”

Discover	new	places	with	guides.	To	help	you	discover	great	places	around	the	world	to	eat,	shop,
and	explore,	Maps	offers	curated	guides	from	trusted	brands	and	partners.	You	can	save	these
guides	and	get	updates	whenever	new	places	are	added.

https://support.apple.com/guide/mail/welcome


Create	your	own	guides.	You	can	create	your	own	guides	for	your	favorite	places	and	share	them
with	friends	and	family.	To	create	a	guide,	move	the	pointer	over	My	Guides	in	the	sidebar,	click	 	on
the	right,	then	Control-click	the	new	guide	to	see	a	menu	of	options.

Explore	in	3D.	Click	Look	Around	 	to	explore	select	cities	in	3D	as	you	move	smoothly	through	the
streets	in	an	interactive	experience.	On	your	Mac	with	Apple	silicon,	you	can	use	the	interactive	3D
Globe	to	experience	the	Earthʼs	natural	beauty.

See	indoor	maps	for	major	destinations.	Find	your	way	around	select	airports	and	shopping	malls.
Just	zoom	in	to	see	what	restaurants	are	near	your	gate,	find	a	restroom,	plan	a	spot	to	meet	up	with
friends	at	the	mall,	and	more.

Get	there	on	public	transit.	Maps	provides	Nearby	Transit	information	for	select	cities,	including
upcoming	departures	near	you.	Click	a	destination	in	the	sidebar,	then	click	 	to	get	suggested	travel
routes	and	estimated	travel	time.	Pin	your	favorite	transit	lines	so	they	always	show	up	at	the	top	if
theyʼre	nearby.

EV	trip	planning	made	easy.	Add	your	electric	vehicle	to	your	iPhone,	and	Maps	shows	you	where
the	charging	stations	are	along	your	route,	and	accounts	for	charging	times	when	calculating	your
ETA.

Plan	your	cycling	route.	Maps	gives	you	the	info	you	need	to	plan	your	cycling	trip,	such	as
elevation,	traffic	conditions,	and	whether	there	are	steep	inclines.	After	you	plan	your	trip,	you	can
send	it	to	your	iPhone.

Get	live	ETA	updates.	When	friends	and	family	share	their	ETA	with	you,	Maps	can	show	you	where
they	are	along	their	route.

Note:	Some	Maps	features	are	not	available	in	all	countries	or	regions.



WARNING:	For	important	information	about	navigation	and	avoiding	distractions	that	could	lead	to
dangerous	situations,	see	Important	safety	information	for	your	Mac.

Tip:	To	see	what	traffic	is	like,	click	the	View	menu	in	the	menu	bar,	then	choose	Show	Traffic.

Learn	more.	See	the	Maps	User	Guide.

Messages
With	Messages,	itʼs	easy	to	stay	in	touch,	no	matter	what	device	youʼre	using.	Manage	group	texts,
pin	favorites	to	the	top,	easily	view	content	shared	with	you	by	others,	and	much	more.	You	can	send
text	messages	to	anyone	with	a	Mac,	iPhone,	iPad,	iPod	touch,	or	Apple	Watch	using	iMessage,	and
send	texts	to	others	using	SMS/MMS.	See	the	Apple	Support	article	About	iMessage	and	SMS/MMS.

Unlimited	messages	with	iMessage.	When	you	sign	in	with	your	Apple	ID	you	can	exchange
unlimited	messages—including	text,	photos,	Live	Photos,	video,	and	more—with	anyone	with	a	Mac,
iPhone,	iPad,	iPod	touch,	or	Apple	Watch.	The	Messages	app	uses	iMessage	to	send	encrypted
messages	to	these	devices	that	appear	in	blue	bubbles	in	your	conversations.	For	setup	information,
see	the	Apple	Support	article	Use	Messages	with	your	Mac.

Send	SMS/MMS.	If	youʼre	not	using	iMessage,	you	can	send	and	receive	SMS	and	MMS	messages	on
your	Mac	if	your	iPhone	(with	iOS	8.1	or	later)	is	signed	in	to	Messages	with	the	same	Apple	ID	as
your	Mac.	On	your	iPhone,	go	to	Settings	>	Messages,	tap	Text	Message	Forwarding,	then	tap	the
name	of	your	Mac	to	turn	on	Text	Message	Forwarding.	On	your	Mac,	youʼll	see	an	activation	code	if
youʼre	not	using	two-factor	authentication	for	your	Apple	ID.	Enter	the	code	on	your	iPhone,	then	tap
Allow.	SMS	and	MMS	messages	arenʼt	encrypted	and	appear	in	green	bubbles	in	your	conversations.

Ask	Siri.	Say	something	like:	“Message	Mom	that	Iʼll	be	late.”

https://support.apple.com/guide/maps/welcome
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Shared	with	You.	Content	sent	to	you	over	Messages	by	people	in	your	Contacts	automatically
appears	in	a	new	Shared	with	You	section	in	the	corresponding	app,	so	you	can	enjoy	it	when	itʼs
convenient	for	you.	Shared	with	You	content	appears	in	Photos,	Safari,	Apple	News,	Apple	Podcasts,
and	the	Apple	TV	app.	Alongside	shared	content	in	the	corresponding	apps,	you	can	see	who	sent	it,
and	with	a	click,	open	the	associated	conversation	in	Messages	so	you	can	continue	the	conversation
while	youʼre	enjoying	what	was	shared	with	you.

Keep	favorite	conversations	at	the	top.	Pin	your	favorite	conversations	to	the	top	of	the	messages
list	by	dragging	them	to	the	top.	New	messages,	Tapbacks,	and	typing	indicators	appear	above	a
pinned	conversation.	When	there	are	unread	messages	in	a	group	conversation,	the	most	recent
participants	appear	around	the	pinned	conversation.

Manage	group	conversations.	Make	it	easier	to	identify	a	group	by	setting	a	photo,	Memoji,	or	emoji
as	the	group	image.	In	a	group	conversation,	you	can	direct	a	message	to	an	individual	by	typing	the
personʼs	name	or	using	the	@	sign,	and	you	can	respond	to	a	question	or	statement	earlier	in	the
conversation	by	adding	your	comment	as	an	inline	reply.	When	a	conversation	becomes	too	active,
you	can	hide	alerts	for	the	conversation.	To	set	a	group	image	and	see	options	for	managing	a
conversation,	select	the	conversation	in	the	list,	then	click	the	Details	button	 	in	the	top-right	corner
of	the	Messages	window.	To	receive	a	notification	when	youʼre	mentioned,	open	Messages
Preferences,	click	General,	then	select	the	“Notify	me	when	my	name	is	mentioned”	checkbox.

Easy	photo	management.	When	someone	sends	you	multiple	photos,	they	appear	as	a	collage	you
can	view	at	a	glance.	Larger	sets	are	gathered	in	a	stack	you	can	flip	through.	Click	the	stack	to	view
the	photos	as	a	grid,	where	you	can	add	a	Tapback	or	inline	reply	to	individual	photos.	To	quickly
save	a	photo	to	Photos,	click	the	Save	Photo	button	 	next	to	it.	To	see	all	the	photos	in	a
conversation,	click	the	Details	button	 .



Make	messages	fun.	Liven	up	discussions	by	responding	to	messages	with	Memoji	stickers,
Tapbacks,	trending	GIFs,	or	special	effects	like	fluttering	confetti,	balloons,	and	more.	Messages
automatically	generates	sticker	packs	based	on	your	Memoji	characters.	To	add	a	Memoji	sticker	to	a
conversation,	click	the	Apps	button	 ,	click	Memoji	Stickers,	then	click	the	one	that	best	expresses
your	mood.	To	add	a	Tapback,	click	and	hold	a	message,	then	choose	a	Tapback.	To	add	a	GIF	or
special	effect,	click	the	Apps	button	 ,	choose	#images	or	Message	Effects,	then	click	the	one	you
want	to	use.	And	look	out	for	Digital	Touch,	invisible	ink,	and	handwritten	messages	that	your	friends
send	you	from	their	iPhone,	iPad,	or	Apple	Watch.

Create	your	own	Memoji.	Design	your	own	personalized	Memoji—choose	skin	color	and	freckles,
hairstyle	and	color,	facial	features,	and	more.	To	use	a	personalized	Memoji	as	your	Messages	photo,
go	to	Messages	>	Preferences.	Click	“Set	up	Name	and	Photo	Sharing,”	click	Continue,	then	click
Customize.	Click	the	New	Memoji	button	 ,	then	click	each	feature	to	design	your	look.	When	you
finish,	click	Done	to	add	the	Memoji	to	your	sticker	collection.	To	add	more	Memoji	to	your	collection,
open	a	conversation,	click	the	Apps	button	 ,	click	Memoji	Stickers,	click	the	New	Memoji	button	

,	then	have	fun	designing.

Send	a	file,	photo,	or	video.	Easily	share	files	by	dragging	them	to	Messages.	Or	quickly	find	and
send	photos	and	videos	from	your	Photos	library.	In	a	conversation,	click	the	Apps	button	 ,	click
Photos,	then	click	a	photo	to	add	it.	Type	a	keyword—for	example,	a	personʼs	name,	date,	or	location
—in	the	search	field	to	help	you	find	a	specific	photo.

Share	your	screen.	You	and	a	friend	can	share	screens	and	even	open	folders,	create	documents,
and	copy	files	by	dragging	them	to	the	desktop	on	the	shared	screen.	Click	the	Details	button	 ,	then
click	the	Screen	Share	button	 .

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Tap	 	to	create	a	new	message.	Tap	the	typing
suggestions	to	add	words,	and	tap	 	to	see	emoji	that	you	can	add	to	your	message.	Click	a	message
in	the	thread	to	see	Tapbacks	on	the	Touch	Bar,	and	tap	to	add	them.

Learn	more.	See	the	Messages	User	Guide.

https://support.apple.com/guide/messages/welcome


Music
The	Apple	Music	app	makes	it	easy	to	organize	and	enjoy	your	iTunes	Store	purchases,	songs,	and
albums	in	your	personal	library,	and	in	the	Apple	Music	catalog	(which	lets	you	listen	to	millions	of
songs	on	demand).	Click	to	view	whatʼs	next,	previously	played	tracks,	and	lyrics	for	whatʼs	playing.
Shop	for	the	music	you	want	in	the	iTunes	Store.

Itʼs	in	your	library.	You	can	easily	view	and	play	your	iTunes	Store	purchases,	items	you	added	from
the	Apple	Music	catalog,	and	music	in	your	personal	library.	Filter	your	content	by	Recently	Added,
Artists,	Albums,	or	Songs.

Browse	the	best	of	Apple	Music.	Click	Browse	in	the	sidebar	to	see	new	music	and	exclusive
releases	from	Apple	Music,	a	music	streaming	service	available	for	a	monthly	fee.	Stream	and
download	more	than	50	million	songs	ad-free,	and	choose	from	a	large	selection	of	playlists	to	find
the	perfect	mix	for	any	moment.

Sing	along.	Click	 	in	the	toolbar	to	display	a	panel	with	lyrics	for	the	current	song	(if	available).

Tune	in.	Click	Radio	in	the	sidebar	to	tune	in	to	Apple	Music	1	live	or	listen	to	any	episode	from	the
Apple	Music	family	of	shows.	Explore	the	variety	of	stations	created	for	almost	every	genre	of	music.

Ask	Siri.	Say	something	like:	“Add	this	song	to	my	library.”

Sync	with	ease.	Sync	your	music	content	directly	in	the	Apple	Music	app.	When	you	connect	a
device,	you	see	it	in	the	sidebar	of	the	Finder.	Just	drag	the	content	you	want	onto	your	device.	You
can	also	back	up	and	restore	your	device	in	the	Finder.

Buy	it	on	the	iTunes	Store.	If	you	want	to	own	your	music,	click	iTunes	Store	in	the	sidebar.	(If	you
donʼt	see	the	store	in	the	sidebar,	choose	Music	>	Preferences,	click	General,	then	click	Show	iTunes
Store.)



Tip:	When	screen	real	estate	is	at	a	premium,	switch	to	MiniPlayer	to	open	a	small	floating	window
that	you	can	drag	where	you	want,	so	you	can	listen	and	control	your	music	while	doing	other	things
on	your	Mac.	To	open	MiniPlayer,	choose	Window	>	MiniPlayer.

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	When	youʼre	playing	a	song,	you	see	the	rewind,
play/pause,	and	fast-forward	buttons	in	the	Touch	Bar.

Learn	more.	See	the	Apple	Music	User	Guide.

News
Apple	News	is	your	one-stop	destination	for	trusted	news	and	information,	curated	by	editors	and
personalized	for	you.	You	can	save	articles	for	future	reading—even	offline	or	on	other	devices.	Apple
News+	lets	you	read	hundreds	of	magazines,	popular	newspapers,	and	premium	digital	publishers	for
a	single	monthly	price.

A	redesigned	news	feed	in	macOS	Monterey	with	more	prominent	bylines	and	publication	dates
makes	it	easier	to	browse	and	verify	stories.	Save	stories	right	from	the	news	feed	to	read	later	or
share.	News+	subscribers	get	a	more	robust	search	feature	and	the	News+	Library,	which	organizes
your	content	by	magazines,	downloaded,	newspapers,	and	catalog—so	itʼs	easier	to	get	to	your
favorites.

Note:	Apple	News	and	Apple	News+	are	not	available	in	all	countries	or	regions.
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Customize	your	feed.	Follow	your	favorite	channels	and	topics	to	see	them	in	the	Today	feed	and
sidebar.	Enter	a	news	outlet	or	topic	in	the	search	field,	then	click	 	to	follow	it.

Tip:	If	youʼre	reading	an	article	and	want	to	save	it	for	later,	choose	File	>	Save	Story.	To	view	the
article	later,	click	Saved	Stories	near	the	top	of	the	sidebar.	You	can	access	articles	from	any	of	your
devices	when	you	sign	in	with	the	same	Apple	ID.

Shared	with	You.	When	friends	in	your	contacts	share	stories	with	you	in	Messages,	they
automatically	appear	in	the	new	Shared	with	You	section	in	the	Today	feed	and	in	the	sidebar	of
Apple	News.	Stories	found	in	News	and	Safari	appear	in	Shared	with	You	in	both	apps—so	you	can
enjoy	them	in	either	place.

Use	Quick	Note	to	save	and	organize	articles.	If	youʼre	doing	research	for	a	project	or	upcoming
vacation,	you	can	add	a	Quick	Note	to	a	news	story	and	tag	it	to	save	it	for	later.	In	News,	press	Fn-Q
or	use	a	specified	Hot	Corner	to	open	Quick	Note	and	save	the	article	link.	You	can	find	the	Quick
Note	later	in	the	sidebar	of	the	Notes	app.

Learn	more.	See	the	Apple	News	User	Guide.

Notes
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Notes	are	more	than	just	text.	Jot	down	quick	thoughts,	or	add	checklists,	images,	web	links,	and
more.	Add	a	Quick	Note	from	anywhere—in	apps	or	webpages,	on	your	Desktop,	or	in	full	screen	or
Split	View	mode.	Create	and	use	tags	to	organize	your	notes	and	make	it	easy	to	search	for	notes	in
the	same	category.	Shared	folders	let	you	share	an	entire	folder	of	notes	with	a	group,	and	everyone
can	participate	and	collaborate.	Add	mentions	(@name)	to	notes	to	alert	someone	to	updated	content
of	interest	to	them.	And	see	all	the	latest	changes	in	the	Activity	view.

Ask	Siri.	Say	something	like:	“Create	a	new	note.”

Add	a	Quick	Note	from	anywhere.	With	new	Quick	Note,	you	can	create	a	note	from	any	app	or
website	on	your	Mac	and	view	it	at	any	time	in	the	new	Quick	Notes	category	in	your	sidebar.	No
matter	what	youʼre	doing	on	your	Mac,	you	can	capture	your	thoughts,	remember	a	location,	or	link	to
a	website	you	want	to	remember,	without	having	to	open	Notes.	When	you	return	to	the	original	app
or	website,	you	see	a	thumbnail	of	your	Quick	Note,	reminding	you	of	useful	information	you	noted
about	that	site	or	app.	Tap	it	to	open	the	Quick	Note.

Easy	to	access.	Use	the	keyboard	shortcut	Fn-Q	or	a	Hot	Corner	that	you	specify	in	System
Preferences	 	>	Desktop	&	Screen	Saver	to	create	a	Quick	Note	wherever	you	are.	In	Safari,	you	can
highlight	text	on	a	webpage,	then	click	Share	 	>	Add	Quick	Note	to	add	the	highlighted	text	to	your
note.

Adjust	the	size	or	position	of	your	Quick	Note	(drag	a	corner	to	resize	the	Quick	Note	or	drag	the	title
bar	to	reposition	it),	so	it	doesnʼt	block	what	youʼre	viewing.

Add	content,	lock	notes,	and	share	them.	Use	the	Notes	toolbar	to	quickly	add	checklists,	photos,
videos,	sketches,	tables,	links,	and	more	to	your	note.	Lock	your	note	with	a	password.	Add
collaborators	to	the	note,	and	send	a	copy	of	the	note	using	Mail,	Messages,	Reminders,	or	AirDrop.



Tip:	When	youʼre	signed	in	with	your	Apple	ID	and	iCloud	is	turned	on	for	Notes,	your	notes	are
kept	up	to	date	on	all	your	devices—so	you	can	create	a	to-do	list	on	your	Mac,	then	check	off	items
on	your	iPhone	while	youʼre	on	the	go.

Add	tags.	Use	tags	anywhere	in	the	body	of	your	note	to	categorize	and	organize	them.	Type	the	#
symbol	followed	by	your	tag	text.	You	can	view	your	tags	in	the	sidebar	to	quickly	jump	to	notes	with
a	specific	tag	or	tags	(for	example,	#vacation	or	#cooking).	Custom	Smart	Folders	automatically
collect	notes	in	one	place	based	on	the	same	tags.

Use	mentions.	Add	mentions	(type	@	followed	by	a	name,	for	example,	@Leslie)	to	connect	directly
with	your	collaborators	on	a	project	or	in	a	social	setting.	Theyʼll	get	an	alert	that	theyʼve	been
mentioned	in	a	note,	and	they	can	jump	right	in	and	participate.

View	a	noteʼs	activity	summary.	See	the	latest	updates	about	whoʼs	been	working	on	a	shared	note
in	the	Activity	view	on	the	right	side	of	the	Notes	window.	Swipe	right	on	note	text	to	view	editor
callouts	showing	highlighted	changes	and	the	date	and	time	the	note	was	edited.



Customize	your	toolbar.	Control-click	anywhere	in	the	tool	bar	to	open	the	Customize	Toolbar
window.	Drag	your	favorite	items	into	the	toolbar	to	make	it	work	for	you.

Use	the	Touch	Bar	on	your	13-inch	MacBook	Pro.	Tap	 	to	create	a	new	note.	Tap	 	to	add	a
checklist	item	to	your	note.

Tap	typing	suggestions	to	add	text.

Tap	 	to	display	text	formatting	buttons	to	align	text	left	or	right	and	apply	bold,	italic,	or	underscore
styles.

Tap	 	to	use	note	paragraph	styles,	like	numbered	lists,	bulleted	lists,	or	headings.

Learn	more.	See	the	Notes	User	Guide.

Numbers
Use	Numbers	to	create	attractive	and	powerful	spreadsheets	on	your	Mac.	More	than	30	Apple-
designed	templates	give	you	a	head	start	creating	budgets,	invoices,	team	rosters,	and	more.
Numbers	can	also	open	and	export	Microsoft	Excel	spreadsheets.

Start	with	a	template—then	add	what	you	want.	Select	the	sample	text	in	the	template,	then	type
new	text.	To	add	images,	drag	a	graphic	file	from	your	Mac	to	the	placeholder	image.
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Get	organized	with	sheets.	Use	multiple	sheets	or	tabs	to	show	different	views	of	your	information.
For	example,	use	one	sheet	for	your	budget,	another	for	a	table,	and	a	third	for	notes.	Click	 	to	add
a	new	sheet.	Drag	a	tab	left	or	right	to	reorder	sheets.

Formulas	are	a	snap.	Get	built-in	help	for	more	than	250	powerful	functions—just	type	the	equal	sign
(=)	in	a	cell,	and	you	see	a	list	of	all	the	functions	and	their	descriptions	in	the	sidebar.	Start	typing	a
formula	to	get	instant	suggestions.

Tip:	To	get	instant	calculations	for	a	series	of	values,	select	the	range	of	cells	containing	the
values.	At	the	bottom	of	the	window	youʼll	see	the	sum,	average,	minimum,	maximum,	and	count	of
the	selected	values.	Click	the	Menu	button	 	at	the	bottom	right	to	see	even	more	options.

Create	pivot	tables.	Create	a	pivot	table	using	a	table	or	range	of	cells	in	a	spreadsheet	as	your
source	data,	then	use	it	to	analyze	any	set	of	data,	quickly	group	and	summarize	values,	and	identify
interesting	patterns	and	trends.	You	can	edit	the	cell	range	of	your	source	data,	add	and	arrange
pivot	table	data,	create	a	snapshot	of	a	pivot	table	that	you	can	copy	to	other	apps,	and	more.

Use	the	Touch	Bar	with	your	13-inch	MacBook	Pro.	Tap	Format,	Autofill,	or	Formula	to	display	the
options	shown	below.	Tap	text	style	and	format	buttons	to	display	more	options	for	choosing	color,
justification,	wrapping,	and	top/bottom	alignment	for	text.



Tap	Format	to	display	these	text	formatting	buttons:

Tap	Autofill	to	display	these	autofill	options:

Tap	Formula	to	display	the	quick	formula	buttons:

Learn	more.	See	the	Numbers	User	Guide.

Pages
Use	the	Pages	app	to	create	stunning,	media-rich	documents	and	books	on	your	Mac.	Open	and	edit
Microsoft	Word	files,	and	track	changes	made	by	yourself	and	others.

Look	good!	Pages	includes	professional,	ready-to-use	templates	for	books,	newsletters,	reports,
résumés,	and	more,	making	it	easy	to	start	your	project.
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All	your	formatting	tools,	in	one	place.	Click	the	Format	button	 	in	the	toolbar	to	open	the	Format
inspector.	Select	something	in	your	document,	and	the	formatting	options	for	it	appear.

Flow	text	around	graphics.	When	you	add	an	image	to	a	text	document,	the	text	flows	automatically
around	the	image.	You	can	fine-tune	how	the	text	wraps	in	the	Format	sidebar.

Become	a	publisher.	Pages	comes	with	book	templates	that	let	you	create	interactive	books	in	EPUB
format.	Add	text	and	images—and	even	a	table	of	contents.	When	youʼre	ready,	you	can	make	your
book	available	for	purchase	or	download	in	Apple	Books.

Start	on	your	Mac,	finish	on	iPad.	You	can	keep	documents	up	to	date	across	all	your	devices	when
you	sign	in	with	the	same	Apple	ID.	So	you	can	start	composing	on	one	device,	and	pick	up	where	you
left	off	on	another.

Translate	in	a	snap.	Select	the	text	you	want	to	translate,	Control-click	the	selected	text,	choose
Translate,	then	choose	a	language.	To	translate	text	youʼve	typed,	click	“Replace	with	Translation.”
You	can	also	download	languages	so	you	can	work	offline—go	to	the	Language	&	Region	pane	of
System	Preferences,	then	click	the	Translation	Languages	button	at	the	bottom.	Not	all	languages	are
available.	See	Translate	on	Mac	in	the	macOS	User	Guide.

Tip:	Turn	on	change	tracking	to	see	the	changes	you	and	others	make	to	a	document.	Each
personʼs	edits	and	comments	are	color-coded,	so	you	can	see	who	made	each	change.	Choose	Edit	>
Track	Changes	to	show	the	change	tracking	toolbar.

Use	the	Touch	Bar	with	your	13-inch	MacBook	Pro.	Tap	to	change	the	paragraph	style,	and	to	add
typing	suggestions.	Tap	 	to	see	more	formatting	options.

Tap	to	choose	text	color,	style	options	(bold,	italic,	and	so	on),	line	spacing,	and	bullet	and	list
formats.	Tap	 	to	return	to	typing	suggestions.
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Tap	the	style	(for	example,	Body)	to	see	other	paragraph	formatting	options,	like	Title,	Subtitle,	and
Heading.	Tap	 	when	you	finish.

Learn	more.	See	the	Pages	User	Guide.

Photos
Use	Photos	and	iCloud	Photos	to	organize,	edit,	and	share	your	photos	and	videos,	and	keep	your
photo	library	up	to	date	on	all	your	devices.	Photos	showcases	your	best	shots,	and	with	more
powerful	search	options,	itʼs	easy	to	find	and	enjoy	your	favorites.	Easy-to-use	editing	tools	let	you
transform	your	photos	and	videos	like	a	pro.

All	your	photos	on	all	your	devices.	With	iCloud	Photos,	you	can	browse,	search,	and	share	all	the
photos	and	videos	from	all	your	devices	that	are	signed	in	with	the	same	Apple	ID.	When	you	take	a
photo	on	your	iPhone,	itʼs	automatically	synced	with	your	other	devices.	And	if	you	edit	photos,	those
edits	appear	on	all	of	your	devices.	To	get	started,	open	System	Preferences,	click	Apple	ID,	click
iCloud,	then	select	Photos.	To	learn	more,	see	the	Apple	Support	article	Set	up	and	use	iCloud
Photos.

Shared	with	You.	When	friends	in	your	Contacts	send	you	photos	in	Messages,	they	automatically
appear	in	your	Photos	app,	in	the	Shared	with	You	section.	Photos	that	youʼre	most	likely	to	care
about,	such	as	events	you	attended,	appear	in	your	library.	When	youʼre	viewing	the	photos	in	the
Photos	app,	you	can	click	the	message	bubble	on	a	photo	to	open	Messages	and	continue	the
conversation.
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Edit	like	a	pro.	Create	standout	photos	and	videos	with	powerful	but	easy-to-use	editing	tools.	Use
the	editing	buttons	above	your	photo	or	video	to	improve	it	with	just	a	click.	For	more	powerful	editing
tools,	click	Edit,	then	use	Smart	Sliders	to	get	professional	results.	You	can	add	filters,	rotate,
increase	exposure,	and	crop	both	photos	and	videos.

Interact	with	text.	Live	Text	recognizes	text	in	images	on	your	computer	and	on	the	web.	You	can
copy	text	from	a	photo	to	paste	into	any	file	on	Mac,	or	click	a	phone	number	or	website	in	the	image
to	call	the	number	or	open	the	website.	To	translate	text,	select	the	text,	Control-click	it,	then	click
Translate.	Not	all	languages	are	available.	See	Translate	on	Mac	in	the	macOS	User	Guide.

Relive	meaningful	moments.	Photos	highlights	important	moments	like	birthdays,	anniversaries,	and
trips.	Your	photo	library	comes	to	life	with	Live	Photos	and	videos	that	begin	playing	as	you	scroll.
Click	Memories	in	the	sidebar	to	have	Photos	create	a	memorable	movie—complete	with	music,	titles,
moods,	and	transitions—that	you	can	personalize	and	share.	Your	Memories	are	available	on	all	your
other	devices	that	use	iCloud	Photos.

Find	what	youʼre	looking	for.	Photos	showcases	the	best	shots	in	your	library	and	hides	duplicates,
receipts,	and	screenshots.	Click	the	buttons	at	the	top	of	the	Photos	window	to	view	photos	by	year,
month,	or	day—or	click	All	Photos	to	quickly	view	your	entire	collection.	Photos	identifies	objects,
scenes,	and	people	in	your	photos	and	videos	so	you	can	search	your	photos	based	on	whatʼs	in
them,	the	date	they	were	taken,	people	youʼve	named	in	them,	captions	you	added,	and	their	location
—if	provided.	You	can	also	use	Spotlight	and	Siri	to	search	for	photos.

Ask	Siri.	Say	something	like:	“Show	me	photos	of	Ursula.”
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People,	places,	and	things.	Visual	Lookup	recognizes	many	objects	in	your	photos.	Swipe	up	on	a
photo	or	click	the	information	button	on	a	photo	to	highlight	recognized	objects	and	scenes.	Learn
more	about	popular	art	and	landmarks	around	the	world,	plants	and	flowers,	books,	and	breeds	of
pets.	To	have	photos	of	people	important	to	you	always	appear	at	the	top	of	the	People	album,	click
the	Favorites	button	 	that	appears	on	their	photo.	Use	the	Places	album	to	view	all	your	photos	with
location	data	on	an	interactive	map.	Zoom	in	on	the	map	to	reveal	more	photos	from	a	specific
location.

Tip:	You	can	add	location	info	to	any	photo.	While	viewing	the	photo,	click	the	Information	button	
,	click	Assign	a	Location,	and	start	typing.	Choose	a	location	from	the	list,	or	type	the	location	and

press	Return.

Get	creative	with	Live	Photos.	With	Live	Photos,	use	the	Loop	effect	to	continuously	loop	the	action,
or	use	Bounce	to	play	the	animation	forward	and	backward.	For	a	professional	DSLR	look,	use	Long
Exposure	to	blur	motion	in	your	Live	Photos	and	turn	an	ordinary	waterfall	or	flowing	stream	into	a
work	of	art.

Use	the	Touch	Bar	with	your	13-inch	MacBook	Pro.	The	Touch	Bar	displays	a	scrubber	with	all	the
photos	and	videos	in	your	library,	which	you	can	use	to	speed	your	search	for	just	the	right	photo.
You	can	tap	to	mark	a	selected	photo	as	a	favorite	 ,	rotate	it	 ,	or	add	it	to	a	new	or	existing	album.

When	you	edit	a	photo,	tap	buttons	to	crop,	apply	filters,	adjust	light,	color,	and	other	settings,	or
retouch	your	selection.	Use	additional	options,	such	as	enhance	 ,	compare	 ,	and	more,
depending	on	your	selection	in	the	previous	Touch	Bar.



Learn	more.	See	the	Photos	User	Guide.

Podcasts
Use	Apple	Podcasts	to	browse,	subscribe,	and	listen	to	favorite	podcasts	on	your	Mac.	Personal
recommendations	help	you	discover	new	podcasts	grouped	by	topics	you	care	about.

Get	started	with	Listen	Now.	See	new	episodes	for	the	podcasts	youʼre	subscribed	to,	as	well	as
personalized	recommendations	for	podcasts	you	might	be	interested	in,	all	in	one	place.	When	youʼre
signed	in	with	your	Apple	ID,	any	podcasts	youʼre	still	listening	to	are	saved	in	Listen	Now,	even	if	you
started	listening	on	another	device.

Ask	Siri.	Say	something	like:	“Continue	playing	the	last	podcast”	or	“Follow	this	podcast.”

Discover	new	podcasts.	Find	topic-	and	show-based	suggestions	for	new	podcasts	in	Listen	Now,	or
see	which	shows	are	trending	in	Top	Charts.	If	you	see	a	show	you	like,	subscribe	to	the	podcast	or
add	an	episode	to	your	library	for	later.	Youʼll	get	suggestions	for	similar	topics	and	shows	based	on
what	you	enjoy	and	see	the	recommendations	your	friends	make	in	Shared	with	You.

Shared	with	You.	When	friends	in	your	Contacts	share	podcasts	with	you	in	Messages,	the	episodes
automatically	appear	in	the	new	Shared	with	You	section	of	Listen	Now	in	Apple	Podcasts.

Save	episodes	to	your	library.	To	save	a	single	episode	to	your	library,	click	 .	To	keep	up	with	new
episodes	for	an	entire	podcast,	click	Subscribe.	To	download	a	podcast	for	offline	listening,	click	 .

Search	by	host	or	guest.	When	you	search	for	a	specific	topic	or	person,	you	can	see	results	for
shows	they	host,	shows	that	theyʼre	a	guest	on,	and	even	shows	where	theyʼre	mentioned	or
discussed.
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Save	ideas	with	Quick	Note.	Want	to	remember	a	podcast	for	your	next	road	trip	or	to	listen	to	while
working	out?	Just	create	a	Quick	Note	to	save	the	information	so	you	can	easily	find	it	later.	In
Podcasts,	press	Fn-Q	or	use	a	specified	Hot	Corner	to	open	Quick	Note	and	save	the	podcast	link.
You	can	find	the	Quick	Note	later	in	the	sidebar	of	the	Notes	app.

Tip:	You	can	use	AirPlay	to	play	a	podcast,	music,	or	radio	through	an	external	speaker.	Click	the
Control	Center	icon	 	in	the	menu	bar,	click	Screen	Mirroring,	then	select	an	available	speaker.

Use	the	Touch	Bar	with	your	13-inch	MacBook	Pro.	When	you	listen	to	a	podcast,	use	the	Touch
Bar	to	pause	or	resume	playing,	or	move	forward	or	back	by	sliding	the	marker	on	the	scrubber	bar.

Learn	more.	See	the	Apple	Podcasts	User	Guide.

Preview
Use	the	Preview	app	to	view	and	make	changes	to	PDFs	and	images,	fill	out	and	sign	forms	online,
annotate	PDFs,	convert	graphic	file	types,	batch	edit	files,	password	protect	a	PDF,	highlight	and
translate	text,	and	much	more.
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Fill	in	a	PDF	form.	In	Preview,	click	a	field	in	the	form,	then	type	your	text.	You	can	choose	File	>
Export	to	save	the	form,	open	it	later,	and	continue	to	fill	it	in.

Save	a	PDF	with	a	password.	To	secure	a	PDF,	give	it	a	password	that	users	must	enter	before	they
can	see	the	contents.	In	Preview,	open	the	PDF	you	want	to	save	with	a	password,	choose	File	>
Export,	then	click	Permissions.	Select	Permissions	options,	and	type	a	password	for	Owner	Password.
Retype	it	to	verify,	click	Apply,	then	click	Save.

Tip:	You	can	also	enter	a	new	name	for	the	PDF	before	saving	to	create	a	copy	of	the	password-
secured	PDF	while	keeping	the	original	PDF	unencrypted.

Add	and	remove	PDF	pages.	Open	a	PDF	in	Preview	and	add,	delete,	or	rearrange	pages	in	the	PDF:

Add	a	page:	Select	the	page	you	want	to	appear	before	the	new	page,	choose	Edit	>	Insert,	then
choose	“Page	from	File”	or	“Blank	Page.”	The	new	page	is	inserted	after	the	current	page.

Delete	a	page:	Choose	View	>	Thumbnails	or	View	>	Contact	Sheet,	select	the	page	or	pages	to
delete,	then	press	the	Delete	key	on	your	keyboard	(or	choose	Edit	>	Delete).

Move	pages:	Choose	View	>	Thumbnails	or	View	>	Contact	Sheet,	then	drag	the	pages	to	their
new	location.

Copy	a	page	from	one	PDF	to	another:	In	each	PDF,	choose	View	>	Thumbnails	or	View	>	Contact
Sheet,	then	drag	thumbnail	images	from	one	PDF	to	the	other.

Translate	in	a	snap.	Select	the	text	you	want	to	translate,	Control-click	the	selected	text,	choose
Translate,	then	choose	a	language.	You	can	also	download	languages	so	you	can	work	offline—go	to
the	Language	&	Region	pane	of	System	Preferences,	then	click	the	Translation	Languages	button	at
the	bottom.	Not	all	languages	are	available.	See	Translate	on	Mac	in	the	macOS	User	Guide.
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View	and	convert	image	files.	Preview	can	convert	images	to	many	file	types	including	JPEG,	JPEG
2000,	PDF,	PNG,	PSD,	TIFF,	and	others.	With	the	image	open	in	Preview,	choose	File	>	Export,	click
the	Format	menu,	choose	a	file	type,	type	a	new	name	and	choose	a	location	for	the	file,	then	click
Save.	If	you	donʼt	see	the	option	you	want	in	the	Format	menu,	hold	the	Option	key	while	you	click	the
menu	to	view	specialized	or	older	formats.

Tip:	To	convert	more	than	one	image	file	at	a	time,	open	the	files	in	one	window,	select	them	in
that	windowʼs	sidebar	(press	Command-A	to	select	all),	then	follow	the	steps	above.	You	can	also
batch	resize	image	files	by	selecting	them	all	and	choosing	Tools	>	Adjust	Size.

Learn	more.	See	the	Preview	User	Guide.

Reminders
Reminders	makes	it	easier	than	ever	to	keep	track	of	all	of	your	to-dos.	Create	and	organize
reminders	for	grocery	lists,	projects	at	work,	or	anything	else	you	want	to	track.	You	can	also	choose
when	and	where	to	receive	reminders.	Make	groups	to	assign	shared	tasks	for	a	project.

Add	tags.	Add	tags	to	organize	your	reminders.	Click	one	or	more	tags	in	the	sidebar	to	quickly	filter
reminders.

Create	Custom	Smart	Lists.	Smart	Lists	automatically	sort	your	upcoming	reminders	based	on	dates,
times,	tags,	locations,	flags,	or	priority.	Create	Custom	Smart	Lists	by	selecting	filters.

Use	smart	suggestions.	Reminders	automatically	suggests	dates,	times,	and	locations	for	a	reminder
based	on	similar	reminders	youʼve	created	in	the	past.
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Assign	responsibility.	Assign	reminders	to	people	you	share	lists	with,	so	that	they	receive	a
notification.	Split	up	tasks	and	make	sure	everyone	knows	what	theyʼre	responsible	for.	To	share	a
list,	choose	File	>	Share	List.

Organize	with	subtasks	and	groups.	To	turn	a	reminder	into	a	subtask,	press	Command-],	or	drag	it
on	top	of	another	reminder.	The	parent	reminder	becomes	bold,	and	the	subtask	is	indented
underneath	it.	You	can	collapse	or	expand	your	subtasks	to	keep	your	view	uncluttered.

To	group	reminders	together,	choose	File	>	New	Group.	Name	the	group	whatever	youʼd	like.	Add
more	lists	by	dragging	them	into	the	group,	or	remove	them	by	dragging	them	out.

Get	reminder	suggestions	in	Mail.	When	youʼre	corresponding	with	someone	in	Mail,	you	can	use	Siri
to	recognize	possible	reminders	and	make	suggestions	for	you	to	create	them.

Add	a	reminder	quickly.	Use	natural	language	to	quickly	add	a	reminder.	For	example,	write	“Take
Amy	to	soccer	every	Wednesday	at	5PM”	to	create	a	repeating	reminder	for	that	day	and	time.

Ask	Siri.	Say	something	like:	“Remind	me	to	stop	at	the	grocery	store	when	I	leave	here.”

Use	the	Touch	Bar	with	your	13-inch	MacBook	Pro.	Use	the	Touch	Bar	in	Reminders	to	add	new
items,	check	off	completed	items,	flag	an	item,	or	add	info,	time,	or	location	to	a	reminder.



Learn	more.	See	the	Reminders	User	Guide.

Safari
Safari	is	the	browser	users	love	for	its	performance,	power-efficiency,	and	innovative	privacy
protections.	In	macOS	Monterey,	Safari	includes	redesigned	tabs,	Tab	Groups,	a	toolbar	that	matches
the	color	of	the	site	youʼre	browsing,	and	improved	Intelligent	Tracking	Prevention.	The	tab	bar,
extensions,	and	start	page	are	available	across	Mac,	iPhone,	and	iPad,	so	you	get	the	same	Safari
everywhere	you	browse,	as	long	as	you	sign	in	to	iCloud	with	the	same	Apple	ID.

Start	searching.	Start	typing	a	word	or	website	address—Safari	shows	you	matching	websites,	as
well	as	suggested	websites.	Or	select	a	favorite	or	frequently	visited	item	from	your	Safari	start	page.
When	you	already	have	a	site	open,	you	can	type	your	search	criteria	in	the	active	tab	to	launch	a	new
search.

Customize	your	Safari	start	page.	Your	start	page	can	show	Favorites,	Reading	List	items,	a	privacy
report,	and	more.	You	can	import	a	photo	of	your	own	to	use	as	a	background	image,	or	choose	one
of	the	provided	backgrounds.	Share	your	start	page	across	devices.	To	set	options	for	the	start	page,
click	 	in	the	bottom	right	of	the	start	page.

View	multiple	webpages	in	one	window.	Click	 	at	the	far	right	of	the	tab	bar	or	press	Command-T
to	open	a	new	tab,	then	enter	an	address.	Tabs	resize	dynamically	as	you	change	the	window	size.
Tabs	also	pick	up	the	background	color	of	your	website.
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See	tab	contents	quickly.	Favicons—icons	or	logos	associated	with	a	website—on	tabs	let	you
identify	a	webpage	at	a	glance.	Hold	the	pointer	over	a	tab	to	see	a	preview	of	the	webpage	contents.

View	the	sidebar.	Click	the	Sidebar	icon	 	to	view	the	sidebar,	where	you	can	manage	your	Tab
Groups,	bookmarks,	Reading	List,	and	Shared	with	You	links.

Organize	with	Tab	Groups.	When	youʼre	doing	research	for	a	project	or	vacation,	you	can	open
several	tabs,	then	save	and	organize	them	in	groups.	When	the	sidebar	 	is	open,	click	the	Add	Tab
Group	icon	 	and	choose	New	Tab	Group	to	create	a	group	from	the	tabs	already	open.	Or	choose
New	Empty	Tab	Group	and	search	for	tabs	to	add	to	a	Tab	Group.	The	Tab	Groups	are	saved	and
visible	in	the	sidebar.	Switch	between	Tab	Groups	using	the	sidebar	or	the	pop-up	menu	 	if	the
sidebar	is	hidden.

Note:	Tab	Groups	are	available	across	devices	that	are	logged	into	iCloud	with	the	same	Apple	ID,	so
you	have	access	to	your	tabs	from	anywhere.



Shared	with	You.	When	friends	in	your	Contacts	share	interesting	articles,	recipes,	and	other	links
with	you	in	Messages,	they	automatically	appear	in	the	Shared	with	You	section	on	the	Safari	start
page	and	in	the	sidebar.	Stories	found	in	both	Safari	and	News	appear	in	the	sidebars	of	both	apps,
so	you	can	read	them	where	itʼs	most	convenient.

Discover	extensions.	Extensions	add	functionality	to	Safari	to	personalize	your	browsing	experience.
You	can	find	extensions	that	block	ads,	find	coupons,	fix	your	grammar,	and	quickly	save	content
from	your	favorite	websites.	Choose	Safari	>	Safari	Extensions	to	view	the	extensions	category	in	the
App	Store,	which	features	spotlighted	Safari	extensions	and	categories	(Browse	Better,	Read	with
Ease,	Top	Free	Apps,	and	so	on).	After	you	get	extensions,	turn	them	on	in	Safari	Preferences.	Select
the	Extensions	tab,	then	click	checkboxes	to	turn	on	extensions.

Make	notes	on	a	webpage.	Highlight	and	make	notes	directly	on	a	webpage	with	Quick	Note,	so	your
notes	will	be	saved	for	the	next	time	you	visit.	Click	the	Share	button	 	for	the	webpage	and	choose
Add	Quick	Note.	Open	and	view	saved	quick	notes	from	the	Notes	sidebar	or	return	to	the	webpage
and	tap	the	thumbnail	of	the	saved	note	to	open	it.

Browse	the	web	safely	and	privately.	Safari	automatically	upgrades	the	sites	you	visit	to	HTTPS,	and
warns	you	when	you	visit	a	website	thatʼs	not	secure,	or	that	may	be	trying	to	trick	you	into	sharing
your	personal	data.	It	also	protects	you	from	cross-site	tracking,	by	identifying	and	removing	the	data
that	trackers	leave	behind.	Safari	asks	your	permission	before	letting	a	social	network	see	what
youʼre	doing	on	third-party	sites.	And	Safari	defends	you	against	web	tracking	by	making	your	Mac
harder	to	identify.	Intelligent	Tracking	Prevention	prevents	trackers	from	profiling	you	using	your	IP
address.



Hide	your	email	address.	With	an	iCloud+	subscription,	you	can	create	a	unique,	random	email
address	any	time	you	need	one	(for	example,	when	completing	a	form	on	a	website),	with	no	limit	to
the	number	of	addresses	you	can	use.	When	you	create	a	Hide	My	Email	address	for	a	site,	any	email
sent	to	that	address	gets	forwarded	to	your	personal	email	account.	You	can	receive	email	without
having	to	share	your	actual	email	address,	and	you	can	disable	a	Hide	My	Email	address	at	any	time.
See	Create	unique,	random	email	addresses	with	Hide	My	Email	in	iCloud+.

Use	strong	passwords.	When	you	sign	up	for	a	new	account	on	the	web,	Safari	automatically	creates
and	autofills	a	new	strong	password	for	you.	If	you	choose	Use	Strong	Password,	the	password	is
saved	to	your	iCloud	Keychain	and	will	autofill	on	all	the	devices	you	log	in	to	with	the	same	Apple	ID.
Safari	securely	monitors	your	passwords,	identifying	any	saved	password	that	may	have	been
involved	in	a	published	data	breach	and	making	it	easy	to	upgrade	to	“Sign	in	with	Apple”	accounts
when	available.	(See	Use	Sign	in	with	Apple	on	Mac	in	the	macOS	User	Guide.)

View	a	privacy	report.	To	better	understand	how	a	site	treats	your	privacy,	click	the	Privacy	Report
button	 	to	the	left	of	the	active	tab	to	view	the	cross-site	trackers	that	Safari	is	blocking	on	each
website.	Click	 	to	see	a	privacy	report	with	more	details	about	the	websiteʼs	active	trackers.

Translate	webpages.	You	can	instantly	translate	entire	webpages	in	Safari.	When	you	encounter	a
page	that	Safari	can	translate,	you	see	a	translate	button	 	in	the	website	address	field.	Click	to
translate	between	any	of	the	following	languages:	English,	Spanish,	Chinese	(Simplified),	Chinese
(Traditional),	French,	German,	Italian,	Russian,	Brazilian	Portuguese,	Arabic,	Italian,	Korean,	and
Japanese.	The	button	changes	color	 	to	show	when	a	webpage	has	been	translated.

Note:	Translation	features	are	not	available	in	all	regions	or	languages.

Tip:	In	a	webpage,	force	click	a	word	to	see	its	definition,	or	a	Wikipedia	article	if	one	is	available.
Try	force	clicking	text	in	other	apps,	like	Messages	or	Mail,	to	get	more	info.

Use	the	Touch	Bar	with	your	13-inch	MacBook	Pro.	Tap	the	left	or	right	arrow	button	in	the	Touch
Bar	to	go	backward	or	forward.	Tap	 	to	open	a	new	tab.

Tap	the	tab	scrubber	in	the	Touch	Bar	to	move	between	open	tabs.

Tap	the	Search	field	 	in	the	Touch	Bar,	then	tap	a	favorite	to	open	it.	When	you	finish,	tap	 	to
return	to	the	Touch	Bar	you	started	with.

Customize	the	Touch	Bar	to	add	your	favorite	controls	(choose	View	>	Customize	Touch	Bar).
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See	Customize	the	Touch	Bar	on	the	13-inch	MacBook	Pro.

Learn	more.	See	the	Safari	User	Guide.

Shortcuts
The	Shortcuts	app	lets	you	quickly	perform	multi-step	tasks	with	just	a	click	or	by	activating	Siri.
Create	shortcuts	to	get	directions	to	the	next	event	in	your	Calendar,	move	text	from	one	app	to
another,	and	more.	Choose	ready-made	shortcuts	from	the	Shortcuts	Gallery	or	build	your	own	using
different	apps	to	run	multiple	steps	in	a	task.

A	gallery	of	possibilities.	Browse	or	search	for	shortcuts	in	the	Gallery.	Starter	shortcuts	are
available	for	a	range	of	common	tasks	grouped	in	collections.	The	shortcuts	you	create,	and	any
ready-made	shortcuts	you	choose	or	edit,	are	shown	in	My	Shortcuts	in	the	Gallery	sidebar.	To	show
or	hide	the	Gallery	sidebar,	click	the	Sidebar	button	 .
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Build	custom	shortcuts.	Create	a	new	shortcut,	then	drag	actions	from	the	list	on	the	right	to	the
shortcut	editor	on	the	left	to	produce	the	result	you	want.	Actions	are	the	building	blocks	of	a
shortcut,	like	steps	in	a	task.	Choose	from	a	wide	range	of	actions,	such	as	getting	the	latest	Photo
from	the	Photos	app,	creating	a	folder,	or	copying	the	current	URL	from	Safari.	You	can	also	use
actions	that	run	a	script,	such	as	rounding	a	number,	setting	airplane	mode,	and	doing	calculations.
Shortcuts	also	provides	“next	action”	suggestions	to	help	you	complete	your	shortcut.

Shortcuts	to	your	shortcuts.	Using	Siri	to	run	a	shortcut	is	the	quickest	way	to	get	something	done.
You	can	also	add	shortcuts	to	the	Dock,	the	menu	bar,	and	the	Services	menu	of	apps.	Double-click	a
shortcut,	click	Shortcut	Details	 ,	then	choose	options	under	Use	as	Quick	Action.

Ask	Siri.	Say	something	like:	“Text	last	image.”

Sync	and	share	shortcuts.	Sign	in	to	all	your	devices	with	the	same	Apple	ID	and	your	shortcuts
appear	on	all	of	them.	Edits	you	make	on	one	device	are	automatically	reflected	on	your	other
devices.	You	can	also	share	your	shortcuts	with	others	and	receive	shared	shortcuts	from	someone
else.	To	share,	double-click	the	shortcut,	click	 ,	then	choose	how	you	want	to	share	it.

Learn	more.	See	the	Shortcuts	User	Guide.

Stocks
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The	Stocks	app	is	the	best	way	to	track	the	market	on	your	Mac.	View	prices	in	the	custom	watchlist,
click	a	stock	to	see	more	details	and	an	interactive	chart,	and	read	about	whatʼs	driving	the	market,
with	stories	from	Apple	News.

Note:	Apple	News	stories	and	Top	Stories	are	available	in	the	U.S.,	Canada,	the	UK,	and	Australia.
News	stories	in	other	countries	and	regions	are	provided	by	Yahoo.

Customize	your	watchlist.	To	add	a	stock	to	your	watchlist,	enter	a	company	name	or	stock	symbol
in	the	Search	field.	In	the	search	results,	double-click	the	stock	symbol	to	view	stock	information.	To
add	the	stock	to	your	watchlist,	click	the	Add	to	Watchlist	button	in	the	top-right	corner.	To	remove	a
stock,	Control-click	the	stock	symbol	and	choose	“Remove	from	Watchlist.”	You	can	also	Control-
click	a	stock	in	your	watchlist	to	open	it	in	a	new	tab	or	window.

Check	market	changes.	While	viewing	your	watchlist,	click	the	green	or	red	button	below	each	price
to	cycle	among	price	change,	percentage	change,	and	market	capitalization.	The	watchlist	also
includes	color-coded	sparklines	that	track	performance	throughout	the	day.

Read	articles	related	to	the	companies	you	follow.	Click	a	stock	in	your	watchlist	to	see	an
interactive	chart	and	additional	details,	and	read	the	latest	news	about	that	company.	Click	Business
News	at	the	top	of	the	watchlist	to	see	a	collection	of	timely	business	articles,	curated	by	Apple
News.



Get	a	deeper	view.	Want	to	see	what	the	market	was	doing	last	week,	last	month,	or	last	year?	Click
the	buttons	above	the	chart	to	switch	timeframes	and	see	prices	in	the	view	you	like	best.

Your	watchlist	on	all	your	devices.	Keep	your	watchlist	consistent	across	all	your	devices	when	you
sign	in	with	the	same	Apple	ID.

Tip:	For	a	quick	look	at	the	stock	market,	check	the	Stocks	widget	in	Notification	Center	on	your
Mac.

Learn	more.	See	the	Stocks	User	Guide.

TV
Watch	all	your	movies	and	TV	shows	in	the	Apple	TV	app.	Buy	or	rent	movies	and	TV	shows,
subscribe	to	channels,	and	pick	up	where	you	left	off	watching	from	any	of	your	devices.

Get	started	with	Watch	Now.	In	Watch	Now,	browse	a	curated	feed	of	recommendations,	based	on
channels	youʼre	subscribed	to	and	movies	or	TV	shows	youʼve	watched.
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Watch	Wolfwalkers	on	the	Apple	TV	app

Keep	watching	in	Up	Next.	In	Up	Next,	youʼll	find	movies	or	TV	shows	youʼre	watching,	as	well	as
movies	and	TV	shows	youʼve	added	to	your	queue.	To	add	a	new	movie	or	TV	show	to	Up	Next,	click
the	Add	to	Up	Next	button.

Discover	more	in	Movies,	TV	Shows,	and	Kids.	If	youʼre	looking	for	something	specific,	click	the
Movies,	TV	Shows,	or	Kids	tab	in	the	menu	bar,	then	browse	by	genre.

Buy,	rent,	or	subscribe.	When	you	find	a	movie	or	TV	show	you	want	to	watch,	you	can	choose	to
buy	or	rent	it.	Channels	youʼve	subscribed	to	are	available	on	all	devices,	and	can	be	used	by	up	to	six
family	members	through	Family	Sharing.

See	what	your	friends	are	sharing.	When	your	friends	and	family	use	the	Messages	app	to	share
shows	and	movies	with	you,	you	can	watch	them	when	itʼs	convenient	for	you.	Just	look	for	them	in
the	Apple	TV	app—in	a	new	section	in	Watch	Now,	called	Shared	With	You.	Content	only	appears	in
Shared	with	You	if	the	person	who	sent	it	is	in	your	Contacts.	See	New	features	on	your	MacBook	Pro.

Choose	something	from	your	own	library.	Click	Library	to	see	all	the	movies	and	TV	shows	youʼve
purchased	or	downloaded,	organized	by	genre.	To	start	watching,	just	click	the	movie	or	TV	show.

Use	the	Touch	Bar	with	your	13-inch	MacBook	Pro.	Use	the	Touch	Bar	to	rewind,	pause,	or	fast-
forward	whatʼs	playing.	Thereʼs	also	a	scrubber	bar	for	navigating	within	a	TV	show	or	movie	and	a
subtitles	button.

Learn	more.	See	the	Apple	TV	App	User	Guide.

https://tv.apple.com/us/movie/wolfwalkers/umc.cmc.amuoq00hqelfi98j0gvg641x
https://support.apple.com/guide/tvapp-mac/welcome


Voice	Memos
Voice	Memos	makes	it	easier	than	ever	to	capture	personal	reminders,	class	lectures,	and	even
interviews	or	song	ideas.	With	iCloud,	you	can	access	the	voice	memos	you	record	with	your	iPhone,
right	on	your	MacBook	Pro.

Record	from	your	MacBook	Pro.	Click	the	Record	button	 	to	start	recording,	then	click	Done	to
stop.	You	can	rename	a	recording	to	make	it	easier	to	identify.	Click	the	default	name,	then	enter	a
new	name.	To	play	back	your	recording,	click	the	Play	button	 .

Your	voice	memos	across	all	your	devices.	Your	voice	memos	are	available	on	all	your	devices	when
you	sign	in	with	the	same	Apple	ID.	You	can	access	recordings	you	made	with	your	iPhone	or	iPad
right	from	your	Mac.

Organize	with	folders.	Create	folders	to	help	you	keep	your	Voice	Memos	organized.	To	add	a	folder,
click	the	Sidebar	button	 ,	then	click	the	New	Folder	button	at	the	bottom	of	the	sidebar.	Enter	a
name	for	the	folder,	then	click	Save.	To	add	a	recording	to	the	folder,	press	and	hold	the	Option	key
while	you	drag	the	recording	to	the	folder.



Mark	a	recording	as	a	favorite.	Select	a	recording,	then	click	the	Favorite	button	 	in	the	toolbar	so
you	can	quickly	find	the	recording	later.	Click	the	Sidebar	button	 	to	see	all	your	favorites.

Skip	silence.	Skip	over	gaps	in	your	audio.	Click	the	Playback	Settings	button	at	the	top	of	the	Voice
Memos	window	and	turn	on	Skip	Silence.

Change	the	playback	speed.	Speed	up	or	slow	down	your	audio.	Click	the	Playback	Settings	button
at	the	top	of	the	Voice	Memos	window,	then	drag	the	slider	left	or	right.

Enhance	a	recording.	Improve	the	sound	quality	of	your	Voice	Memos	by	reducing	background	noise
and	room	reverberation.	Click	the	Playback	Settings	button	at	the	top	of	the	Voice	Memos	window
and	turn	on	Enhance	Recording.

Use	the	Touch	Bar	with	your	13-inch	MacBook	Pro.	Use	the	Touch	Bar	to	record,	pause,	or	play
your	voice	memo.

Learn	more.	See	the	Voice	Memos	User	Guide.

https://support.apple.com/guide/voice-memos/welcome/mac/


Find	answers

Use	the	macOS	User	Guide
The	macOS	User	Guide	has	a	lot	more	information	about	how	to	use	your	MacBook	Pro.

Get	help.	Click	the	Finder	icon	 	in	the	Dock,	then	click	the	Help	menu	in	the	menu	bar	and	choose
macOS	Help	to	open	the	macOS	User	Guide.	Or	type	a	question	or	term	in	the	search	field,	then
choose	a	topic	from	the	results	list.

Explore	topics.	To	find	a	topic	in	the	macOS	User	Guide,	you	can	browse	or	search.	To	browse,	click
“Table	of	Contents”	to	see	the	list	of	topics,	then	click	a	topic	to	read	it.	Or	type	what	you	want	to
find	in	the	search	field	to	go	right	to	your	answer.



Find	out	whatʼs	new.	Click	the	Help	menu,	then	choose	“See	Whatʼs	New	in	macOS”	to	find	out	more
about	the	latest	features	of	macOS.

Tip:	If	you	canʼt	remember	the	location	of	a	menu	item	in	an	app,	search	for	it	in	Help.	Place	the
pointer	over	the	result,	and	an	arrow	shows	you	the	command.

Learn	more.	See	the	macOS	User	Guide.

Are	you	new	to	Mac?
If	this	is	your	first	Mac	computer,	here	is	some	helpful	information	to	get	you	up	to	speed—especially
if	you	came	from	a	Windows	environment.

Familiarize	yourself	with	the	desktop.	The	desktop	is	where	you	do	your	work,	and	where	you	can
quickly	open	apps,	search,	and	organize	files.

https://support.apple.com/guide/mac-help/welcome/mac


On	the	desktop	youʼll	find:

The	menu	bar:	The	menu	bar	for	the	desktop	or	the	active	open	app	is	always	at	the	top	of	the
screen.	Use	menus	to	find	options	and	perform	tasks	in	apps.	For	information	about	items	in	the
menu	bar,	such	as	the	Apple	menu	and	the	Help	menu,	see	The	desktop,	menu	bar,	and	Help	on
your	Mac.

The	Dock:	The	Dock	is	similar	to	the	taskbar	and	Start	menu	in	Windows	and	appears	at	the
bottom	of	the	desktop	(but	you	can	change	its	location	in	System	Preferences).	The	Dock	makes	it
easy	to	see	all	the	apps	you	have	open	and	quickly	launch	your	favorite	apps.	To	open	an	app,
click	its	icon	in	the	Dock.	You	can	also	open	apps	using	Launchpad.	See	The	Dock	on	your	Mac.

The	Finder:	Click	 	in	the	Dock	to	open	the	Finder,	where	you	organize	and	locate	your	files
(similar	to	File	Explorer	in	Windows).	Use	the	buttons	at	the	top	of	the	Finder	window	to	change
how	you	view	your	files—as	icons	 ,	in	a	list	 ,	in	columns	 ,	or	in	a	gallery	 .	In	any	view,	you
can	select	a	file	and	press	the	Space	bar	to	see	a	Quick	Look	preview	without	opening	the	file.	See
The	Finder	on	your	Mac.

The	Spotlight	menu:	Spotlight	lets	you	search	for	anything	on	your	Mac,	including	documents,
contacts,	email	messages,	and	more.	You	can	also	launch	apps	and	search	on	the	web.	To	open
Spotlight,	click	the	Spotlight	icon	 	at	the	top	right	of	the	screen	or	press	Command-Space	bar.
See	Spotlight	on	your	Mac.

System	Preferences:	System	Preferences	 	is	similar	to	the	Control	Panel	in	Windows.	Customize
your	Mac	with	settings	for	the	desktop,	Dock,	display,	Bluetooth,	network,	and	much	more.	See
System	Preferences	on	your	Mac.



Get	to	know	the	keyboard	and	trackpad.	The	Command	key	 	on	Mac	is	generally	the	same	as	the
Control	key	on	Windows.	For	example,	use	Command-C	and	Command-V	to	copy	and	paste	content.
The	Delete	key	on	Mac	is	the	same	as	the	Backspace	key	on	Windows.	Press	Fn-Delete	to	forward
delete.

Use	the	trackpad	to	click,	right-click,	force	click,	scroll,	swipe,	and	resize	documents	quickly.	See
MacBook	Pro	trackpad	for	details	on	trackpad	gestures.

For	a	list	of	Mac	keyboard	shortcuts	and	differences	between	Mac	and	Windows	keyboards,	see	the
Apple	Support	article	Mac	tips	for	Windows	switchers.	Also	see	Windows	keys	on	a	Mac	keyboard	in
the	macOS	User	Guide.	For	more	shortcuts	in	this	guide,	see	Keyboard	shortcuts	on	your	Mac.

Install	apps.	You	can	download	apps	from	the	App	Store	or	the	internet.	When	you	download	an	app
from	the	internet,	you	get	a	disk	image	file	(ending	in	.dmg)	or	package	file	(.pkg).	To	install	the	app,
locate	the	.dmg	or	.pkg	file	in	your	Downloads	folder,	double-click	it,	then	follow	the	onscreen
instructions.	Youʼre	prompted	to	delete	the	disk	image	or	package	file	after	you	install	the	app.

To	uninstall	an	app,	find	the	app	in	the	Applications	folder	in	Finder,	then	drag	the	app	to	the	Trash.
Some	apps	have	an	Uninstaller,	which	you	can	use	to	delete	the	app	and	other	files	associated	with	it.
See	Install	and	uninstall	apps	in	the	macOS	User	Guide.

Maximize,	minimize,	and	close	windows.	You	can	have	multiple	windows	for	an	app	open	at	a	time.
Use	the	buttons	in	the	top-left	corner	of	a	window	to	resize	and	close	windows.

Click	the	Close	Window	button	 	or	press	Command-W	to	close	the	window,	but	not	the	app.
Press	Option-Command-W	to	close	all	open	windows	for	the	app.	Press	Command-Q	to	quit	the
app.

Click	the	Minimize	Window	button	 	to	minimize	a	window	(or	press	Command-M).	Minimizing	a
window	leaves	the	app	open	but	reduces	the	window	to	an	icon	on	the	right	side	of	the	Dock.
Click	the	icon	to	restore	the	window	to	its	previous	size.

Click	the	Full-Screen	Window	button	 	to	open	your	app	full-screen.	To	maximize	the	window,
hold	the	Option	key	and	click	the	button.	Or	hover	on	the	button	to	see	more	options,	such	as
tiling	the	window.	Press	Esc	to	return	the	window	to	its	previous	size.

Move	windows.	Drag	the	window	by	its	title	bar	to	put	it	where	you	want	it.	Some	windows	canʼt	be
moved.	See	Manage	windows	on	Mac	in	the	macOS	User	Guide.

Switch	between	app	windows.	Press	Command-Tab	to	quickly	switch	to	the	previous	app.	When	you
have	several	app	windows	open,	press	and	hold	Command,	then	press	Tab	to	see	icons	for	all	the
open	apps.	While	holding	Command,	press	Tab	(or	the	arrow	keys)	to	move	between	the	apps	and
select	the	one	you	want	to	be	active.	Release	the	Command	key	to	work	in	the	active	app.

Take	a	screenshot.	Press	Command-Shift-5	to	access	the	Screenshot	Utility.	See	Take	a	screenshot
on	your	Mac.
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Let	Siri	do	tasks	for	you.	To	activate	Siri	on	your	14-inch	or	16-inch	MacBook	Pro,	click	the	Siri	icon
at	the	top	right	of	the	screen	or	press	the	Dictation/Siri	key	(F5).	On	your	13-inch	MacBook	Pro,	you
can	tap	the	Siri	button	in	the	Control	Strip	on	the	Touch	Bar	or	press	and	hold	Command-Space	bar.	If
the	option	is	turned	on,	you	can	say	“Hey	Siri”	and	continue	with	your	request.	Ask	Siri	to	open	a
folder,	launch	an	app,	make	the	screen	brighter,	and	other	tasks.	See	Siri	on	your	Mac.

Use	your	Mac	with	iPhone,	iPad,	and	Apple	Watch.	If	you	sign	in	to	your	Apple	devices	with	the
same	Apple	ID,	you	can	easily	share	files	and	photos,	edit	documents,	answer	email	and	calls,	and
send	text	among	devices.	See	Use	your	MacBook	Pro	with	iCloud	and	Continuity.

Learn	more.	See	the	Apple	Support	articles	Whatʼs	it	called	on	my	Mac?	and	Mac	keyboard	shortcuts.

Common	questions	about	your	Mac
How	do	I	get	support	for	my	MacBook	Pro?	Go	to	MacBook	Pro	Support.

Iʼm	new	to	Mac.	Are	there	tips	for	PC	users?	Yes!	See	Are	you	new	to	Mac?	and	the	Apple	Support
article	Mac	tips	for	Windows	switchers.

How	do	I	take	a	screenshot	on	my	Mac?	Press	Command-Shift-3	to	take	a	screenshot	of	the	entire
screen.	Press	Command-Shift-4	to	take	a	screenshot	of	a	selected	area	of	the	screen.	To	learn	more,
see	Take	a	screenshot	on	your	Mac.

Where	is	my	serial	number?	Choose	Apple	menu	 	>	About	This	Mac.	The	serial	number	is	the	last
item	in	the	list.	You	can	also	find	the	serial	number	on	the	bottom	of	your	MacBook	Pro.

How	do	I	know	which	model	of	MacBook	Pro	I	have?	See	the	Apple	Support	article	Identify	your
MacBook	Pro	model.	You	can	also	choose	Apple	menu	 	>	About	This	Mac	to	view	the	model
information.

How	can	I	find	the	documentation	for	my	MacBook	Pro?	To	find	the	MacBook	Pro	Essentials	guide,
choose	Apple	menu	 	>	About	This	Mac,	click	the	Support	tab,	then	click	User	Manual.	From	the
Support	tab,	you	can	also	click	“macOS	Help”	to	open	the	user	guide	for	the	operating	system.	For
older	Mac	models,	see	Browse	manuals	by	product.

How	do	I	get	help	for	an	app?	When	youʼre	using	the	app,	click	the	Help	menu	in	the	menu	bar	at	the
top	of	the	screen.

Where	is	the	safety	information	for	my	MacBook	Pro?	See	Important	safety	information	for	your
Mac.

How	do	I	find	the	technical	specifications?	Go	to	13-inch	MacBook	Pro	Tech	Specs,	or	14-inch	and
16-inch	MacBook	Pro	Tech	Specs,	or	choose	Apple	menu	 	>	About	This	Mac	and	click	the	buttons	at
the	top.

How	do	I	check	my	disk	for	problems?	Use	Disk	Utility.	See	Repair	a	storage	device	in	Disk	Utility	on
Mac	in	the	Disk	Utility	User	Guide.
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How	do	I	reinstall	macOS?	Use	macOS	Recovery.	(The	macOS	Recovery	process	for	MacBook	Pro
with	Apple	silicon	is	different	than	the	process	for	other	MacBook	Pro	models.)	See	How	to	reinstall
macOS.

Note:	Beginning	with	macOS	Big	Sur,	Time	Machine	backups	donʼt	include	system	files.	See	Back	up
and	restore	your	Mac.

What	should	I	do	before	selling	or	trading	in	my	Mac?	Back	up	your	data,	then	restore	your	Mac	to
factory	settings.	See	What	to	do	before	you	sell,	give	away,	or	trade	in	your	Mac.

Keyboard	shortcuts	on	your	Mac
You	can	press	key	combinations	to	do	things	on	your	MacBook	Pro	that	youʼd	normally	do	with	a
trackpad,	mouse,	or	other	device.	Hereʼs	a	list	of	commonly	used	keyboard	shortcuts.

Note:	Keyboard	shortcuts	in	apps	may	vary	depending	on	the	language	and	keyboard	layout	youʼre
using	on	your	Mac.	If	the	shortcuts	below	donʼt	work	as	you	expect,	look	in	the	app	menus	in	the
menu	bar	to	see	the	correct	shortcuts.	You	can	also	use	the	keyboard	viewer	to	see	your	current
keyboard	layout,	known	as	an	input	source.	See	Use	the	keyboard	viewer	on	Mac	in	the	macOS	User
Guide.

Shortcut Description

Command-X Cut	the	selected	item	and	copy	it	to	the	Clipboard.

Command-C Copy	the	selected	item	to	the	Clipboard.

Command-V Paste	the	contents	of	the	Clipboard	into	the	current	document	or	app.

Command-Z Undo	the	previous	command.	Press	Command-Shift-Z	to	redo.

Command-A Select	all	items.

Command-F Open	a	Find	window,	or	find	items	in	a	document.

Command-G Find	the	next	occurrence	of	the	item	youʼre	searching	for.	Press
Command-Shift-G	to	find	the	previous	occurrence.

Command-H Hide	the	windows	of	the	front	app.	Press	Command-Option-H	to	view	the
front	app	but	hide	all	other	apps.

Command-M Minimize	the	front	window	to	the	Dock.	Press	Command-Option-M	to
minimize	all	windows	of	the	front	app.

Command-N Open	a	new	document	or	window.

Command-O Open	the	selected	item,	or	open	a	dialog	to	select	a	file	to	open.

Command-P Print	the	current	document.

https://support.apple.com/HT204904
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Command-S Save	the	current	document.

Command-W Close	the	front	window.	Press	Command-Option-W	to	close	all	windows
of	the	app.

Command-Q Quit	the	current	app.

Command-Option-Esc Choose	an	app	to	Force	Quit.

Command-Tab Switch	to	the	next	most	recently	used	app	among	your	open	apps.

Command-Shift-5 Open	the	Screenshot	utility.	You	can	also	take	screenshots	using	the
following	shortcuts:

Press	Command-Shift-3	to	take	a	screenshot	of	the	entire	screen.
Press	Command-Shift-4	to	take	a	screenshot	of	a	selected	area	of	the
screen.
Press	Command-Shift-6	to	capture	the	Touch	Bar	on	the	13-inch
MacBook	Pro.

Shortcut Description

For	more	keyboard	shortcuts,	see	the	Apple	Support	article	Mac	keyboard	shortcuts.

Security	features	on	your	MacBook	Pro
Your	MacBook	Pro	provides	security	features	to	protect	whatʼs	on	your	computer	and	prevent
unauthorized	software	apps	from	loading	during	startup:

Secure	storage:	Your	MacBook	Pro	storage	drive	is	encrypted	with	keys	tied	to	its	hardware	to
provide	advanced	levels	of	security.	In	the	event	of	a	catastrophic	failure,	data	recovery	may	not
be	possible,	so	you	need	to	back	up	your	files	to	an	external	source.	See	Use	macOS	Recovery	on
a	Mac	with	Apple	silicon	in	the	macOS	User	Guide.

You	can	set	up	Time	Machine	or	another	backup	plan	to	regularly	back	up	your	files	on	the
computer.	See	Back	up	your	files	with	Time	Machine	in	the	macOS	User	Guide,	and	the	Apple
Support	article	Back	up	your	Mac	with	Time	Machine.

Secure	boot	and	Startup	Security	Utility:	Support	for	secure	boot	is	turned	on	automatically.	Itʼs
designed	to	verify	that	the	operating	system	software	loaded	on	your	computer	at	startup	is
authorized	by	Apple.

If	your	MacBook	Pro	doesnʼt	start	because	it	detects	an	untrusted	component,	it	will	start	up	from
a	secure	recovery	partition	and	automatically	correct	issues	if	possible.	To	learn	more	about	the
Startup	Security	Utility	or	to	find	out	how	to	set	other	options,	see	the	Apple	Support	article	About
Startup	Security	Utility.
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System	integrity:	The	MacBook	Pro	with	Apple	silicon	is	designed	to	verify	that	the	version	of
macOS	software	loaded	during	startup	is	authorized	by	Apple,	and	continues	behind	the	scenes	to
protect	the	authorizations	established	for	macOS	as	it	runs.	This	makes	it	harder	for	malware	or
malicious	websites	to	exploit	your	Mac.

Data	Protection:	In	addition	to	the	default	storage	drive	encryption	in	MacBook	Pro	with	Apple
silicon,	third-party	app	developers	can	use	file-level	encryption	to	better	protect	sensitive	data,
without	impacting	system	performance.

Note:	In	rare	circumstances,	such	as	a	power	failure	during	a	macOS	upgrade,	your	MacBook	Pro	may
become	unresponsive	and	the	firmware	on	the	chip	may	need	to	be	revived.	See	Revive	or	restore	a
Mac	with	Apple	silicon	with	Apple	Configurator	2	in	the	Apple	Configurator	2	User	Guide.

Learn	more.	See	the	Apple	Platform	Security	User	Guide.

Save	space	on	your	MacBook	Pro
With	Optimize	Storage,	you	can	automatically	free	up	space	on	your	MacBook	Pro	by	making	files
available	on	demand.	Your	oldest	files	will	be	stored	in	iCloud	and	on	your	email	IMAP	or	Exchange
server,	so	you	can	download	them	at	any	time.	There	are	also	tools	to	identify	and	delete	big	files.

Optimize	storage.	To	see	storage	recommendations,	go	to	Apple	menu	 	>	About	This	Mac,	click
Storage,	then	click	Manage.	Youʼll	see	different	recommendations	based	on	how	you	configured	your
Mac.	If	your	Mac	is	low	on	storage,	youʼll	see	an	alert	with	a	link	to	the	Storage	pane.

Set	options	to:

https://support.apple.com/guide/apple-configurator-2/apdd5f3c75ad
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Store	in	iCloud:	Store	all	files,	photos,	and	messages	in	iCloud	and	save	space	on	your	Mac.

Desktop	and	Documents:	Store	all	the	files	from	your	Desktop	and	Documents	folders	in	iCloud
Drive.	When	storage	space	is	needed,	iCloud	Drive	keeps	recently	opened	files	on	your	Mac
and	makes	your	oldest	files	available	on	demand.

Photos:	Store	photos	and	videos	in	iCloud	Photos.	When	storage	spaces	is	needed,	iCloud
Photos	uses	optimized	versions	of	photos	and	video	on	your	Mac	and	makes	the	originals
available	on	demand.

Messages:	Store	all	messages	and	attachments	in	iCloud.	When	storage	space	is	needed,
iCloud	keeps	recent	attachments	on	your	Mac	and	makes	your	oldest	files	available	on
demand.

Even	though	your	files	are	stored	in	the	cloud,	you	can	access	them	right	where	you	left	them	on
your	MacBook	Pro.	See	Access	your	iCloud	content	on	your	Mac.

Optimize	Storage:	Save	space	on	your	Mac	by	optimizing	the	storage	of	movies	and	TV	shows	in
the	Apple	TV	app.	You	can	choose	to	automatically	remove	movies	or	TV	shows	from	your
MacBook	Pro	after	you	watch	them.	You	can	download	them	again	at	any	time.

Empty	Trash	Automatically:	Automatically	erase	items	that	have	been	in	the	Trash	for	more	than
30	days.

Reduce	Clutter:	Easily	identify	large	files,	and	delete	the	files	you	no	longer	need.	To	browse	large
files,	click	through	the	categories	in	the	sidebar—Books,	Documents,	iCloud	Drive,	Mail,
Messages,	Music	Creation,	Photos,	Trash,	and	more.

To	help	you	save	space	as	you	work,	macOS	also:

Prevents	you	from	downloading	the	same	file	twice	from	Safari

Alerts	you	to	remove	installer	software	when	you	finish	installing	a	new	app

Clears	logs	and	caches	that	are	safe	to	remove	when	youʼre	low	on	storage

Learn	more.	See	Optimize	storage	space	on	your	Mac	in	the	System	Information	User	Guide.

Take	a	screenshot	on	your	Mac
Explore	the	Screenshot	menu	to	find	all	the	controls	you	need	to	take	screenshots	and	screen
recordings.	You	can	also	capture	your	voice	during	a	screen	recording.	The	optimized	workflow	lets
you	take	photos	and	videos	of	your	screen,	and	then	easily	share,	edit,	or	save	them.

Access	the	screenshot	controls.	Press	Command-Shift-5.	You	can	capture	the	entire	screen,	a
selected	window,	or	a	portion	of	a	window.	You	can	also	record	the	entire	screen	or	a	selected
portion	of	the	screen.
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Use	the	icons	at	the	bottom	of	the	screen	to	capture	a	selection	 ,	record	your	screen	 ,	and	more.
Click	Options	to	modify	your	save	location,	set	a	timer	before	capturing,	set	microphone	and	audio
options,	or	show	the	pointer.	Click	Capture	or	Record	to	take	the	screenshot	or	video.

After	you	take	a	screenshot	or	video,	a	thumbnail	appears	in	the	corner	of	the	screen.	Drag	the
thumbnail	into	a	document	or	folder,	swipe	to	the	right	to	quickly	save	it,	or	click	to	edit	or	share	it.

Note:	You	can	also	open	the	Screenshot	utility	from	the	Other	folder	in	Launchpad,	or	go	to	the	Apps
>	Utilities	folder	in	the	Finder.

Mark	up	your	screenshot.	Click	the	thumbnail	of	your	screenshot	to	use	Markup	tools	and	make
annotations.	You	can	also	click	Share	 	to	send	your	marked-up	screen	to	colleagues	or	friends—
right	from	the	screenshot	itself.	See	Mark	up	files	on	Mac	in	the	macOS	User	Guide.

Learn	more.	See	Take	screenshots	or	screen	recordings	on	Mac	in	the	macOS	User	Guide.

Mac	resources,	service,	and	support
You	can	find	more	information	about	your	MacBook	Pro	in	System	Report,	in	Apple	Diagnostics,	and
through	online	resources.

System	Report.	To	get	information	about	your	MacBook	Pro,	use	System	Report.	It	shows	you	what
hardware	and	software	is	installed,	the	serial	number	and	operating	system	version,	how	much
memory	is	installed,	and	more.	To	open	System	Report,	choose	Apple	menu	 	>	About	This	Mac,	then
click	System	Report.

Apple	Diagnostics.	You	can	use	Apple	Diagnostics	to	help	determine	if	thereʼs	a	problem	with	one	of
the	computerʼs	components,	such	as	the	memory	or	processor.	Apple	Diagnostics	helps	to	identify
the	potential	source	of	a	hardware	issue	and	provides	first	steps	to	try	and	resolve	it.	Apple
Diagnostics	will	also	help	you	get	in	touch	with	AppleCare	Support	if	you	need	more	help.

https://support.apple.com/guide/mac-help/mchl1fd88863/mac
https://support.apple.com/guide/mac-help/mh26782/


Before	using	Apple	Diagnostics,	disconnect	any	external	devices,	such	as	a	hard	disk	or	external
display.	Be	sure	the	MacBook	Pro	is	connected	to	the	internet.

To	start	Apple	Diagnostics	on	MacBook	Pro	with	Apple	silicon,	restart	the	computer,	press	and	hold
the	power	button	for	10	seconds	to	open	Startup	Options,	then	hold	Command-D	to	enter	Diagnostics
mode.	To	start	Apple	Diagnostics	on	other	MacBook	Pro	models,	restart	the	computer	and	hold	down
the	D	key	as	it	starts	up.

If	prompted,	select	the	language	for	your	location.	Press	the	Return	key	or	click	the	right	arrow
button.	The	basic	Apple	Diagnostics	test	takes	a	few	minutes	to	complete.	If	an	issue	is	found,	a
description	of	the	issue	appears	with	additional	instructions.	Make	a	note	of	any	reference	codes
before	you	exit	Apple	Diagnostics,	in	case	you	need	to	contact	AppleCare	support.

Online	resources.	For	online	service	and	support	information,	go	to	Welcome	to	Apple	Support.	You
can	learn	about	Apple	products,	view	online	manuals,	check	for	software	updates,	connect	with	other
Apple	users,	and	get	service,	support,	and	professional	advice	from	Apple.	For	more	information
about	your	MacBook	Pro,	go	to	MacBook	Pro	Support.

AppleCare	support.	If	you	need	assistance,	AppleCare	representatives	can	help	you	with	installing
and	opening	apps,	and	with	troubleshooting.	Call	the	support	center	number	nearest	you	(the	first	90
days	are	complimentary).	Have	the	purchase	date	and	your	MacBook	Pro	serial	number	ready	when
you	call.

A	complete	list	of	support	telephone	numbers	is	available	on	the	web	at	Contact	Apple	for	support
and	service.	Telephone	numbers	are	subject	to	change,	and	local	and	national	telephone	rates	may
apply.

Your	90	days	of	complimentary	telephone	support	begins	on	the	date	of	purchase.

https://www.apple.com/support
https://support.apple.com/mac/macbook-pro
https://support.apple.com/HT201232


Safety,	handling,	and	regulatory	information

Important	safety	information	for	your	Mac
WARNING:	Failure	to	follow	these	safety	instructions	could	result	in	fire,	electric	shock,	or	other

injuries,	or	damage	to	your	MacBook	Pro,	cables,	or	other	property.	Read	all	safety	information	below
before	using	your	MacBook	Pro.

Built-in	battery.	Donʼt	attempt	to	replace	or	remove	the	battery	yourself—you	may	damage	the
battery,	which	could	cause	overheating	and	injury.	The	built-in	battery	should	be	replaced	by	Apple	or
an	authorized	service	provider,	and	must	be	recycled	or	disposed	of	separately	from	household
waste.	Dispose	of	batteries	according	to	your	local	environmental	laws	and	guidelines.	Donʼt	expose
your	MacBook	Pro	to	extreme	heat	sources,	such	as	radiators	or	fireplaces,	where	temperatures
might	exceed	212°F	(100°C).

For	information	about	battery	service	and	recycling,	go	to	Battery	Service	and	Recycling.

Handling.	Handle	your	MacBook	Pro	with	care.	It	is	made	of	metal,	glass,	and	plastic	and	has
sensitive	electronic	components	inside.	Place	your	MacBook	Pro	on	a	stable	work	surface	that	allows
for	adequate	air	circulation	under	and	around	the	computer.	Your	MacBook	Pro	can	be	damaged	if
dropped,	burned,	punctured,	or	crushed,	or	if	it	comes	in	contact	with	liquids,	oils,	and	lotions.	Donʼt
use	a	damaged	MacBook	Pro,	such	as	one	with	a	cracked	screen,	as	it	may	cause	injury.

Handle	your	USB-C	to	MagSafe	3	Cable	with	care.	It	contains	sensitive	electronic	components	inside.
Charge	your	device	on	a	stable	work	surface	that	allows	for	adequate	air	circulation	under	and	around
the	computer.	Your	USB-C	to	MagSafe	3	Cable	can	be	damaged	if	dropped,	burned,	punctured,	or
crushed,	or	if	it	comes	in	contact	with	liquids,	oils,	and	lotions.	Donʼt	use	a	damaged/frayed	USB-C	to
MagSafe	3	Cable.

Liquid	exposure.	Keep	your	MacBook	Pro	and	its	charge	cable	away	from	sources	of	liquid,	such	as
drinks,	oils,	lotions,	sinks,	bathtubs,	shower	stalls,	and	so	on.	Protect	your	MacBook	Pro	and	the
charge	cable	from	dampness,	humidity,	or	wet	weather,	such	as	rain,	snow,	and	fog.

Charging	your	MacBook	Pro.	Charge	your	14-inch	or	16-inch	MacBook	Pro	only	with	the	included
67W	USB-C	Power	Adapter,	96W	USB-C	Power	Adapter,	or	140W	USB-C	Power	Adapter	and	USB-C
to	MagSafe	3	Cable,	or	with	a	third-party	power	adapter	and	cable	that	are	compatible	with	USB-C
PD	and	compliant	with	applicable	international	and	regional	regulations	and	safety	standards.	Charge
your	13-inch	MacBook	Pro	only	with	the	included	61W	USB-C	Power	Adapter	and	USB-C	Charge
Cable,	or	with	a	third-party	power	adapter	and	cable	that	are	compatible	with	USB-C	PD	and
compliant	with	applicable	international	and	regional	regulations	and	safety	standards.

Other	power	adapters	might	not	meet	applicable	safety	standards,	and	charging	with	such	power
adapters	could	pose	a	risk	of	death	or	injury.	Using	damaged	power	adapters	or	cables,	or	charging
when	moisture	is	present,	can	cause	fire,	electric	shock,	injury,	or	damage	to	your	MacBook	Pro	or
other	property.	When	you	use	the	included	power	adapter	to	charge	your	MacBook	Pro,	make	sure
the	charge	cable	is	fully	inserted	into	the	power	adapter	before	you	plug	the	power	adapter	into	a
power	outlet.

https://www.apple.com/batteries/service-and-recycling


Prolonged	heat	exposure.	Your	MacBook	Pro	and	its	power	adapter	may	become	very	warm	during
normal	use.	The	MacBook	Pro	and	its	61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,	96W
USB-C	Power	Adapter,	or	140W	USB-C	Power	Adapter	comply	with	required	surface	temperature
limits	defined	by	applicable	country	regulations	and	international	and	regional	safety	standards.
However,	even	within	these	limits,	sustained	contact	with	warm	surfaces	for	long	periods	of	time	may
cause	discomfort	or	injury.

To	reduce	the	possibility	of	overheating	or	heat-related	injuries,	always	allow	adequate	ventilation
around	the	MacBook	Pro	and	its	power	adapter	and	use	care	when	handling	them.	Use	common
sense	to	avoid	situations	where	your	skin	is	in	prolonged	contact	with	a	device	or	its	power	adapter
when	itʼs	operating	or	plugged	into	a	power	source.	For	example,	donʼt	sleep	with	a	device	or	power
adapter	when	itʼs	plugged	into	a	power	source.	Do	not	place	the	device	or	power	adapter	under	a
blanket,	pillow,	or	your	body	when	the	device	or	adapter	is	connected	to	a	power	source.	Never	push
anything	into	the	ventilation	openings,	as	doing	so	may	be	dangerous	and	cause	your	computer	to
overheat.	Never	place	anything	over	the	keyboard	when	operating	your	MacBook	Pro.	If	your
MacBook	Pro	is	on	your	lap	and	gets	uncomfortably	warm,	remove	it	from	your	lap	and	place	it	on	a
stable,	well-ventilated	work	surface.	Take	special	care	if	you	have	a	physical	condition	that	affects
your	ability	to	detect	heat	against	the	body.

61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,	96W	USB-C	PowerAdapter,	or	140W
USB-C	Power	Adapter.	To	operate	the	61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,	96W
USB-C	PowerAdapter,	or	140W	USB-C	Power	Adapter	safely	and	reduce	the	possibility	of	heat-
related	injury	or	damage,	do	one	of	the	following:

Plug	the	61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,	96W	USB-C	PowerAdapter,	or
140W	USB-C	Power	Adapter	directly	into	a	power	outlet.

If	youʼre	using	the	Power	Adapter	Extension	Cable,	place	the	power	adapter	on	a	desk,	table,	or
on	the	floor	in	a	well-ventilated	location.

Donʼt	use	your	MacBook	Pro	or	its	power	adapter	in	wet	locations,	such	as	near	a	sink,	bathtub,	or
shower	stall,	and	donʼt	connect	or	disconnect	the	power	adapter	with	wet	hands.	Unplug	the	power
adapter	and	disconnect	any	cables	if	any	of	the	following	conditions	exists:

The	USB-C	cable	or	power	cord	has	become	frayed	or	damaged.

The	plug	part	of	the	61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,	96W	USB-C
PowerAdapter,	or	140W	USB-C	Power	Adapter,	the	prongs,	or	the	adapter	case	have	become
damaged.

Your	MacBook	Pro	or	61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,	96W	USB-C
PowerAdapter,	or	140W	USB-C	Power	Adapter	has	been	dropped.

Your	MacBook	Pro	or	61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,	96W	USB-C
PowerAdapter,	or	140W	USB-C	Power	Adapter	is	exposed	to	rain,	liquid,	or	excessive	moisture.

You	suspect	the	MacBook	Pro	or	61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,	96W
USB-C	PowerAdapter,	or	140W	USB-C	Power	Adapter	needs	service	or	repair.



You	want	to	clean	the	MacBook	Pro	or	61W	USB-C	Power	Adapter,	67W	USB-C	Power	Adapter,
96W	USB-C	PowerAdapter,	or	140W	USB-C	Power	Adapter	(use	only	the	recommended
procedure,	described	in	Important	handling	information	for	your	Mac).

The	MagSafe	3	power	port	contains	a	magnet	that	can	erase	data	on	a	credit	card,	iPod,	or	other
device.	To	preserve	your	data,	do	not	place	these	or	other	magnetically	sensitive	material	or	devices
within	1	inch	(25	mm)	of	this	port.

If	debris	gets	onto	the	power	port,	remove	it	gently	with	a	dry	cotton	swab.

61W	USB-C	Power	Adapter	specifications:

Frequency:	50	to	60	Hz,	single	phase

Line	Voltage:	100	to	240	V

(USB-PD)	Output	Voltage:	20.3VDC/3A	or	15VDC/3A	or	9VDC/3A	or	5.2VDC/3A

67W	USB-C	Power	Adapter	specifications:

Frequency:	50	to	60	Hz,	single	phase

Line	Voltage:	100	to	240	V

(USB-PD)	Output	Voltage:	20.3VDC/3.3A	or	15VDC/3A	or	9VDC/3A	or	5.2VDC/3A

96W	USB-C	Power	Adapter	specifications:

Frequency:	50	to	60	Hz,	single	phase

Line	Voltage:	100	to	240	V

(USB-PD)	Output	Voltage:	20.5VDC/4.7A	or	15VDC/3A	or	9VDC/3A	or	5.2VDC/3A

140W	USB-C	Power	Adapter	specifications:

Frequency:	50	to	60	Hz,	single	phase

Line	Voltage:	100	to	240	V

(USB-PD)	Output	Voltage:	28VDC/5A	or	20.5VDC/5A	or	15VDC/5A	or	9VDC/3A	or	5.2VDC/3A

Hearing	loss.	Listening	to	sound	at	high	volumes	may	damage	your	hearing.	Background	noise,	as
well	as	continued	exposure	to	high	volume	levels,	can	make	sounds	seem	quieter	than	they	actually
are.	Use	only	compatible	earbuds,	headphones,	or	earpieces	with	your	MacBook	Pro.	Turn	on	the
audio	and	check	the	volume	before	inserting	anything	into	your	ear.	See	Sound	and	Hearing.

WARNING:	To	prevent	possible	hearing	damage,	do	not	listen	at	high	volume	levels	for	long
periods.

https://www.apple.com/sound/


Repairing.	Your	MacBook	Pro	doesnʼt	have	any	user-serviceable	parts.	Do	not	open	or	disassemble
MacBook	Pro	or	attempt	to	repair	it	or	replace	any	components.	Disassembling	your	MacBook	Pro
may	damage	it	or	may	cause	injury	to	you.	If	you	attempt	to	open	your	MacBook	Pro,	you	risk
damaging	your	computer,	and	such	damage	isnʼt	covered	by	the	limited	warranty	on	your	MacBook
Pro.

If	your	MacBook	Pro	needs	service,	is	damaged,	malfunctions,	or	comes	in	contact	with	liquid,
contact	Apple	or	an	Apple-authorized	repair	center,	such	as	an	Apple	Authorized	Service	Provider.
You	can	find	information	about	getting	service	at	Mac	Service	and	Repair.

Navigation.	Maps,	directions,	and	location-based	apps	depend	on	data	services.	These	data	services
are	subject	to	change	and	may	not	be	available	in	all	areas,	resulting	in	maps,	directions,	or	location-
based	information	that	may	be	unavailable,	inaccurate,	or	incomplete.	Compare	the	provided
location-based	information	to	your	surroundings	and	defer	to	posted	signs	to	resolve	any
discrepancies.	Do	not	use	these	services	while	performing	activities	that	require	your	full	attention.
Always	comply	with	posted	signs	and	the	applicable	laws	and	regulations	in	the	areas	where	you	are
using	navigation,	and	always	use	common	sense.

Radio	frequency	exposure.	MacBook	Pro	uses	radio	signals	to	connect	to	wireless	networks.	For
information	about	radio	frequency	(RF)	energy	resulting	from	radio	signals	and	steps	you	can	take	to
minimize	exposure,	go	to	RF	Exposure.

Medical	device	interference.	MacBook	Pro	contains	magnets	as	well	as	components	and	radios	that
emit	electromagnetic	fields.	These	magnets	and	electromagnetic	fields	might	interfere	with	medical
devices.	Consult	your	physician	and	medical	device	manufacturer	for	information	specific	to	your
medical	device	and	whether	you	need	to	maintain	a	safe	distance	of	separation	between	your	medical
device	and	MacBook	Pro.	Manufacturers	often	provide	recommendations	on	the	safe	use	of	their
devices	around	wireless	or	magnetic	products	to	prevent	possible	interference.	If	you	suspect
MacBook	Pro	is	interfering	with	your	medical	device,	stop	using	your	MacBook	Pro.	Medical	devices
such	as	implanted	pacemakers	and	defibrillators	may	contain	sensors	that	respond	to	magnets	and
radios	when	in	close	contact.	To	avoid	any	potential	interactions	with	these	devices,	keep	your
MacBook	Pro	a	safe	distance	away	from	your	device	(more	than	6	inches	/	15	cm),	but	consult	with
your	physician	and	your	device	manufacturer	for	specific	guidelines).

Medical	conditions.	If	you	have	a	medical	condition	that	you	believe	could	be	affected	by	using
MacBook	Pro	(for	example,	seizures,	blackouts,	eyestrain,	or	headaches),	consult	with	your	physician
prior	to	using	MacBook	Pro.

Repetitive	motion.	When	you	perform	repetitive	activities	such	as	typing	or	playing	games	on
MacBook	Pro,	you	may	experience	discomfort	in	your	hands,	arms,	wrists,	shoulders,	neck,	or	other
parts	of	your	body.	If	you	experience	discomfort,	stop	using	MacBook	Pro	and	consult	a	physician.

Choking	hazard.	Some	MacBook	Pro	accessories	may	present	a	choking	hazard	to	small	children.
Keep	these	accessories	away	from	small	children.

High-consequence	activities.	Your	MacBook	Pro	is	not	intended	for	use	where	the	failure	of	the
computer	could	lead	to	death,	personal	injury,	or	severe	environmental	damage.

https://support.apple.com/mac/repair/service
https://www.apple.com/legal/rfexposure


Explosive	and	other	atmospheric	conditions.	Using	MacBook	Pro	in	any	area	with	a	potentially
explosive	atmosphere	may	be	hazardous—particularly	in	areas	where	the	air	contains	high	levels	of
flammable	chemicals,	vapors,	or	particles	such	as	grain,	dust,	or	metal	powders.	Exposing	MacBook
Pro	to	environments	having	high	concentrations	of	industrial	chemicals,	including	evaporating
liquified	gases	such	as	helium,	may	damage	or	impair	MacBook	Pro	functionality.	Obey	all	signs	and
instructions.

Important	handling	information	for	your	Mac
Operating	environment.	Operating	your	MacBook	Pro	outside	these	ranges	may	affect	performance:

Operating	temperature:	50°	to	95°	F	(10°	to	35°	C)

Storage	temperature:	-13°	to	113°	F	(-25°	to	45°	C)

Relative	humidity:	0%	to	90%	(noncondensing)

Operating	altitude:	Tested	up	to	10,000	feet	(0	to	3048	meters)

Carrying	your	MacBook	Pro.	If	you	carry	your	MacBook	Pro	in	a	bag	or	briefcase,	make	sure	there
are	no	loose	items	(such	as	paper	clips	or	coins)	that	could	accidentally	get	inside	the	computer
through	vent	openings	or	get	stuck	inside	a	port.

CAUTION:	Keep	hands	and	fingers	away	from	the	moving	parts	to	avoid	pinching.

Using	connectors	and	ports.	Never	force	a	connector	into	the	ports.	When	connecting	a	device,
make	sure	the	port	is	free	of	debris,	that	the	connector	matches	the	port,	and	that	you	have
positioned	the	connector	correctly	in	relation	to	the	port.

Using	the	USB-C	Charge	Cable	(2	m).	Certain	usage	patterns	can	contribute	to	the	fraying	or
breaking	of	cables.	The	USB-C	Charge	Cable,	pictured	in	Whatʼs	included:	13-inch	MacBook	Pro,	like
any	other	metal	wire	or	cable,	is	subject	to	becoming	weak	or	brittle	if	repeatedly	bent	in	the	same
spot.	Aim	for	gentle	curves	instead	of	angles	in	the	cable.	Regularly	inspect	the	cable	and	connectors
for	any	kinks,	breaks,	bends,	or	other	damage.	Should	you	find	any	such	damage,	discontinue	use	of
the	USB-C	Charge	Cable.

Using	the	USB-C	to	MagSafe	3	Cable	(2	m).	Certain	usage	patterns	can	contribute	to	the	fraying	or
breaking	of	cables.	The	USB-C	to	MagSafe	3	Cable,	pictured	in	Whatʼs	included:	14-inch	and	16-inch
MacBook	Pro,	like	any	other	metal	wire	or	cable,	is	subject	to	becoming	weak	or	brittle	if	repeatedly
bent	in	the	same	spot.	Aim	for	gentle	curves	instead	of	angles	in	the	cable.	Regularly	inspect	the
cable	and	connectors	for	any	kinks,	breaks,	bends,	or	other	damage.	Should	you	find	any	such
damage,	discontinue	use	of	the	USB-C	to	MagSafe	3	Cable.

Storing	your	MacBook	Pro.	If	youʼre	going	to	store	your	MacBook	Pro	for	an	extended	period	of	time,
keep	it	in	a	cool	location	(ideally,	71°	F	or	22°	C)	and	discharge	the	battery	to	50	percent.	When
storing	your	computer	for	longer	than	five	months,	maintain	the	capacity	of	the	battery	by	charging
the	battery	to	50	percent	every	six	months	or	so.



Cleaning	your	MacBook	Pro.	When	cleaning	the	outside	of	your	MacBook	Pro	and	its	components,
first	shut	down	your	MacBook	Pro	and	unplug	the	charge	cable	and	the	power	adapter.	Then	dampen
a	clean,	soft,	lint-free	cloth	to	wipe	the	MacBook	Pro	exterior.	Avoid	getting	moisture	in	any	openings.
Donʼt	spray	liquid	directly	on	the	computer.	Donʼt	use	aerosol	sprays,	solvents,	abrasives,	or	cleaners
containing	hydrogen	peroxide,	which	might	damage	the	finish.

Cleaning	the	MacBook	Pro	screen.	To	clean	the	MacBook	Pro	screen,	first	shut	down	your	MacBook
Pro	and	unplug	the	charge	cable	and	the	power	adapter.	Then	dampen	a	clean,	soft,	lint-free	cloth
with	just	water	and	wipe	the	screen.	Donʼt	spray	liquid	directly	on	the	screen.

Mac	ergonomics
When	you	use	the	keyboard	and	mouse,	your	shoulders	should	be	relaxed.	Your	upper	arm	and
forearm	should	form	an	angle	that	is	slightly	greater	than	a	right	angle,	with	your	wrist	and	hand	in
roughly	a	straight	line.

Use	a	light	touch	when	typing	or	using	the	trackpad	and	keep	your	hands	and	fingers	relaxed.	Avoid
rolling	your	thumbs	under	your	palms.

Change	hand	positions	often	to	avoid	fatigue.	Some	computer	users	might	develop	discomfort	in	their
hands,	wrists,	or	arms	after	intensive	work	without	breaks.	If	you	begin	to	develop	chronic	pain	or
discomfort	in	your	hands,	wrists,	or	arms,	consult	a	qualified	health	specialist.

External	mouse.	If	you	use	an	external	mouse,	position	the	mouse	at	the	same	height	as	the	keyboard
and	within	a	comfortable	reach.

Chair.	An	adjustable	chair	that	provides	firm,	comfortable	support	is	best.	Adjust	the	height	of	the
chair	so	your	thighs	are	horizontal	and	your	feet	are	flat	on	the	floor.	The	back	of	the	chair	should
support	your	lower	back	(lumbar	region).	Follow	the	manufacturerʼs	instructions	for	adjusting	the
backrest	to	fit	your	body	properly.



Built-in	display.	Adjust	the	angle	of	the	display	to	minimize	glare	and	reflections	from	overhead	lights
and	windows.	Do	not	force	the	display	if	you	meet	resistance.	The	display	is	not	designed	to	open
past	135	degrees.

You	can	adjust	the	brightness	of	the	screen	when	you	take	the	computer	from	one	work	location	to
another,	or	if	the	lighting	in	your	work	area	changes.

For	more	information	about	ergonomics,	see	the	Apple	Support	article	Ergonomics.

Regulatory	information
Regulatory	information,	certification,	and	compliance	marks	specific	to	MacBook	Pro	are	available	on-
device.	Choose	Apple	menu	 	>	About	This	Mac	>	Resources	>	Regulatory	Certification.

FCC	compliance	statement
This	device	complies	with	part	15	of	the	FCC	Rules.	Operation	is	subject	to	the	following	two
conditions:	(1)	this	device	may	not	cause	harmful	interference,	and	(2)	this	device	must	accept	any
interference	received,	including	interference	that	may	cause	undesired	operation.

Note:	This	equipment	has	been	tested	and	found	to	comply	with	the	limits	for	a	Class	B	digital	device,
pursuant	to	part	15	of	the	FCC	Rules.	These	limits	are	designed	to	provide	reasonable	protection
against	harmful	interference	in	a	residential	installation.

This	equipment	generates,	uses,	and	can	radiate	radio	frequency	energy	and,	if	not	installed	and	used
in	accordance	with	the	instructions,	may	cause	harmful	interference	to	radio	communications.
However,	there	is	no	guarantee	that	interference	will	not	occur	in	a	particular	installation.

If	this	equipment	does	cause	harmful	interference	to	radio	or	television	reception,	which	can	be
determined	by	turning	the	equipment	off	and	on,	the	user	is	encouraged	to	try	to	correct	the
interference	by	one	or	more	of	the	following	measures:

Reorient	or	relocate	the	receiving	antenna.

Increase	the	separation	between	the	equipment	and	receiver.

Connect	the	equipment	to	an	outlet	on	a	circuit	different	from	that	to	which	the	receiver	is
connected.

Consult	the	dealer	or	an	experienced	radio/TV	technician	for	help.

Changes	or	modifications	to	this	product	not	authorized	by	Apple	could	void	the	electromagnetic
compatibility	(EMC)	and	wireless	compliance	and	negate	your	authority	to	operate	the	product.

This	product	has	demonstrated	EMC	compliance	under	conditions	that	included	the	use	of	compliant
peripheral	devices	and	shielded	cables	between	system	components.	It	is	important	that	you	use
compliant	peripheral	devices	and	shielded	cables	between	system	components	to	reduce	the
possibility	of	causing	interference	to	radios,	television	sets,	and	other	electronic	devices.

https://www.apple.com/about/ergonomics


Responsible	party	(contact	for	FCC	matters	only):
Apple	Inc.
One	Apple	Park	Way,	MS	911-AHW
Cupertino,	CA	95014
USA

apple.com/contact

ISED	Canada	compliance	statement
This	device	complies	with	ISED	Canada	licence-exempt	RSS	standard(s).	Operation	is	subject	to	the
following	two	conditions:	(1)	this	device	may	not	cause	interference,	and	(2)	this	device	must	accept
any	interference,	including	interference	that	may	cause	undesired	operation	of	the	device.

Operation	in	the	band	5150–5250	MHz	is	only	for	indoor	use	to	reduce	the	potential	for	harmful
interference	to	co-channel	mobile	satellite	systems.

Le	présent	appareil	est	conforme	aux	CNR	dʼISDE	Canada	applicables	aux	appareils	radio	exempts	de
licence.	Lʼexploitation	est	autorisée	aux	deux	conditions	suivantes	:	(1)	lʼappareil	ne	doit	pas	produire
de	brouillage,	et	(2)	lʼappareil	doit	accepter	tout	brouillage	radioélectrique	subi,	même	si	le	brouillage
est	susceptible	dʼen	compromettre	le	fonctionnement.

La	bande	5150–5250	MHz	est	réservée	uniquement	pour	une	utilisation	à	lʼintérieur	afin	de	réduire	les
risques	de	brouillage	préjudiciable	aux	systèmes	de	satellites	mobiles	utilisant	les	mêmes	canaux.

ENERGY	STAR®	compliance	statement

As	an	ENERGY	STAR	partner,	Apple	has	determined	that	standard	configurations	of	this	product	meet
the	ENERGY	STAR	guidelines	for	energy	efficiency.	The	ENERGY	STAR	program	is	a	partnership	with
electronic	equipment	manufacturers	to	promote	energy-efficient	products.	Reducing	energy
consumption	of	products	saves	money	and	helps	conserve	valuable	resources.

MacBook	Pro	is	shipped	with	power	management	enabled,	with	the	computer	set	to	sleep	after	10
minutes	of	user	inactivity.	To	wake	your	computer,	click	the	trackpad	or	press	any	key	on	the
keyboard.	To	change	this	setting,	open	System	Preferences,	then	click	Energy	Saver.

For	more	information	about	ENERGY	STAR,	go	to	Energy	Star.

Apple	and	the	environment

https://www.apple.com/contact
https://www.energystar.gov


At	Apple,	we	recognize	our	responsibility	to	minimize	the	environmental	impacts	of	our	operations
and	products.

For	information,	go	to	Appleʼs	Environment	website.

Disposal	and	recycling	information

The	symbol	above	means	that	according	to	local	laws	and	regulations	your	product	and/or	its	battery
shall	be	disposed	of	separately	from	household	waste.	When	this	product	reaches	its	end	of	life,	take
it	to	a	collection	point	designated	by	local	authorities.	The	separate	collection	and	recycling	of	your
product	and/or	its	battery	at	the	time	of	disposal	will	help	conserve	natural	resources	and	ensure	that
it	is	recycled	in	a	manner	that	protects	human	health	and	the	environment.

For	information	about	Appleʼs	recycling	program,	recycling	collection	points,	restricted	substances,
and	other	environmental	initiatives,	visit	apple.com/environment.

Información	sobre	eliminación	de	residuos	y	reciclaje
El	símbolo	de	arriba	indica	que	este	producto	y/o	su	batería	no	deben	desecharse	con	los	residuos
domésticos.	Cuando	quieras	desechar	este	producto	y/o	su	batería,	hazlo	de	conformidad	con	las
leyes	y	directrices	medioambientales	locales.	Para	obtener	más	información	sobre	el	programa	de
reciclaje	de	Apple,	los	puntos	de	recolección	para	reciclaje,	las	sustancias	restringidas	y	otras
iniciativas	medioambientales,	visita	apple.com/mx/environment	o	apple.com/la/environment.

Brasil	–	Informações	sobre	descarte	e	reciclagem
O	símbolo	acima	indica	que	este	produto	e/ou	sua	bateria	não	devem	ser	descartados	no	lixo
doméstico.	Quando	decidir	descartar	este	produto	e/ou	sua	bateria,	faça-o	de	acordo	com	as	leis	e
diretrizes	ambientais	locais.	Para	informações	sobre	substâncias	de	uso	restrito,	o	programa	de
reciclagem	da	Apple,	pontos	de	coleta	e	telefone	de	informações,	visite	apple.com/br/environment.

Battery	disposal	information
The	battery	in	your	MacBook	Pro	should	be	serviced,	replaced,	or	recycled	by	Apple	or	an	authorized
service	provider,	and	must	be	recycled	or	disposed	of	separately	from	household	waste	according	to
your	local	environmental	laws	and	guidelines.	For	information	about	battery	service	and	recycling,	go
to	Battery	Service	and	Recycling.

Software	License	Agreement
Use	of	MacBook	Pro	constitutes	acceptance	of	the	Apple	and	third-party	software	license	terms
found	at	Software	License	Agreements.

https://www.apple.com/environment
https://www.apple.com/environment
https://www.apple.com/mx/environment/
https://www.apple.com/la/environment
https://www.apple.com/br/environment
https://www.apple.com/batteries/service-and-recycling
https://www.apple.com/legal/sla
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IOS	is	a	trademark	or	registered	trademark	of	Cisco	in	the	U.S.	and	other	countries	and	is	used	under	license.
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by	Apple	Inc.	is	under	license.
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Some	apps	are	not	available	in	all	areas.	App	availability	is	subject	to	change.

https://www.apple.com

